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Introduction

I-1 Purpose of This Handbook
This handbook, Handbook M-32, governs the Management Operating Data
System (MODS) program. Handbook M-32 applies to offices that use the
remote Main Frame, Gold Tape LAN, or stand-alone personal computer
versions of MODS software for managing operational data on:

! mail volume
! work hours
! performance by operation (work activity)

This manual presents the program responsibilities for maintaining and
operating the MODS System:

! when to report data
! the units of measurement used to convert mail volume
! the naming conventions to use for data reporting
! how to enter data into MODS, using input devices and importing data

from other postal systems

MODS is for national application; all postal facilities in the system must follow
the procedures in this handbook for volume and work hour reporting and other
data entry, except where options or alternatives are specified. The MODS
program has some flexibility and options to accommodate local needs. To
vary from any of these procedures, you must first get the approval of USPS
Headquarters Operations Technical Support Group.

I-2 Describing the MODS Program
The Management Operating Data System (MODS) is a systematic approach
to gather, store, and report data on workload, work hours, and machine
utilization. The operational data is entered into MODS, compiled, and
communicated in reports to postal facilities for planning mail processing
activities and projecting work hours and mail volumes.

Handbook M-32 is to be used as a management record-keeping system--a
tool for management to track work hours and other information to maintain the
efficiency of the Postal Service. Handbook M-32 is not relevant to craft
jurisdiction.
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Today, there are three ways to use MODS:
! the remote mainframe computer
! PCMODS on a stand-alone personal computer
! Gold Tape LAN for large facilities on a stand-alone PC

Mainframe: When the program was first developed, we were limited to the
remote mainframe version of MODS for larger facilities. (Because of size,
personal computers were not able to accommodate MODS for these
facilities.) Most larger offices still use the remote mainframe to report data into
MODS.

PCMODS:  All other offices use the Personal Computer Management
Operating Data Systems (PCMODS) application on either the local Gold Tape
LAN or the stand-alone personal computer.

Gold Tape LAN: Today, advances in data processing technology have
created a version of PCMODS software that can accommodate even larger
facilities. Facilities using mainframe MODS now can migrate to the Gold Tape
LAN PCMOD Systems.

I-3 How MODS Fits in the USPS Network:
The Postal Source Data System (PSDS) is an electronic data processing
communications network that provides data entry and retrieval for postal
systems. It is used by most of the larger facilities to manage:

! MODS (located at the Minneapolis ISCC)
! Time and Attendance System (T&A)
! National Maintenance Information and Control System (NMICS)

MODS uses the PSDS network to gather and transmit operational data to the
Minneapolis ISCC for processing on the remote mainframe computer. The
data is processed, organized, and compiled into reports related to volume,
work hour, and machine utilization. The PSDS network then communicates
these reports back to the local office for planning and tracking.

I-3.1 Data Collection Site: If You are Connected to PSDS
The PSDS communications equipment is located in each facility’s Data
Collection Site (DCS). The PSDS recording devices linked to the PSDS
communications network are located in various locations:

! mail processing plants
! annexes
! airmail facility
! vehicle maintenance facilities
! others



April 2000                                                                                                                                  3

These recording devices are linked to the DCS with cables and telephone
lines. PSDS connects the DCS to the Minneapolis ISCC, where all collected
data is managed. The Minneapolis ISCC provides "24-7" communication of
data to and from facilities in the PSDS network—24 hours a day, seven days
a week.

I-3.2 Electronic Time Clock (ETC) System: If You are Not
Connected to PSDS

The Electronic Time Clock (ETC) system is an automated program used for
collecting time and attendance data for offices not connected to the PSDS
network. Similar to the PSDS Time and Attendance System, ETC records,
stores, and processes employee clock rings to generate work hour data that
supports PCMODS work hour reporting. ETC maintains employee data locally
and transmits employee weekly totals to the Minneapolis ISSC for payroll
purposes.

I-4 MODS Program Support
The Customer Support Branch in the Minneapolis ISSC provides MODS
technical system support. Please direct program support or any additional
guidance to the Area MODS Coordinator.

I-5 Customer Support
The Customer Support Branch in Minneapolis provides technical assistance
to field users of MODS and PCMODS 24 hours a day, seven days a week:

! provides guidance
! troubleshoots problems
! helps offices use the mainframe MODS or PCMODS

For support, call 1-800-USPS-HELP (1-800-877-7435). To open a help ticket,
you need this information:

! site name
! your name
! your telephone number
! Finance Number
! PRN Address (for PCMODS sites)
! description of the problem/error message

To reference and track the problem, the Customer Support Branch will assign
your problem an open ticket number, which will remain open until the problem
is resolved. To follow up, call Customer Support with the ticket number.
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I-6 Area MODS Coordinators
Each Area has a MODS Coordinator who is responsible for:

! ensuring compliance with MODS
! providing program support
! training
! ensuring accurate data reporting
! managing related MODS activities between headquarters and the

field offices

I-7 Who is Responsible for What
These are the roles and responsibilities of the various players in the MODS
Program: USPS Headquarters, Area Offices, Field Offices, and Finance.

I-7.1 USPS Headquarters
Processing Operations responsible for:

! assigning a headquarters program coordinator
! managing the overall operation of MODS/PCMODS
! assigning operation numbers to work activities
! approving changes or modifications to MODS/PCMODS
! overseeing the design and technical management of

MODS/PCMODS
! overseeing the development of the periodic updating of the national

conversion rates
! providing program support to the area coordinators

I-7.2 Area Office
In-Plant Support is responsible for:

! assigning an area program coordinator
! coordinating program related activities between headquarters and the

field offices
! providing detailed direction for accurately collecting MODS/PCMODS

data
! overseeing the overall operation and technical management of

MODS/PCMODS within the area
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I-7.3 Field Office
Plant/Post Office is responsible for:

! managing the overall operation of the local MODS/PCMODS
! assigning a local program coordinator
! complying with all procedures outlined in this handbook
! managing the mail flow matrix and updating them annually or

whenever significant changes occur
! maintaining the MODS scale profile table
! reviewing MODS/PCMODS reports daily
! accurately recording volume and work hours in MODS/PCMODS in a

timely manner
! ensuring that the flow of mail is orderly through recording locations,

that mail is properly presented for recording, and that correct tare
weights of all rolling stock used to weigh mails are clearly marked

! preparing proper documentation and ensuring correction of data
reporting errors

I-7.4 Finance
Finance is responsible for:

! managing the processing of volume and work hour data and
preparing related reports for management in the PSDS facilities

! providing workhour data files for the ETC offices in a timely manner
for input in the PCMODS facilities
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1 The MODS Program

1-1 Functions of the MODS System
The Postal Service uses the MODS System to collect operational data,
generate reports, and transmit local data files to the Corporate Data Base
(CDB) through the Corporate Information System (CIS). The CDB provides
long-term data storage to meet the reporting requirements of the national
weekly and accounting period. MODS stores the raw data and provides a
historical database for national and local planning, analysis, and tracking of
mail processing activities.

! Mainframe MODS automatically transmits data files daily to the CDB
through the PSDS network for weekly reporting. The weekly MODS
files are rolled up into a report on each accounting period.

! The PCMODS System uses the software application's Transmit
Option to activate the File Transfer Program (FTP) as described in the
PCMODS User's Guide. MODS data files are transmitted to the CDB
weekly, and the weekly MODS files are rolled up to create a report on
each accounting period.

For all facilities—mainframe MODS and PCMODS—the MODS System
performs these functions:

! assigns each activity a standard 3-digit operation number (Each
facility may further define operations with a Local Unit (LU) code—a
2-digit number added to the operation number. The LUs are not
transmitted to the CDB MODS files.)

! uses 2-digit source/type codes, mail distribution, and handling
operation numbers to identify the origin, type designation, and other
characteristics of the mail

! records mail volume by various methods (Most data is imported from
other systems—the majority of the machine data is imported from the
End of Run (EOR) Program. In other cases, the volume is by machine
meter, machine printouts, actual piece counts—by weight, containers,
or linear measurement.)

! uses national conversion rates to convert mail weight, containers, or
feet into pieces of mail

! reports mail volume processed as first handling piece (FHP) and
projects subsequent handling pieces (SHP) using mailflow densities
or actual pieces except where noted

! records and reports actual work hours and authorized overtime by
operation

! provides optional planning of hours by labor distribution code and
operation number
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! provides optional planning of FHP volumes by letters, flats, and
parcels

The mainframe MODS System also performs these functions:
! reports workload units in non-distribution operations
! uses national factor rates to convert workload units, letters, flats,

parcels, and mixed volumes to work credits

1-2 MODS Basic Components
The MODS System has two basic components: MODS 1 and MODS 2 postal
facilities.  The difference between the two components is the method of data
collection and reporting:

! MODS 1 facilities use the remote mainframe computer, MODS
software, and the Postal Source Data System (PSDS)
communications network to collect data and generate reports.  The
mainframe computer is located at the Minneapolis ISSC.

! MODS 2 facilities use the Gold Tape LAN or stand-alone  PC version
of the MODS software and local printers to collect data and generate
reports.

Both systems are covered in this handbook because MODS 1 and MODS 2
facilities collect the same type of operational data and share program
similarities:

! operation numbers
! labor distribution codes (LDCs)
! source/type codes (S/Ts)

1-2.1 MODS 1 Offices
To input and report MODS data, MODS 1 offices use the PSDS recording
devices and the communications network. The data is collected nationwide
and transmitted by PSDS to the mainframe at the Minneapolis ISSC. There
the MODS software application organizes, interprets, and compiles the data
into reports that are communicated back to the postal facilities for planning
and projecting work hours and mail volumes.

1-2.2 MODS 2 Offices
MODS 2 offices use the Gold Tape LAN or stand-alone PC to report MODS
data. The data is collected using the PCMODS software application.
PCMODS organizes, compiles, and generates reports for planning and
projecting work hours and mail volumes.
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1-2.3 Regional Post Office Code (REGPO)
To identify offices, MODS data reporting facilities are assigned a 4-digit
Regional Post Office Code (REGPO). All facilities in the reporting city are
assigned the same REGPO (mail processing, vehicle or air mail facility in the
same city, for example). The REGPO code separates data by City Post Office
name in the Corporate Data Base MODS files. REGPO codes are assigned
by Area Office and City Post Office name.

1-2.4 Separate Reporting Facility (SRF) Codes
For MODS data reporting, PSDS uses Separate Reporting Facility (SRF)
codes to separate each group of facilities reporting by finance number within
a REGPO code. A 2-digit SRF code is assigned to each finance number
within a REGPO/City. It distinguishes the office for data reporting purposes
and creates separate MODS reports for each reporting facility or SRF.
Individual SRFs are assigned to each facility—mail processing plant, air mail
facility, delivery units, vehicle facility—in each city.

MODS 2 facilities can not use SRF codes because the Electronic Time Clock
program (ETC) does not support SRFs. The ETC work hours can not be
imported into PCMODS by SRF code. The PCMODS application can assign
SRF codes at the program’s Config Site Parameter menu.

1-3 Entering and Transmitting Data
MODS 1 and MODS 2 offices both use input devices to enter and transmit
site-specific data:

! volume
! mail processing machine data
! employee work hours by time, by operation number, and employee

identification number

Because of the difference in the MODS software application, the descriptions
of the input and output devices vary slightly for MODS 1 and MODS 2 sites.

1-3.1 PSDS Transactor: MODS 1 Offices
MODS 1 offices use PSDS transactors as the input workstation. The
workstation is an AT&T PC 6300 IWS (Industrial Workstation) that transmits
to the remote mainframe computer’s MODS software program  in Eqan ISSC.
The workstation consists of:

! a video display terminal (VDT)
! a system module for data storage
! a keyboard for data entry
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The transactor uses custom screens to record inputs relating to time and
attendance, personnel data, MODS volume transactions, and mail processing
equipment information.

1-3.2 PCMODS Input Workstation: MODS 2 Offices
MODS 2 offices use a PC Workstation configured with the Oracle-based
PCMODS software program as the input workstation. The workstation
consists of:

! a Gold Tape LAN with an NT Server or stand-alone PC
! a keyboard
! a video display terminal (VDT)
! a printer

The PCMODS software uses menu-driven screens to input data, create files,
store data, and interface with other postal data files to manage the daily
operating data for the local site.

1-4 Work Hour Data

1-4.1 Employee Badge Reader (EBR)
Employee Badge Readers (EBR) record employees clock ring data used by
several postal systems. The primary data user is the Time and Attendance
system (T&A), which uses employee clock ring data to compute work hour
usage by operation number with the capability of optional tour reporting.

! MODS 1 offices use Employee Badge Readers (EBR) connected to
the PSDS network to collect employee clock rings. The PSDS
network transmits the clock ring data to the Eqan ISSC for the MODS
System to report work hours.

! MODS 2 offices use Employee Badge Readers (EBR) connected to
the Electronic Time Clock System (ETC) to collect, store, and transmit
clock rings for processing within ETC. The ETC program uses the
stored clock rings to generate local reports that PCMODS uses to
report work hours. The PCMODS programs interface with ETC to
import the local clock ring data to generate work hours for MODS
reporting.

1-5 Volume Data

1-5.1 MODS Scales Programs
The USPS uses Hardy Scales and PCScales software programs to collect
weighed mail volume data and convert the weighed pounds to actual pieces
for MODS volume input. The Hardy Scales can be used by either MODS 1 or
MODS 2 programs. PCScales is only used in MODS 2 offices.
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Both scales programs use platform scales to weigh containers of mail and
also use a computer with software—either Hardy Scales or PCScales. The
scales software program records weights, converts weighed pounds to pieces
using national conversion rates, and creates mail volume files for input into
MODS.

! For MODS 1 facilities, the Hardy Scales program interfaces with the
PSDS communication network to transmit the data automatically to
Eqan ISSC for processing in MODS.

! For MODS 2 facilities, the Hardy Scales or PCScales create weighed
volume files for automatic data entry into PCMODS using the
system’s interface.

1-5.1.1 Hardy Scales Program
The Hardy Scales program uses the same version of software in either MODS
1 or MODS 2 facilities that:

! purchased their equipment specifically from Hardy
! connect all floor scale workstations (SWS) to a controller

In MODS 1 facilities, the Hardy Scales controller is connected to the PSDS
communication network for automatic data reporting into MODS 1.  The
platform transmits weights in whole pounds to the Scale Workstations (SWS).
The SWS stores the weight information and sends data to the Main Facility
Device Controller (MFDC) through the Hardy Scales System Controller
(SSC).  In MODS 1 facilities, the PSDS network is used to transmit volume
data from the MFDC to the mainframe MODS at the Eqan ISSC.

In MODS 2 facilities, the weight volume files from the Hardy Scales System
Controller (SSC) are copied to a diskette for input into MODS using the
PCMODS scales interface option.

1-5.1.2 MODS PCScales Program
PCScales is the PC version of Hardy Scales software. PCScales may or may
not be connected to the platforms or any other weighing device. MODS
weighing procedures must be followed to obtain the weight of the container of
mail. If the platform is not connected, the weight must be manually entered
into the PCScales screen. The scales program applies national conversion
rates to convert pounds to pieces and create mail volume files for PCMODS
input.

The scale Workstation—which includes a keyboard, video display terminal
(VDT), and computer—stores the volume data. At the end of the day, the
volume data from each workstation must be copied to a diskette for entry into
PCMODS. The PCScales program provides volume data input for the MODS
2 facilities.
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1-5.1.3 Scale Input Devices
The floor scale is a mechanical weighing device used as the primary method
of entering weighed volumes into the MODS System, but other scales are
used in conjunction with the scales program:

! bench scales
! in-motion scales

1-5.1.3.1 Bench Scale

The bench scale is a smaller scale that typically weighs mail up to only 10
pounds. The bench scale is usually connected to the MFDC for data
transmission; however, in some cases it is not. If it is not connected, a manual
entry must be made into the MODS System using the weight and source type
for the weighed mail.

1-5.1.3.2 In-motion (Conveyor) Scale

The in-motion scale is positioned on a conveyor line and weighs mail as it
moves along the belt. The scale is preset to facilitate the automatic recording
of mail. The computer automatically deducts standard tare weights for letter
and flat trays. This also includes inline scales in Tray Management Systems
(TMS).

1-5.1.4 End of Run (EOR) Program
End of Run (EOR) is a software program that collects data from the
automated and some mechanized mail processing equipment on a user-
defined time interval from an on-site Virtual Address Extension-Virtual
Memory System (VAX-VMS). In addition to on-line viewing capabilities and
standard reports, EOR supplies equipment statistical data files for the MODS.
EOR generates daily files to report mail pieces fed and accepted by machine
and time. The machine files are used to input Total Pieces Fed (TPF) and
Total Pieces Handled (TPH) volume in MODS by machine and operation
number.

! MODS 1 offices automatically transfer EOR data files into MODS by
establishing a File Transfer Program (FTP) connection with the VAX-
VMS.

! MODS 2 offices collect EOR data files on diskettes for transfer into
PCMODS to generate TPF and TPH volume by machine and
operation number.

1-6 MODS Reporting Periods

1-6.1 MODS Day
The local office designates the a.m. cutoff time for processing MODS data
(6:00, 7:00, or 8:00 a.m.)—when the volume of mail on hand will be at its
minimum. For late morning Delivery Point Sequence (DPS) dispatch to
stations and branches, DPS mail dispatch time can be after the MOD Day
cutoff.
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1-6.2 MODS Tour
The MODS day is made up of three tours of eight hours each. Tour 2 begins
at the start of the MODS day, followed by tour 3, and ending with tour 1. Work
hours are reported by tour for all functional areas on the tour work hour
reports. An optional mail processing tour operating report is available on
request through the local office.

1-6.3 MODS Week
The MODS week begins with tour 2 on Saturday morning and continues
through tour 1 on Friday night.

1-6.4 MODS Accounting Period
The MODS accounting period begins with tour 2, Saturday, day  01, and ends
with tour 1, Friday, day 28. The MODS accounting period reports consolidate
data for each of the 28 days of the accounting period.

1-7 MODS Reports
The MODS 1 System creates outputs or reports daily, weekly, and by
accounting period. These reports can be retrieved in two ways:

! receiving automatically generated, canned, hard-copy reports
transmitted over the PSDS communications network at the
designated reporting frequency and distributed to the facility by the
Data Collection Site (DCS)

! accessing the Corporate Information System (CIS) to find
electronically stored MODS raw data files and canned reports

The MODS 2 System creates similar reports, but daily reports can be
retrieved only from the local server’s storage. In MODS 2 offices, users
generate canned reports from the menu-driven screen and make distribution
to the facility. Weekly and accounting period reporting is available by
accessing the CIS. The CIS stores MODS data for the MODS 2 facility
identical to the data stored for the MODS 1 facility. Like MODS 1 users,
MODS 2 users can access the electronically stored MODS raw data and
canned reports.
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2 MODS Operation Numbers,
Source/Type Codes, and Transactions

2-1 MODS System Operation Numbers
Operation numbers are 3-digit numbers that designate uniquely defined
activities (operations) performed in post offices. To record volumes,
workloads, and work hours, use the operation numbers defined in Appendix A
of this handbook.

2-1.1 Volume and Workload Operations

2-1.1.1    First Handling Pieces
Record mail volume in the operation where it receives its first distribution
handling—the first handling pieces (FHP) count.  A first handling piece is a
letter, flat, or parcel that receives its initial distribution in a postal facility.  The
FHP—the number of pieces of mail received for distribution in a facility—is a
useful indicator for planning and measuring the distribution workload of the
facility.

First handling pieces are determined by machine meter counts or by national
conversion rates.

2-1.1.1.1.  Machine Meter Count
From cancellation devices, we collect machine meter counts of the number of
pieces canceled. The machine meter count is credited as first handling pieces
in the outgoing operation where the pieces will be distributed.

2-1.1.1.2 Advanced Facer/Canceller System (AFCS) Volume Reporting

You must enter the following:
! the number of pieces cancelled
! FIM A, B, and C
! Runtime
! Downtime

This data is available from the AFCS Single Machine Production Report. For
MODS processing, use the End of Run application to bring in AFCS
information.



April 2000                                                                                                                                  14

At all times, the site must ensure that all volume from these stackers is
processed in the MODS operations where it is recorded. If the volume is
processed in another operation, first withdraw it as FHP using Source/Type
code 01.
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2-1.1.1.3   End Of Run (EOR) Application

The End of Run (EOR) application credits machine-canceled letter volume
from operations 011-015 as FHP to the MLOCR-ISS, outgoing primary,
operation 881. These are the volume recording procedures for EOR:

! Letter volume moving from the 011-015 operations into the operation
831 that is not credited through EOR must be weighed.

! Letter volume moving from the 011-015 operations into the 881
operation is not weighed.

Operation 881:

Mapping letter volume from 011-015 operations into operation 881 is no
longer necessary; all mappings to operation 881 must be deleted. If an office
leaves the 881 mapping in place, the FHP volume will still be accurate but it
will generate an exception report. Volume mapped into operation 881 will still
be sent to Minneapolis. But Minneapolis will reject all 881-01 transactions
because the automatic credit accounted for this volume.

Local personnel must not mistake this exception report as lost volume and
manually enter this volume into MODS

2-1.1.1.4   National Conversion Rates

Other letter and flat operations determine first handling pieces by multiplying
the number of pounds of mail weighed to the operation by a standard national
conversion rate of the number of pieces per pound of mail. The result is the
number of first handling pieces to be distributed in the operation. The National
Conversion Rates were updated September 14, 1998.

2-1.1.1.5   Priority Conversion Rates

For Priority Conversion Rates, use these conversion rate types:

Description Pieces Item
Priority 74 U-Cart
Priority 92 Hamper
Priority 20 Sack
Priority 19 SPBS Tray

PSDS sites must tabulate all the priority pieces and then enter the data with a
Source/Type code of S/T 70. Priority Mail segregated by shape must use the
appropriate letter, flat, or parcels S/T code.

2-1.1.1.6  Actual Counts

In parcel operations, first handling pieces are determined by an actual count
of parcels or by standard conversion rates of the number of pieces per
container (sack or hamper).
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2-1.1.2    Subsequent Handling Pieces and Total Piece Handlings
First handling pieces that require more distribution into subsequent or
downstream manual operations are projected as subsequent handling pieces
(SHP), based on local mail flow densities. In non-automated environments,
the total of FHP and SHP becomes total piece handlings (TPH).

For mechanized and automated operations, the total piece handlings are the
total pieces fed minus any reworked and/or rejected pieces. The TPH is the
number of handlings necessary to distribute each piece of mail from the time
of receipt to dispatch. Comparing the FHP and TPH gives you the handling
ratio of mail for a facility.

Example: If the ratio of FHP to TPH (TPH divided by FHP) is 1.5, the average
piece of mail receives 1.5 handlings from the time it is received until it is
dispatched from the facility.

This performance information can be used to measure performance and
efficiency. This ratio can vary depending on mail flows and operating plans. A
low ratio does not guarantee efficiency.

To record machine operations that are connected to the End of Run (EOR)
Application:

! Allow EOR to compute TPH.

To record operations not incorporated in EOR:
! Record the actual total pieces fed from meter readings or machine

printouts.
! Enter the total pieces fed for these operations with a 7-5 transaction.
! Enter the total pieces fed by the cancellation, parcel sorting, and

ACDC equipment with a 7-5 transaction.

To record workload units:
! Record workload units in valid non-distribution operations by piece,

sack, or cubic feet. (A workload unit is the amount of work performed
in indirect distribution operations: banded trays, sorted sacks, a cubic
foot of vehicle loaded or unloaded, or an accepted mailing.)

To record work hour operations:
! Record work hours in operation numbers defined in Appendix A of

this handbook—except the special operations 777, 778, 888, and 999.

To record mixed operations:
! In general, mail distribution operations handle only one type of mail.

Operations that handle one or more mail types (letters, flats, and
parcels) are mixed operations. For example, priority mail can be
either a letter, flat, or parcel.

To record special operations:
! The following operations perform special functions (do not charge

work hours and direct volume inputs to these operations):
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Special Operations Function
777 Accumulates incoming letter volume

finalized to carrier routes and station
boxes.  Volume is flowed using density
matrixes from distribution operations.

778 Accumulates incoming flat volumes
finalized to carrier routes and station
boxes.  Volume is flowed using density
matrixes from distribution operations.

888 Accumulates all mail finalized for
distribution.  Includes residues and
backflows necessary for 100% density
for each operation.

999 Accumulates work hours recorded into
unassigned or invalid operation
numbers.

2-2 Source/Type Codes (S/T Codes)
Mail identification codes combine operation numbers and 2-digit Source/Type
(S/T) codes. S/T codes may identify the size, shape, class, unit of measure,
and type of mail. Use these codes to input mail volumes into the mail
distribution operation.

! The system uses national conversion rates to convert pounds or units
into pieces. S/T codes also are used to input workload units into non-
distribution operations.

! The system uses national factors to convert workload units into work
credits.  Some S/T codes are used to withdraw or transfer mail
between operations, and others are used for inventory purposes.

All S/T codes are uniquely described and grouped by type of mail (letters,
flats, and parcels) so that the same S/T code reflects the same source and
type of mail, regardless of the operation with which it is used.
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2-2.1     Letter Mail Source/Type Codes
The physical characteristics of a letter determine whether it is machinable or
non-machinable. Letter mail is recorded according to its size/machinability,
regardless of the operation in which it is worked. When machinable-sized
letters are worked in manual operations, enter them using machinable S/T
codes.
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Source/Type Codes

S/T
Code

Description
Rate

    Type Mail Handling Action

01 Machine Canceled 35.51    Machinable Letters FHP +
02 Metered Prep Pref 27.88    Machinable Letters FHP +
03 Metered Bypass Pref 28.25    Machinable Letters FHP +
04 Metered Prep Std 22.22    Machinable Letters FHP +
05 Metered Bypass Std 19.6    Machinable Letters FHP +
06 Opening Unit Mixed Pref 28.55    Machinable Letters FHP +
07 Opening Unit Mixed Std 18.11    Machinable Letters FHP +
08 Category C- OCR Readable 1    Machinable Letters INVALID +
09 Subsequent Handling, Mixed, Std 18.11    Machinable Letters TPH +
10 Second Handling, Mixed, Pref 28.55    Machinable Letters TPH +
11 Hand Canceled 21.42    Non-Machinable Letters FHP +
12 Metered Prep, Pref 21.52    Non-Machinable Letters FHP +
13 Metered Bypass, Pref 15.07    Non-Machinable Letters FHP +
14 Metered Prep, Std 11.61    Non-Machinable Letters FHP +
15 Metered Bypass, Std 14.14    Non-Machinable Letters FHP +
16 Opening Unit Mixed Pref 21.02    Non-Machinable Letters FHP +
17 Opening Unit Mixed Std 13.57    Non-Machinable Letters FHP +
18 Barcode A Field 1    Machinable Letters INVALID +
19 Barcode B Field 1    Machinable Letters INVALID +
20 Barcode C Field 1    Machinable Letters INVALID +
21 Barcode B' Prime Field 1    Machinable Letters INVALID +
22 Barcode C' Prime Field 1    Machinable Letters INVALID +
23 Pre-Barcode B Field 1    Machinable Letters INVALID +
24 Pre-Barcode C Field 1    Machinable Letters INVALID +
25 Second Handling, Metered

Prep/Metered Bypass Std
13.66    Non-Machinable Letters TPH -

26 Pre Barcode B' Prime Field 1    Machinable Letters INVALID +
27 Machine Rejects 35.42    Machinable Letters TPH -
28 Auto/Mech Second Handling 1    Machinable Letters TPH +
29 Riffle Mail 30.43    Non-Machinable Letters TPH +
30 Pre Barcoded C'Prime Field 1    Machinable Letters INVALID +
31 Inventory Hand Canceled 21.42    Non-Machinable Letters FHP +
32 Inventory Metered Preparation,

Pref
21.52    Non-Machinable Letters FHP +

33 Pre Barcoded Unique 5-Digit 1    Machinable Letters INVALID +
34 Inventory Opening Unit, Std 13.57    Non-Machinable Letters FHP +
35 Inventory Second Handling, Std 13.57    Non-Machinable Letters TPH +
36 Inventory Opening Unit, Mixed

Pref
21.02    Non-Machinable Letters FHP +

37 Inventory Second Handling, Pref 21.02    Non-Machinable Letters TPH +
38 Category B – Script 1    Machinable Letters INVALID -
39 Rework 23.72    Machinable Letters FHP +
40 400 Bin 35.42    Machinable Letters TPH -
41 Letters, Destination 30.98    Foreign Letters FHP +
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42 Letters, Origin 35.56    Foreign Letters FHP +
43 Total Unique 5- digit 1    Machinable Letters INVALID +
44 Withdraw – Foreign Origin 35.56    Foreign Letters TPH -
45 Inventory Foreign Origin 35.56    Foreign Letters FHP +
46 Inventory Foreign Origin 35.56    Foreign Letters TPH +
47 Local Cancellations 33.19    Machinable Letters FHP +
48 Console Reading 1    Machinable Letters INVALID +
49 Carrier Bypass 1 Letters INVALID +
56 Category A – FIM 1 Letters INVALID +
75 Originating Presort, Pref 1 Letters INVALID +
76 Originating Presort, Std 1 Letters INVALID +
80 Machine Canceled 35.51 Letters FHP +
81 Metered Preparation, Pref 27.88 Letters FHP +
82 Metered Bypass, Pref 28.25 Letters FHP +
83 Metered BBM 22.22 Letters FHP +
84 Metered Bypass Std 19.6 Letters FHP +
85 Opening Unit, Pref 28.55 Letters FHP +
86 Opening Unit, Std 18.11 Letters FHP +
87 Metered Bypass Pref 15.07 Letters FHP +
88 Metered Bypass, Std 14.14 Letters FHP +
89 Opening Unit, Std 13.57 Letters FHP +
94 AFCS-ISS Script Image Lift 1 Letters INVALID +
95 AFCS-ISS OCR Readable Image

Lift
1 Letters INVALID +

96 Reserved 1 Letters INVALID +
97 Reserved 1 Letters INVALID +
98 Reserved 1 Letters INVALID +
99 Workload Unit 1 Workload

Unit
INVALID +

Inventories minus workload from current MODS day and credits workload to the next MODS day.

2-2.1.1    Machine-canceled Stamped Mail—Input

To enter pieces canceled in operations 011-014, use S/T 01.
! Total the volume of letters canceled on canceling devices and enter

the number as pieces canceled.
! To transmit the AFCS information, use the End of Run application.

2-2.1.2    Hand-canceled Mail—Input

Weigh hand-canceled mail with S/T 11, which credits 010 with canceled
pieces and the distribution operation with FHP.

2-2.1.3    Metered Mail—Input
! For meter and permit letters, use S/T codes 02-05 and 12-15.
! To add FHP to the input operation and accumulate volume in

operation 020, use S/T codes 02, 04, 12, and 14.
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! To record letters that do not require preparation (bypass) in 020 into
the distribution operations, use S/T codes 03, 05, 13, or 15. This will
credit FHP to the distribution operation and to the 020 bypass.

! When the number of pieces requiring distribution is readily available
from a mailer's statement, enter the number with a 7-3 transaction.

2-2.1.4    Metered Mail—Withdrawal

2-2.1.5    Opening Unit—Input
! To enter mixed stamped and metered letters from a preferential or

opening unit, use S/T codes 06, 07, 16, or 17.
! To enter letter mail that originates from the central markup,

computerized forwarding units, Nixie section, etc., and requires
distribution in the facility into the distribution operation, use opening
unit S/T code 06, 07, 16, or 17.

2-2.1.6    Withdrawals
Do not run mail through the canceling machine more than once for Hand, No
Such Numbers (NSN), or similar endorsements—and then run it through
again for date. This results in an erroneous FHP count for operation 881.

Instead, make a deduction to reflect the correct number of pieces canceled by
entering a transaction 7-5 (011-015) 2 xxxx, where xxxx is the number of
pieces run through twice.

For adjustments other than current day, use either:
! A1 during the pay period
! PA for prior pay periods

2-2.1.7    Automation Culls
We recommend that you weigh this mail (from 883, for example) into the
appropriate operation number (043, for example)--with a scales transaction 02
and a mail type of 16 or 17.

2-2.1.8    Riffle Mail SHP Inputs
Weigh riffle mail that is distributed in operation 029, but requires additional
distribution, into the subsequent operation with S/T code 29.

2-2.1.9 Mechanization Operation Rework Subsequent Handling Mail
Deduct all rework mail (MPLSM Zero Bin, 400 Bin, sweepside, and machine
errors) on mechanization equipment operations from the total pieces fed for
that operation using S/T codes 27, 39, or 40.

! If this volume is to be reworked in another operation, record it as an
SHP in the operation where it will be distributed.

! If meters are installed, enter the meter readings from the bins with a
7-3 transaction. Otherwise, this mail must be weighed.

Report these mail volumes with S/T code 39:
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! Zero Bin
! Full Bin Bypass Mail
! No Key Mail

Mail volumes reported in S/T code 40 include:
! 400 Bin
! Unassigned Digits Mail
! Invalid Key Code Mail
! Any Special Assignments

Deduct sweepside and machine errors from the total pieces fed by
mechanization operations using S/T code 27.

2-2.1.10 Automation Operation Rework Subsequent Handling Mail
Deduct automation operation rework mail from the total pieces fed for that
operation using S/T code 27 or 39. Stacker 1 on the automation operations is
the stacker receiving non-readable mail.

1. Treat these volumes as having had valid FHP handling in these
operations because the identification and separation of non-
readable volumes is a function of the equipment.

2. Remove this mail to the corresponding manual or MPLSM
operation for further processing.

3. Volume taken to manual operations must be either weighed or
incorporated in the mail flow matrix. If weighed, use a transaction
type 4.

The last stacker(s) on the automation equipment is for those volumes being
rejected because of machine malfunctions. The End of Run application will
automatically subtract stacker counts from pieces fed.

If automation rework mail is taken to a manual operation, this mail must be
weighed or incorporated in the mail flow matrix. If weighed, use a transaction
type 4.

The rework mail taken to the MPLSM will be reflected in that operation's total
pieces fed from the console readings; therefore, a second handling entry is
not required.

2-2.1.11  Subsequent Handling, Automation/Mechanization
Mail distributed on automation or mechanization operations may require more
processing in a manual operation. This subsequent handling mail may be
weighed or flowed to downstream operations.

An OCR bin profile report taken at the end of processing for each scheme will
give the actual count of letters distributed to each stacker. Use this report to
determine the number of pieces of mail going to manual operations. To enter
the number of pieces of mail, use:

! a 7-3 transaction
! the manual operation number
! S/T code 28
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Example:  1,725 pieces of mail from OCR stacker 12 must receive more
processing in operation 168.

2-2.1.12  S/T Codes for Foreign Mail
Foreign Mail S/T codes 41, 42, 44-46 are used only in airport mail facilities or
exchange offices that receive clearly identifiable foreign airmail letters.

2-2.1.13  Local Cancellations S/T Code 47
To input letters canceled at an associate office, use Local Cancellations S/T
code 47, which does not add to the total pieces for operation 010 or deduct
from 881 FHP. FHP will be credited only to the distribution operation.

2-2.1.14  Console Reading S/T Code 48

In PSDS offices, to enter or adjust machine console readings—for current,
prior period, or year to date—use S/T code 48. This S/T code can only be
used with an A-1 transaction, because S/T code 48 adjusts only the operation
of input. Make adjustments by scheme operations (881, 882, etc.) as
necessary.  The FHP count is automatically adjusted for operation 881 when
S/T code 48 is used with operations 011-015.

2-2.1.15  Carrier Bypass Volumes S/T code 49
To enter letters presorted to carrier routes or that otherwise require no
distribution, use S/T code 49. The actual piece count is input with a 7-1 or 7-3
transaction to operations 253-339. This volume will be added to the
station/branch carrier volume.

2-2.2 Flat and Newspaper Source/Type Codes

2-2.2.1    S/T Codes 50-69, 90-93
Use the S/T codes listed in the Flat & Newspaper Source/Type Codes with
operations 060, 062, 063, 069, 070, 073-075, 141-148, 170, 175, 178, 179,
191-197, 240, 330-339, 401-409, 421-428, 441-448, 461-469, 801-807, 961-
967.

Flat Sorter Reworks:

Record volume for flat sorting machines reject bin and key errors into the
operation where it will receive second handling distribution. Enter meter
readings for the rework volume with a 7-3 transaction. Otherwise, this mail
must be weighed. To simplify and reduce the necessary recordings, Flat
Sorting operations have been paired with associated manual operations. S/T
code 50 deducts TPH when used with flat sorter operations.

Stamped Mail—Input:

S/T code 51 credits operation 010 with pieces canceled and the distribution
operation with FHP.
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Metered Mail—Input:

S/T codes 52 and 53 are for metered and permit flats. S/T code 52 adds
volume to operation 020. Flats that do not require preparation are considered
bypass and must be recorded into a distribution operation with S/T code 53.
S/T code 53 adds volume to operation 020 bypass.

Opening Unit—Input:

To enter mixed stamped and metered flats from a preferential or bulk
business opening unit, use S/T code 54 or 66. Enter flat mail from the central
markup or computerized forwarding units that requires distribution within the
facility into the distribution operation using S/T code 54 or 66.

Opening Unit—Newspapers:

To enter newspapers from a preferential or bulk business opening unit into a
distribution operation when the newspapers are distributed in cases in a flat
operation, use S/T code 55.

Withdrawals:
! Mail entered into an operation but not worked there must be weighed

out with S/T code 63.
! If subsequent handling mail is withdrawn using S/T code 63 and must

be worked in another operation, reenter it with S/T code 64.
! Reenter withdrawn FHP mail using the appropriate original S/T code.

FSM Subsequent Handlings:

Mail from the FSM operations may require further processing in a manual
operation. Either weigh this mail or use manual matrixes.

Foreign Mail:

S/T codes 61 and 62 are used only in airport mail facilities, exchange offices,
or plants that receive clearly identifiable foreign airmail flats.

Console Readings:

To enter or adjust machine console readings—current, prior period, or year to
date—use S/T code 68. This S/T code can only be used with an A-1
transaction.

Because S/T code 68 adjusts only the operation of input, make adjustments
to scheme operations (141, 142, etc.).

Carrier Bypass Volumes:

For flats presorted to carrier routes or that otherwise require no distribution,
use S/T code 69. Enter the actual piece count with a 7-1 or 7-3 transaction to
operation 240-253. This volume will be added to the station/branch carrier
volume.
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Flat and Newspaper Source/Type Codes

S/T
Code

Description Rate Type Mail Handling Action

50 Rework Bin and Key Errors 3.57 Flats FHP +
51 Machine Canceled 4.72 Flats FHP +
52 Meter Preparation 4.18 Flats FHP +
53 Meter Bypass 4.49 Flats FHP +
54 Opening Unit, Mixes Pref 3.57 Flats FHP +
55 Opening Unit, Newspapers 2.78 Flats FHP +
57 Inventory Mixed Pref 3.57 Flats FHP +
58 Inventory Mixed Pref 3.57 Flats TPH +
59 Inventory Newspapers 2.78 Flats FHP +
60 Inventory Newspapers 2.78 Flats FHP +
61 Flats, Origin 4.59 Flats FHP +
62 Inventory Foreign 4.59 Flats FHP +
63 Withdrawal, All Flats Second

Handling
3.57 Flats TPH -

64 Second Handling, Mixed, Pref 3.57 Flats TPH +
65 Originating Std 4.83 Flats FHP +
66 Opening Unit, Mixed Std 4.36 Flats FHP +
67 Inventory, Opening Unit, Mixed

Std
4.36 Flats FHP +

68 Console Reading (Pieces Fed) 1 Flats +
69 Carrier Bypass 1 Flats +
77 Originating Presort, Pref 1 Flats +
78 Originating Presort, Std 1 Flats +
90 Machine Canceled 4.72 Flats FHP +
91 Metered Preparation 4.18 Flats FHP +
92 Metered Bypass 4.49 Flats FHP +
93 Originating, Std 4.83 Flats FHP +

[ Inventor …]
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2-2.3 Parcel Source/Type Codes

2-2.3.1    S/T Codes 70-74, 79
Use these S/T codes with operations 100, 102, 103, 105, 107, 108, 130, 138,
139, 200, and 240-253:

Parcel Source/Type Codes

S/T
Code

Description Rate Type Mail Handling Action

70 Outside Piece 1 Parcels FHP +
71 Sacks 8.79 Parcels FHP +
72 Hampers 39.7 Parcels FHP +
73 Hampers - Extended 65 Parcels FHP +
74 Inventory - Hampers 39.7 Parcels FHP +
79 Parcels for Delivery 1 Parcels FHP +

Conv.
Source Description S/T Rate FHP

Outside Piece 70  1.00 X
Sacks 71  8.79 X
Hampers 72  39.7 X
Hampers--Extended 73  65.0 X
Inventory--Hampers 74  39.7 X
Parcels for Delivery 79  1.00 --

2-2.3.2    S/T Code 79

For all parcels that will be delivered by carriers—including parcels that are
presorted to carrier routes or otherwise require no distribution—use S/T code
79. Enter the actual piece count with a 7-1 or 7-3 transaction to operations
240-339. MODS adds this volume to the station/branch carrier volume.

2-2.4 Originating Presort Source/Type Codes
All originating presorted volume may be entered into MODS. Originating
presorted volume is not credited toward the first handling piece total of a
facility. The purpose of entering this volume is to track variances in the
amount or type of originating presorted volume received.
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2-2.4.1    S/T Codes 75-78
Use S/T codes 75-78 with operations 002 through 009:

                    Conv.
  Source Description S/T Rate 

Pref. Letters        75 1.00

Standard Letters    76 1.00

Pref. Flats & Parcels 77 1.00

Standard Flats & Parcels 78 1.00

2-2.5 Workload Unit Operation Source/Type Codes
Most operations in LDC 17 and 18 require entry of workload unit data—before
the tour or daily MODS cutoff time established for each office. To enter
workload units, use S/T code 99 and a 7-1 or 7-3 transaction.

Most workload units are entered using S/T code 99—except for SPBS, which
must use a 7 transaction. The SPBS is a required entry; the others are
optional.

2-2.5.1    Source/Type Code 99
Use S/T code 99 with non-distribution operations to credit work load units.

Conv.
Source Description S/T Rate

Workload Units 99 1.00

For opening and pouching operations (110-117, 120-129, 180-189), the
workload unit of measure is a sack, equivalent sack, or tray. Count all sacks
or trays that require work effort in these operations as they enter the
operation. Do not take credit for:

! output from these operations—sacks pulled or containers unloaded
! sacks or trays reworked within the same facility
! dispatched sacks or trays that do not require processing in the

opening pouching operations
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Conversion Rates for Work Credit Equivalent Sacks
Sacks per Container

Container   Full 3/4 Full 1/2 Full 1/4 Full

U-Cart (1075)  4  3  2  1
Gurney (1033)  5  4  3  1
Hamper (1046) 13 10  7  3
Hamper (1046) w/Insert  8  6  4  2
BMC/OTR 36 27 18  9
APC/GPMC 24 18 12  6
Wire Container 19 14  9  5
Platform Truck (1070) 27 20 13  7
Pallet/Skid 38 29 19 10

These are the workload units of measure used by the various operations:

ACDCS operations (118-119): a piece scanned. The number of pieces
scanned will generally be available from the computer that supports the
ACDCS equipment. Facilities with remote or bypass ACDCS equipment that
actually tag and scan mail must use other methods to obtain a piece count.
Enter the total number of pieces scanned with a 75 transaction.

Platform operations (210-234): a cubic foot of vehicle loaded or unloaded.
Take credit for both loading and unloading for mail processed for another
office that requires loading and unloading as a dock transfer.

Sack sorting operations (235-239): a sack, pouch, or outside piece sorted.
Sack sorting for work credit purposes is the first distribution of a sack, pouch,
or outside piece on a mechanized sack sorter, platform, slide, chute,
conveyor, multislide, or bullpen operation. Do not take credit for subsequent
sorts or sorts done on the platform as a part of the vehicle unloading process.
Where possible, use electromechanical devices, such as photocell counters,
for piece counting.

Registry section operations (585-590): a piece of registered or certified mail
distributed by a mail processing employee in the registry section. To
determine the total of all pieces distributed, use Form 3854 and/or Form
3854A for the tour or day.

Express mail operations (131, 669, and 793): a piece of inbound or outbound
express mail that requires distribution by a mail processing employee in the
express mail unit.

Bulk mail entry unit operations (001 and 839): a mailing accepted by the unit.
You can determine the number of mailings accepted from a count of the forms
used in accepting the mailings—Form 3602, Form 3602 PC, Form 3541, etc.).

2-2.6 Applicable Source/Type Codes
For each operation number, use only the S/T codes listed in this chapter. When an S/T
code is used that does not apply, it is reported on the MODS error signal report.
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3 Workhours

The MODS System accumulates workhours by operation, MODS Day, MODS
Tour, MODS Week, and MODS Accounting Period.  Before using operation
numbers to record workhours, the operation numbers must be validated.  In
this Handbook, the term "operation" means the same as "operation number"
and "operation-LU number."

Craft workhours are related to direct distribution or processing operations—
including time for allied labor.  Allied labor includes these and others:

! obtaining mail from staging areas
! opening and dumping mail from sacks or containers
! traying letters and flats
! loading ledges
! sweeping processed mail from cases, tying out loose packing, and

disposing of mail
! moving mail to scales and to subsequent handling or staging areas
! obtaining, handling, labeling, closing, and disposing of sacks or

containers at staging areas, dump holes, etc.
! loading or unloading loose packs or similar containers, unless a

centralized loose pack operation is used (See Operation 110, 120, or
180.)

! distributing letter or flat bundles that were tied out in a local office
! obtaining empty equipment for use in operating and moving excess

empty equipment—such as trays, containers, or sacks—to
designated internal storage areas

! recording and reporting missent mail received from other post offices
as necessary

! examining and spreading empty sacks or pouches

Record craft workhours in valid operation numbers, which you can find in
Appendix A.

3-1 Reporting Workhours
The MODS System accumulates both straight and overtime workhours by
operation number from non-exempt EAS and craft employees' clock rings.
EAS-exempt employees are not required to enter clock rings: their workhours
are automatically accumulated by the MODS System.
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3-1.1     Local Unit
To further define workhours and volumes by operation number, you can use
Local Units (LUs). LUs are 2-digit numbers assigned locally to operation
numbers to provide management additional tracking options for workhours
and volume reporting. For example, Operation 030-01 is an operation with a
local unit assigned to it.

Workhours and volumes by local unit are reported at the local level only.
Local units do not appear on district, area, or national MODS reports or in the
Corporate Date Base.

The default local unit for all operations is 00. All other local units are invalid
until activated in the local facility operation validity table for each Separate
Reporting Facility (SRF). For an explanation of SRFs, see the next section.

! To add local units to the operation validity table, use PSDS
transaction 0. When activating local units, the 00 default must be
activated before activating any other local units.

! To add local units in a PCMODS facility, see Chapter 8.

3-1.2   Separate Reporting Facility(SRF) Codes in PSDS
Sites
Installation heads in PSDS sites who want separate reports for one or more
reporting units within a finance number can assign 2-digit SRF codes. SRF
codes distinguish units for reporting purposes and create separate MODS
reports for the designated reporting unit/SRF.

Example:  An installation head may receive separate MODS reports for:
! the P&DC (SRF 00)
! the government mail section (SRF 01) in the same building
! the priority mail annex (SRF 03) located across town

Sites may have no more than 39 SRFs. If an installation head chooses not to
assign SRF codes, MODS automatically assigns SRF 00 as the default SRF
for the finance number. If an SRF is deleted, the remaining SRFs are
numbered as designated by the installation head.

3-1.2.1    Adding or Deleting SRFs
Submit requests to assign, add, change, or delete SRF codes to Eqan ISSC
one accounting period before the implementation date. Requests should
include this information:

! finance number
! post office name
! SRF name
! SRF number
! to change or delete an SRF, the number of the SRF where data will

be consolidated
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! effective date of the change

All SRF actions are effective on the first day of the accounting period.

3-1.2.2 Machine Number Ranges for SRFs
This exhibit lists the allowable machine identification numbers by SRF codes.
The machine type determines the numerical value of the first digit of the
machine identification number.

MACHINE TYPES

1- Transactor 3- Floor Scale 5- Alphanumeric System
2-Bench Scale 4- In Motion Scale 6- Badge Reader

SRF CODE MACH ID # SRF CODE MACHI ID # SRF CODE MACH ID NO
00 X001-X275 14 X721-X730 28 X881-X890
01 X276-X385 15 X731-X740 29 X891-X900
02 X386-X435 16 X741-X750 30 X901-X910
03 X436-X485 17 X751-X780 31 X911-X920
04 X486-X620 18 X781-X790 32 X921-X930
05 X621-X630 19 X791-X800 33 X931-X940
06 X631-X640 20 X801-X810 34 X941-X950
07 X641-X660 21 X811-X820 35 X951-X960
08 X661-X670 22 X821-X830 36 X961-X970
09 X671-X680 23 X831-X840 37 X971-X980
10 X681-X690 24 X841-X850 38 X981-X990
11 X691-X700 25 X851-X860 39 X991-X999
12 X701-X710 26 X861-X870
13 X711-X720 27 X871-X880

3-2 Recording Workhours

   Special Requirements
For PSDS offices, each employee is assigned a base finance number/SRF in
the PSDS master file. This number indicates his or her normal reporting unit.

Each time-recording device is assigned an SRF code in MODS that
corresponds with the finance number/SRF/reporting unit where the device is
located.

Clock rings must be entered on a time clock in the finance
number/SRF/reporting unit where the work will be performed.

   General
All employees must use correct clocking procedures to ensure that hours are
charged to the correct finance number/SRF/reporting unit.

Employees must record workhours in the operation, local unit, and SRF
where the work is performed.
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! Only the operation numbers in Appendix A may be used to record
workhours.

! Only operation numbers validated in the SRF operation table may be
used to record workhours.

! Only valid local units assigned in the SRF validity table may be used
to record workhours.

The SRF validity table of the time-recording device on which clock rings are
made determines the validity of operation numbers used in clock rings.

3-2.2.1   Recording Hours in the Correct Operation Number and/or
Local Unit
Employees use time-recording devices to select the operation number to
record workhours. When recording hours manually, enter the operation
number on these two forms:

! PS Form 1260, Non-Transactor Card
! PS Form 1261, Non-Transactor Report

1-7.1.1     Recording Hours in the Correct Separate Reporting
Facility
For PSDS offices, employees who perform work outside their finance
number/SRF/reporting unit use special function keys (TR: transfer key) on the
time-recording device in the new reporting unit/SRF to transfer hours to the
new in the finance number/SRF/reporting unit.

When manually recording clock rings, enter the SRF on these two forms:
! PS Form 1260, Non-Transactor Card
! PS Form 1261, Non-Transactor Report

3-3 Specific Clocking Procedures to Record Workhours
These are the procedures we use to properly record workhours by Finance
Number/SRF/Reporting Unit. MODS accumulates workhours from three types
of clock rings:

! standard clock rings
! transfer/loan clock rings
! adjustment clock rings

3-3.1     Standard Clock Rings
Employees enter standard clock rings on an Employee Badge Reader (EBR).
The employee selects a ring type (BT, OL, IL, ET) and an operation number.

MODS reports the workhours in the SRF assigned to the EBR. If employees
enter clock rings on an EBR assigned to a different SRF/reporting area,
MODS reports the workhours in the valid SRF assigned to their finance
number/reporting area.
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3-3.2    Transfer Clock Rings
Transfer clock rings are entered when an employee uses the TR function key
on an EBR. The TR function key transfers hours to a designation/activity
code, labor distribution code, and/or SRF in a facility other than the
employee's base EBR/SRF/reporting area. Employees record workhours on
the operation where the work is to be performed.  When entering rings
manually:

! Record the SRF on either PS Form 1260 or PS Form 1261.
! Do not use loaned operations numbers 988-997; these operations are

for loans to finance numbers outside the facility.

TR transactions clock rings must be entered on an EBR assigned to the
SRF/reporting area where the hours are transferred.

MODS reports transfer workhours in the reporting area identified in the TR
transaction and the SRF assigned to the EBR where the rings are entered.

If the TR transaction reporting area and the EBR/SRF reporting area are
different, MODS reports the workhours to the transferred finance
number/reporting area and a default SRF assigned to the transfer reporting
area.

City:  Plains, USA

Name Finance Number Assigned SRF Default SRF
P&DC 32-0000 00 00
CS 32-1111 01,02,03 00
AMC 32-4444 04 00
BMC 32-5555 05 00

Employee
Assigned to SRF

Enters Clock Rings on
EBR Assigned to SRF

Loaned to TR MODS Reports Workhours
in SRF/Finance Number

Number Name Number Name Number Name SRF Finance Name
00 P&DC 01 CS 01 CS 01 32-1111 CS
04 AMC 00 P&DC 00 P&DC 00 32-0000 P&DC
05 BMC 00 P&DC 00 P&DC 00 32-0000 P&DC
01 CS 04 AMC 04 AMC 04 32-4444 AMC
02 CS 00 P&DC 00 P&DC 00 32-0000 P&DC

Employee
Assigned to SRF

Enters Clock Rings on
EBR Assigned to SRF

Loaned to TR MODS Reports Workhours
in SRF/Finance Number

Number Name Number Name Number Name SRF Finance Name
00 P&DC 00 P&DC 01 CS 01 32-1111 CS
04 AMC 04 AMC 00 P&DC 00 32-0000 P&DC
05 BMC 05 BMC 02 CS 02 32-1111 CS
01 CS 01 CS 00 P&DC 00 32-0000 P&DC
02 CS 02 CS 04 AMC 04 32-4444 AMC
03 CS 03 CS 05 BMC 05 32-5555 BMC
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3-3.3    Other Clock Rings
MODS accumulates workhours from 5 codes the same way as for Standard
and Transfer/Loan clock rings.

3-3.3.1     5 Codes
5 Code clock rings are applied the same as Standard clock rings.

! If the employee’s reporting area and the SRF reporting area match,
MODS reports these workhours in the SRF entered in the transaction.

! If the employee’s reporting area and the SRF reporting area are
different, MODS reports the workhours to the default SRF assigned to
the employee’s base finance number/reporting area.

3-3.3.2    5L Transactions
5L transaction clock rings are applied the same as Transfer/loan clock rings.
The 5L transaction must be entered on an SRF assigned to the reporting area
where the workhours are loaned.

! If the 5L transaction finance number/reporting area and the SRF
reporting area match, MODS reports the workhours in the SRF
entered in the transaction.

! If the 5L transaction finance number/reporting area and the SRF
reporting area are different, MODS reports the workhours in the
loaned finance number/reporting area and a default SRF assigned to
the loaned reporting area.

3-4 Specific Clocking Procedures

3-4.1    Non-exempt and Craft Employees
Non-exempt and craft employees must always be clocked into the operation
where they are assigned.

3-4.2    Exempt Employees
EAS-exempt employees are not required to enter clock rings. Their hours are
automatically accumulated by MODS based on the operation number
assigned in the employee’s master record. You can override this automatic
accumulation of hours by entering clock rings through an EBR or transactor.

3-4.3    When  Moving from One Operation to Another
If an employee moves from one operation to another, the employee must
immediately clock into the new operation. If the employee is moving between
floors or between buildings, use the appropriate travel operations in Appendix
A.
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3-4.4    Stand By Operations
For personnel in mail processing, customer services, and delivery services
who cannot be gainfully employed, report workhours in the appropriate stand
by operation number defined in Appendix A.  This does not apply to
temporary equipment breakdowns of ten minutes or less.

3-4.5     MODS Overtime
MODS overtime hours are included in workhours and are reported separately
for informational purposes. MODS does not distinguish:

! regular overtime from penalty overtime
! out-of-schedule premium
! supervisory extra straight time hours authorized

Penalty overtime, out-of-schedule premium, and supervisory over-forty hours
are reported as overtime on the MODS.

MODS overtime hours should be reconciled with paid overtime hours (NWRS)
within a tolerance of 5% per pay period.

3-5 PSDS Authorizations
Hours worked over 8 hours in a day or 40 hours in a week are not reported as
overtime on MODS unless PSDS timely overtime authorizations are entered.
Time and Attendance overtime authorizations (TR 2-9), in conjunction with
employee clock rings, provide overtime hours on MODS in the operation
where the overtime hours are worked.  Incorrect overtime authorizations
distort overtime hours on the MODS.

Example:  An employee begins two hours after tour overtime at 1500. If you
enter 1400 for the after-tour overtime authorization, the overtime will be
reported on MODS in the operations worked from 1400-1600—not 1500-1700.

If overtime hours for an employee cross two MODS days, enter the overtime
authorization before the MODS split time for the first day. This ensures that
the overtime is reported correctly on both MODS days.

Example:  The office MODS day ends at 0800 a.m.  An employee is on two
hours after-tour overtime beginning at 0700 a.m. For MODS to report 1 hour
overtime for each day, the overtime authorization must be entered before the
0900 a.m. MODS daily adjustment cutoff time.

3-5.1     MODS Overtime Adjustment
When PSDS (paid) overtime hours are reported incorrectly, MODS overtime
hours are also reported incorrectly. Note, however, that two separate
transactions are required to correct overtime hours:

! For paid hours, use PSDS TR 6, Total Hours Adjustment.
! For MODS overtime hours, use TR 79, Overtime Estimate.
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When adjusting overtime hours with PSDS TR 6, you may need to use TR 79
to adjust  MODS overtime hours.

3-5.2     Forced Overtime
The Time and Attendance System “forces” payroll records to crossfoot to 40
hours when they are not corrected in a timely manner.

Example:  An employee who is eligible for overtime has more than 8 hours in
a day or more than 40 in a week and the overtime is not authorized using
either TR 2-9 or TR 6. In this case, the payroll system will “force” the payroll
record to crossfoot by paying the unauthorized overtime.

“Forced” overtime is not reported as overtime in MODS:
! If the forced overtime is correct, adjust MODS overtime to agree with

the paid overtime using TR 79 in the operation where the overtime
was worked.

! If the forced overtime is not correct, prepare a payroll adjustment to
recover the overtime hours. When the payroll adjustment is
processed, the paid overtime and the MODS overtime will agree.

5.2-3     Transactor Screen 79
To adjust MODS overtime hours by operation, use transaction code 79,
Overtime Estimate. Overtime resulting from a TR-6 or forced by the Time and
Attendance System may require adjustment to the MODS using transaction
code 79.

! For transaction code 79, use the current day of the pay period on
which the transaction is entered.

! For stations and branches (customer or delivery service), enter
overtime as replacement (REP) or other.

Use these character settings for this transaction:
! Characters 1-2: Transaction code 79
! Characters 3-7: Operation number
! Character 8: Value 1 = other (plus)

2 = other (minus)
3 = replacement (plus)
4 = replacement (minus)

! Character 9: Frequency
1 = Current Day
2 = Prior Period
3 = Year-to-date

! Characters 10-12: Number of whole OT hours
! Characters 13-14:    SRF
! Characters 16-21: Finance

Note:  The entry period for the current day is one hour after the MODS day
begins until one hour after it ends. For prior period and year-to-date
adjustments, the entry period is up to cut-off time Sunday morning.
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ONLINE    07.53

SCREEN:  79 MODS OVERTIME ESTIMATE

TR OPERATION/ O/T
CD LOCAL UNIT VALUE FREQUENCY HOURS SRF FINANCE
__ ___-__ _ _ __ __ ______

OPN/LU :  OPERATION NUMBER - LOCAL UNIT

VALUE :  1 = PLUS REGULAR OT, 2 = MINUS REGULAR OT
   3 = PLUS REPLACEMENT OT, 4 = MINUS REPLACEMENT OT

FREQUENCY :  1 = CURRENT DAY, 2 = PRIOR PERIOD, 3 = YEAR-TO-DATE

O/T HOURS :  NUMBER OF OVERTIME HOURS

SRF/FINANCE :  ENTER SRF OR FINANCE, ONE OR THE OTHER, NOT BOTH
HYPEN FILL FILED NOT USED

SCREEN:     71&72 73&74 75 94 95 96 97 98 PD MENU

3-6 Computing Workhours
Workhours are computed from non-exempt EAS and craft employee time and
attendance entries according to the operation number associated with each
clock ring.  Exempt EAS employees' workhours are computed using the
operation entered in the PSDS Employee Master Record Coding.

These entries start the accrual of time:
! begin tour (BT)
! in from lunch (IL)
! move (MV) entries

These entries end the accrual of time:
! out to lunch (OL)
! end tour (ET)

The system adds the accrual for all employees by separate reporting facility,
tour, and operation number.  Hours are rounded to the nearest whole hour.
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3-6.1     MODS Tours
MODS tour cutoffs are calculated in 8-hour increments beginning with the
MODS day cutoff.

Example: The MODS day cutoff is 0700, and the tour 2 cutoff is eight hours
later or 1500. The next exhibit shows the MODS tour cutoffs:

MODS Tour Cutoffs

If the MODS Daily
Cutoff Time is

MODS Tour 2
Cutoff Time is

MODS Tour 3
Cutoff Time

MODS Tour 1
Cutoff Time

0600 1400 2200 0600
0700 1500 2300 0700
0800 1600 2400 0800

The next exhibit shows the calculation of hours for an employee during a tour:

Employee Workhours for One MODS Work Day

Ring
#

MODS
Day

MODS
Tour Clock Rings MODS Calculation of Workhours Operation

1 3 1 BT 0600 030 (Start accumulation) 030
--Daily Cutoff Time 0700

2 4 2 MV 0800 040 Ring 2 Minus Ring 1 = 2.00 hours 030
3 4 2 MV 0900 050 Ring 3 Minus Ring 2 = 1.00 hours 040
4 4 2 OL 1000 050 Ring 4 Minus Ring 3 = 1.00 hours 050
5 4 2 IL 1050 030 (Off the clock)
6 4 2 MV 1250 040 Ring 6 Minus Ring 5 = 2.00 hours 030
7 4 2 ET 1450 040 Ring 7 Minus Ring 6 = 2.00 hours 040

   Total = 8.00 hours

Note:  With a MODS day cutoff of 0700, one hour will be reported in MODS
day 3, and the remaining 7 hours will be reported in MODS day 4.

3-6.2    Clock Ring Sequence Errors
A sequence error occurs when:

! the employee’s basic clock rings are not entered in the proper
sequence

! when a basic clock ring is omitted, redundant, or improperly
preceded, separated, or followed by a move ring

When MODS encounters an employee’s clock rings, part of which are in
sequence error, MODS calculates the hours for the correct clock rings and
ignores the portion in sequence error.

Example:  An employee has no begin-tour, an out-to-lunch at 1200, an in-
from-lunch at 1250, and an end-tour at 1650. MODS will calculate the hours
between 1250 and 1650, but will ignore the hours before the 1200 out-to-
lunch ring.
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When sequence errors in clock rings are corrected before the daily MODS
cutoff, the correct workhours are reflected on the daily MODS reports.

Example: If the BT ring in the previous exhibit was omitted, the accumulation
for operation 030 would be one hour short on MODS day 3 and one hour
short on MODS day 4. Entering the correcting transaction (511 0600 030)
during MODS day 4 would reflect the correct MODS day 4 total workhours
(7.0 hours), and the correct MODS day 4 workhours on operation 030 (4.00
hours). The one hour for operation 030 on day 3 will be reflected on the
weekly report.

! If a ring adjustment is entered after the daily cutoff, the next level of
reporting (weekly or accounting period) reflects the adjustment.

! If the MODS day 4 begin tour clock ring is entered on MODS day 5,
the result is an adjustment of two hours for operation 030 on the
weekly report.

3-6.2.1    Purged Clock Rings
Purged clock rings are uncorrected sequence errors and carrier route errors.
If they are not corrected within three days, they are removed from the Time
and Attendance System. When these rings purge, MODS automatically
deletes all hours previously charged and associated with the purged rings.
Purged clock rings must be reentered exactly in the operations where they
were originally worked.  Do not re-enter the purged clock rings using
operation 998 (Time and Attendance Correction).

3-6.2.2    Default Hours - Operation 999
Hours that cannot be charged to valid operations default to operation 999.
These hours are charged to LDC 50 or LDC 53 based on the designation
activity of the employee. Operation 999 hours are found on the Finance
Operating Report.

Note: Designation activity 19-0 defaults to LDC 53.

Hours that cannot be charged to a valid local unit default to operation 999-00.

3-6.3 End Tours

3-6.3.1    Computing Hours
The most critical ring is the end tour (ET) ring. If an employee fails to enter an
end tour (ET) ring, MODS will continue to accumulate time to the next MODS
tour cutoff.

Example:  If the employee in the next exhibit leaves without entering an end
tour (ET) ring, MODS continues to charge hours until 1500—the MODS tour 2
cutoff—which overstates the hours in operation 150 by .50 hours. The .50
hours is the additional time charged from 1450 (the scheduled end tour time)
and 1500 (the MODS tour 2 cutoff). When the correct end tour is entered,
MODS adjusts the workhours accordingly.
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Employee Workhours for One Tour

MODS
Ring

MOD
S
Day

Tour Clock Rings Time Calculation Operation

1 3 1 BT 0600 030 (Start accumulation) 030
--Daily Cutoff Time 0700

2 4 2 MV 0800 040 Ring 2 Minus Ring 1 = 2.00 hours 030
3 4 2 OL 0900 040 Ring 3 Minus Ring 2 = 1.00 hours 040
4 4 2 IL 0950 150 Tour 2 cutoff Minus Ring 4=5.50 hours 150
--Tour 2 Cutoff Time 1500--

   Total = 8.50 hours

3-6.3.2     Time and Attendance Clock Ring Adjustments.
Time and Attendance clock ring adjustments entered after the weekly MODS
cutoff (Sunday daily cutoff) will be reflected in the accounting period data.
Clock ring adjustments entered after the accounting period MODS cutoff will
be reflected in the next accounting period MODS year-to-date data.

3-6.4    Total Hours Time and Attendance Hour
Adjustments
MODS does not use Time and Attendance hour adjustments (transaction
code 6 - Total Hours Adjustment) in its hour calculations; Time and
Attendance hour adjustments have no effect on the MODS System. Do not
use transaction code 6 instead of daily clock ring (transaction code 5) or for
overtime authorization (TR 2-9).

To enter any adjustments for MODS workhours or overtime, you must use the
A4, 7-9, PA, or PB transactions. For more, see Chapter 4.

3-6.5     Invalid Social Security Number Adjustments
Clock rings made with invalid social security numbers will accumulate
workhours for MODS. To adjust MODS hours accumulated by invalid social
security numbers, either use an A-4 transaction or correct the invalid clock
ring while still online in PSDS.

3-7 Work Hour Adjustments

3-7.1    Transactor Screen A4
Use transaction screen A4, MODS Work Hour Adjustment, to add and
transfer workhours from or to operation numbers:

! by day
! by week
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! by accounting period
! by year to date

This transaction adjusts hours within an accounting period only if the
transaction is entered by day 1 of the next accounting period. Adjustments
made for a prior accounting period after day 1 reflect only as year-to-date
hours and are not reflected in next year's SPLY hours by accounting period.
This transaction does not affect payroll accounting.

You can add hours to one Operation-LU without deducting from another
Operation-LU; however, hours cannot be deducted from one Operation-LU
without adding those hours to another Operation-LU. Subtracting workhours is
permitted only for year-to-date adjustments using all zeros as the to
Operation-LU.

The cutoff time for inputting transaction codes A4 is the daily cutoff time. The
workhours transfer report must be verified, approved, and initialed by the
appropriate functional manager or designee. These are the necessary
character settings for a transaction code A4:

! Characters  1-2: Transaction code A4
! Characters  3-7:  From Operation-LU
! Characters  8-9:  From Separate Reporting Facility code
! Characters 10-15:  From Finance Number
! Characters 16-20:  To Operation-LU
! Characters 21-22:  To Separate Reporting Facility code
! Characters 23-28:  To Finance Number
! Characters 29-30:  Accounting period to be adjusted
! Characters 31-32:  Day of AP to be adjusted, 01-28
! Characters 33-35:  Amount of workhours
! Character  36: Craft 1 = Clerk & Other, 2 = Mailhandler,

 3 = Supervisor
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ONLINE    14.90

SCREEN:  A4 MODS WORK HOUR ADJUSTMENT

Day
TR *--------------FROM--------------**--------------TO------------------*  OF WORK CRAFT
CD OPN/LU  SRF FINANCE OPN/LU SRF FINANCE AP AP HOURS CODE
_ _ ___-__ __ ______ ___-__ __ ______ __ __ ___ _

ENTER EITHER SRF OR FINANCE (FOR BOTH FROM AND TO)

AP :  00 = YEAR TO DATE, 01 - 13 FOR DAILY

CRAFT CODE :  1 = CRAFT & OTHERS, 2 = MAILHANDLER, 3 = SUPERVISOR

SCREEN:     A1 A2 A3 A5 A6 A7 A8A&B ABC A9 MENU

3-8 Time and Attendance Inquiries
Attendance inquiries provide employee clock ring information by:

! employee number
! operation number
! specified device number
! pay location number

Use these transactions to verify attendance and ensure that employees are
clocked into the operation where they are working.

3-8.1    Transactor Screen 70
Use transactor screen 70, Attendance Inquiry by Machine Number, to obtain a
list of employees whose last clock ring was made on a specified input device
before a specified time. The request must be for the current day, DPP. Only
on-line clock rings appear on the report (begin tour, in-from-lunch, and
moves). Use these character settings for these transactions:

! Characters 01-02:  Transaction code 70 (preset)
! Characters 03-06:  Machine number
! Characters 07-10:  Time of attendance check (hours and hundredths)
! Characters 11-12:  DPP. Use current day of the pay period.
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ONLINE    14.90

SCREEN:  70 ATTENDANCE INQUIRY BY MACHINE NUMBER

TR MACHINE
CD NUMBER TIME DPP

---- -- -- -- -- -- --.-- -- -- --

MACHINE NUMBER :  BEGINS WITH “6” FOR BADGE READERS
:  BEGINS WITH “1” FOR TRANSACTORS

DPP :  USE CURRENT DAY OF PAY PERIOD

SCREEN:     5 2L 29 2H 6 42 83 84 85 86 MENU

3-8.2    Transactor Screen 76
To obtain a list of employees whose last clock ring was made on a particular
operation or pay location who are on the clock at a specified time, use
Transactor Screen 76, Online Attendance Inquiry by Pay Location Number or
OPN-LU,.

Note:  If you enter 9999 for the time, the report will include ALL clock rings for
employees who had rings on the operation/pay location requested. The
request must be for the current day, DPP.  Only on-line clock rings appear on
the report (begin tour, in-from-lunch, and moves). If the supervisor wants all-
day information for the specific operation, enter 9999 for the time. Use these
character settings for these transactions:

! Characters  1-2: Transaction code 76 (preset)
! Characters  3-6:  Time-of-attendance check (hours and

hundredths)
! Characters  7-11: Operation-LU
! Characters  12-14: Pay Location
! Characters 15-16: DPP. Use current day of the pay period.



April 2000                                                                                                                                  44

ONLINE    14.49

SCREEN:  76 ONLINE ATTENDANCE INQUIRY BY
PAY LOCATION NUMBER

OR
OPN-LU

TR PAY
CD     TIME OPN-LU LOCATION DPP
76          . -- -- -- -- -- -- -- --

OPN-LU :  IF INQUIRY IS FOR OPN-LU, ENTER HYPHENS IN PAY LOCATION
PAY LOCATION :  IF INQUIRY IS FOR PAY LOCATION, ENTER HYPHENS IN OPN-LU
DPP :  USE CURRENT DAY OF PAY PERIOD

**********    NOTE    **********
ENTER EITHER OPN-LU OR PAY LOCATION, ONE OR THE OTHER, NOT BOTH

SCREEN:     5 2L 29 2H 6 42 83 84 85 86 MENU
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3-8.3    Transactor Screen PD
To obtain a list of employees who made clock rings on a particular operation
for a prior MODS day (up to seven MODS days back), use Transactor Screen
PD, Prior MODS Day Hours Inquiry by Accounting Period and Day.  Use
these character settings for these transactions :

! Characters 1-2: Transaction code PD
! Characters 3-4: Accounting Period
! Characters 5-6: Prior Day of the Accounting Period
! Characters 7-8: Separate Reporting Facility (SRF) Code
! Characters 9-13: Operation-LU
! Characters 14-45: Multiple SRF and Operation-LU request

SCREEN:  PD ONLINE    14.49
PRIOR MODS DAY HOURS INQUIRY
BY ACCOUNTING PERIOD AND DAY

TR CD AP PRIOR/DAP SRF OPN-LU SRF OPN-LU
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

SRF OPN-LU SRF OPN-LU SRF OPN-LU
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

AP :  ACCOUNTING PERIOD, 01 - 13
PRIOR DAP :  PRIOR DAY OF THE ACCOUNTING PERIOD, 01 - 28

   NOTE.  7 DAYS PRIOR TO CURRENT DAY OF ACCOUNTING PERIOD
SRF :  ENTER A SPECIFIC SRF, OR XX FOR ALL SRF’S
OPN-LU :  ENTER A VALID OPN-LU, OR XXX-XX FOR ALL OPN-LU’S

****************  UNUSED FIELDS ARE DASH FILLED ****************
****ONLY ONE REQUEST ALLOWED WHEN REQUESTING ALL SRF’S WITH ALL OPN-LU’S****

SCREEN:     MENU

3-8.4     Transactor Screen 81
Use transactor screen 81, Attendance Inquiry by Employee ID Numbers, to
obtain a list of an employee's current online clock rings.  All current online
clock rings appear on the report. Use these character settings for these
transactions:

! Characters 1-2: Transaction code 81
! Characters 3-11: Employee ID number (social security number)
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ONLINE    14.45

SCREEN:  81 ATTENDANCE INQUIRY BY EMPLOYEE ID NUMBERS

PAY
TR ID
CD NUMBER

81 _________

SCREEN:     5 2L 29 2H 6 42 83 84 85 86 MENU

3-8.4     MODS Prior AP Adjustments
Input Screens:

! Screen PA:  MODS Prior AP Adjustment - Part A
! Screen PB:  MODS Prior AP Adjustment - Part B

These transactions cannot be used for current period adjustments. Use the
correct values—and not the difference between the current amount and the
correct amount.

Transactions will be generated to update the Corporate Data Base file.  A
report is printed the day following input to allow verification of the data
entered. The PA Transaction will adjust FHP, TPH, TPF, hours, and overtime.

! Enter only the fields to be changed, and fill the unused fields with
hyphens.

! Enter zeroes in a field to create an adjustment with a value of zero.
! Enter Volume Data in pieces to the nearest 100.

The OT Adjust Field will affect regular OT only—not replacement. The Hour
Adjust Field will affect clerk hours only.

Example: If an operation reports clerk and supervisor hours, only the clerk
hours amount will be adjusted.

Also, if an operation reports LTR, FLT, and PAR, only the LTR amount will be
adjusted. This affects operations such as 713, 240, and 769.RE
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EN:  PA ONLINE    14.49

MODS Prior AP Adjustment - Part A

TR
CD FY AP Day LDC SRF OPN-LU
P A -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

FHP TPH TPF Hours Overtime
-- -- --.-- -- -- --.-- -- -- --. -- -- -- -- -- -- -- -- --

(Enter the total correct amount.  DO NOT enter the difference between the current
amount and the correct amount.)
Volume data (FHP,TPH,TPF) are entered in pieces to the nearest 100.
Only enter fields to be changed and unused fields are hyphen filled.

**This transaction can only be used for prior accounting period adjustments.**

SCREEN:     MENU

The PB Transaction will adjust AFCS FIMS or AFCS categories.  Enter only
the fields to be changed, and fill the unused fields with hyphens.  Entering
zeroes in a field will create an adjustment with a value of zero.

SCREEN:  PB ONLINE    14.49
MODS Prior AP Adjustment - Part B

TR No of Run Down
CD FY AP Day LDC SRF OPN-LU Mach Time Time
P B -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

* Other equipment volume (encodes, AFCS FIMS or AFCS categories)*
ST Pieces ST Pieces ST Pieces ST Pieces
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- ---

(Enter the total correct amount.  DO NOT enter the difference between the current  amount and
the correct amount).

Use the “other equipment volume” field for adjusting encode AFCS FIMS, or AFCS categories.
Only enter field to be changed and unused fields are hyphen filled.

* This transaction can only be used for prior accounting period adjustment.
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3-9 Error Reports

3-9.1     Invalid Operation Report
This report does the following:

! identifies hours calculated from clock rings with invalid operation
numbers

! transfers them to LDC 50 and LDC 53
! prints the complete set of rings for these employees

Supervisory overtime hours charged to operation 999 cannot be removed
from the MODS report. This is because operation 999 is used to collect both
craft and supervisory overtime charged to invalid operations and TR 79 does
not distinguish between craft and supervisory overtime.

3-9.2     MODS Daily Error Transactions Report
This report reflects MODS wishes that defaulted to an SRF, which happens
when the employee’s reporting area/base finance number and the machine ID
of the clock ring are inconsistent. The inconsistency causes MODS to default
these workhours to a valid SRF for the employee’s finance number.
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4System Inputs and Computations—
Workloads

4-1 Recording Mail Volume
To record mail volume, follow these guidelines:

! For mail volume from mail processing equipment, use the End of Run
(EOR) application. For manual entries into EOR, use console or
meter readings.

! For letters and flat mail by weight, use the MODS scale system—
except for machine counts or actual pieces from mailers' statements.
For inventories, use the MODS scales or linear measurements.

! Record newspapers by weight when they are distributed in cases in a
flat operation.

! Record the parcel volume by container count, meter readings of
parcel sorting machines, or other counters. Credit outside parcels to a
parcel operation.

! To show the inventory status of the mail volume, use clearance tags:
o Label 139, Input Weighed
o Label 141, Inventoried
o Label 142, Do Not Weigh

! Record workload units in specified non-distribution operations.

4-2 Recording Distribution Operations
Distribution sorts mail to:

! automated area distribution centers (AADCs)
! area distribution centers (ADCs)
! states
! sectional facility centers
! cities
! foreign countries
! official mail
! associate offices
! stations
! branches
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! carrier routes
! holdouts (for example, firms, addresses, institutions, and boxes)
! box sections
! ZIP Codes
! uncoded mail
! nixie
! APO, FPO, and others

Sortations by size, shape, weight, class, or facing are not a distribution.

4-2.1    General Policy
For all distribution operations, piece handling will be credited only for
distribution letters, flats, and parcels. Priority Mail receives piece handling
credit in the operation where it is processed. Only designated and properly
trained employees may record mail volumes.

4.2.2    Recording First Handling Pieces (FHP)
Mail receives its FHP count—First Handling Pieces—in the operation where it
is first distributed in the post office. Each piece of mail distributed in an
office—letters, flats, and parcels, except irregular parcel post, and IPP—
receives only one FHP count.

4-2.3    Recording Subsequent Handling Pieces (SHP)
Subsequent Handling Pieces (SHP) is mail that was first distributed as FHP
but later receives further distribution in that office. In MODS, SHP is projected
to downstream manual operations using one of these methods:

! local mailflow densities
! actual bin counts
! scale transaction

Backflows and reworks are not valid as subsequent handlings. Here are two
examples of backflows and rework mail:

! For rework, mail that is mis-sent to a postal facility and returned to the
plant for processing does not require a piece handling credit.

! For a backflow, mail mis-sorted within a postal facility does not
receive a piece handling credit. Mail worked in operation 030 and
mis-sorted to operation 040 does not receive a piece handling credit
when returned back to operation 030 for processing.

4-2.4     Recording Total Piece Handlings (TPH)
For manual operations, Total Piece Handlings (TPH) is the total of FHP and
SHP volumes. For validating machine operations, MODS records the actual
total piece handling from either End Of Run (EOR) application, meter
readings, or printouts.

! For PSDS offices, enter the total pieces accepted for these
operations with transactor code 75 or EOR.
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! For PCMODS offices, enter the total pieces accepted through the
Volume Data Entry screen or EOR.

4-2.5    Recording Mail Preparation Operations
Mail volume in distribution operations accumulates from volume entries. Mail
preparation operations 010-019 and 020,020B-bypass do not receive an FHP,
SHP, or TPH count; they receive a non-add TPH count. A piece count is
accumulated for these operations simultaneously as inputs are recorded into
the distribution operations.

Example: Letter mail weighed from 020 to 881 will credit FHP to 881, and the
same number of pieces to 020.

4-2.6 Letter Canceling
Mail canceled on the AFCS must be incorporated into the End of Run (EOR)
application. For other canceling areas:

1. Total the readings from letter-canceling devices each day.

2. Enter them in PSDS through transactor code 7-5.

PCMODS offices manually enter the pieces canceled through the Data,
Manual Entry screen. When weighing mail, follow these guidelines:

! Weigh hand-canceled letters into distribution operations with
Source/type code 11 (S/T code 11).

! Weigh hand and machine-canceled flats into distribution operations
with S/T code 51.

Volume weighed with S/T codes 11 and 51 will credit FHP to the distribution
operation, and the same number of pieces to the canceling operation.

When mail is presented for weighing or counting, ascertain and properly enter
the type of mail, its origin, and destination. Record mail volume as defined by
the specific operation and S/T code (see Chapter 2 and Appendix A).  Here
are two PSDS examples:

! 881 02 shows that a quantity of mail going into operation 881 for
distribution is metered, preferential, machinable-size letters from the
metered facing unit, and is to be converted to pieces at a rate of
27.88 letters per pound. This mail is counted as first handling pieces
in (FHP) operation 881. It is also counted as pieces in operation 020.

! S/T code 52 identifies metered flat mail coming from the mail
preparation unit to a distribution operation. 141 52 shows that a
quantity of mail going into operation 141 for distribution is to be
converted to pieces at a rate of 4.18 flats per pound and counted as
FHP. It is also counted as pieces in operation 020.

4-2.7 Recording Presort Operations
For the presort operations, recording volume is mandatory. The data is input
directly into the system from the source document through:

! transactor screens (PSDS)
! Form 3602, Statement of Mailing with Permit Imprints
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! other forms used to record bulk mailings accepted from a mailer,
including Form 3602-PC, Statement of Mailing--Bulk Rates, and Form
3541-A, Statement of Mailing--Second Class/Requester Publications

Include in these volume recordings all originating presort volumes processed
in the acceptance unit at the MODS or PCMODS office. For FHP purposes,
volumes for these operations are "non-add".
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4-2.7.1 Additional Handling
Record all presort volumes that require additional handling in the appropriate
distribution operation.

4-2.7.2 Recording Procedures
Volume recordings provide a count of presort volume. Record hours required
for traying and sleeving of presort volumes in the associated presort
operation.

! In PSDS offices, record presort letter, flat, and parcel volumes and
work hours as defined by operations 002 through 009, using S/T
codes 75-78.

! In PCMODS offices, add these volumes by operation number on the
Data, Manual Entry screen.

4-2.8 Recording Workload Units
Record workload units for operations that perform indirect distribution of mail.
Recording  workload units is a local management decision. Workload units,
which vary from operation to operation, give indirect distribution operations a
trackable measure of work.

Example: Opening and pouching operations record the number of sacks or
equivalent sacks processed, while platform operations record the number of
cubic feet loaded or unloaded.

4-2.8.1 Work Credit Factors
To convert workload units into work credits, MODS uses national conversion
factors. Work credits give us a way to compare work effort in unlike
operations. Work credit factors are also applied to direct distribution
operations.

To arrive at the total work credits, multiply the TPH by the work credit factor.
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4-2.8.2 Indirect and Direct Work Credit Factors
The next exhibit lists work credit factors:

Work Credit Factors

Composite
Operation
Number

Description Work
Credit
Factor

010C, 020C, 020B Mail Preparation   0.30
110C, 120C, 180C Opening and Pouching 52.00
118C ACDCS 15.00
210C, 230C Platform   1.50
235C, 238C Sack Sorting 12.40
Oper: 349 Mechanized Sack Sorter

International
12.40

131C Express Mail 25.00
Opers:585 - 590 Registry 31.40
001 Bulk Mail Acceptance 394.33

Letters 1.00
Flats 2.20
Parcels 9.00
Priority 2.80

4-2.9 National Conversion Rates

4-2.9.1 Converting Pounds into Pieces
If automatic machine counters or meters are not available, weigh letters and
flat mail into distribution operations. MODS then converts pounds into pieces.

Whenever mail is weighed, affix a clearance label—MODS scale ticket or
Label 139, Input Weighed. Label 139 is used in offices that have a MODS
scale system, PCMODS scale.  On Label 139, include this information:

! the weight
! date
! tour
! time
! number of trays
! mail identification code (the operation and the source/type code or

trans type/mail type)

In those rare cases when scales are not available, use the linear rates in the
next exhibit. You can also use linear rates or pound rates for inventories.
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Linear Rates

Description Pieces Per
Pound

Pieces Per Foot

Letter Mail
Machine Canceled 35.51 294
Hand Canceled 21.42 92
Machinable Metered 27.88 214
Machinable Metered Bypass 28.25 219
Non-machinable Metered 21.52 136
Non-machinable Metered Bypass 15.07 112
Machinable Mixed Pref 28.55 250
Non-machineable Mixed Pref 21.02 171
Machinable Mixed Standard 18.11 191
Non-machinable Mixed Standard 13.57 156
Foreign Originating 35.56 391
Foreign Destinating 30.98 311

Flats
Canceled 4.72 115
Metered Pref. 4.18 99
Mixed Pref. 3.57 101
Originating Standard 4.83 115
Foreign Origin 4.59 115
Newspapers 2.78

.

4-2.9.2 Converting Parcel Volume Into Pieces—Linear and
Pound Rates

To convert parcel volume into pieces, use these rates to count containers:
! pieces per sack = 8.79
! pieces per hamper = 38.7
! pieces per hamper (with extension ) = 65.0

To convert parcels for other containers, use these rates:
! brickloaded (ordinary) = 3 per cubic foot
! brickloaded (outsides) = 0.7 per cubic foot
! loose loaded (ordinary) = 2 per cubic foot

4-2.9.3 Tare Weight

4-2.9.3.1 Trays and Sacks

The standard tare weight of a hard plastic letter tray is 3.5 pounds; the
standard tare weight of a flat tray is 8.8 pounds. The next exhibit shows the
average weights for sacks or pouches that can be used when mail is weighed
in the sack.
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Average Weights for Weighing Mail in Sacks

Sack or
Pouch

Material Color Weight (lbs)

No. 1 Canvas White 3.5
No. 2 Canvas White 2.6
No. 2 Nylon Brown 1.3
No. 2 Cot-Lon White 1.8
No. 3 Canvas White 2.0
No. 3 Nylon Brown 0.8
No. 3 Cot-Lon White 1.2
AM Cot-Lon White 1.2
FCM Nylon Green 0.5

4-2.9.3.2 Rolling Stock

On all rolling stock equipment used to transport mail to distribution operations,
mark the tare weight clearly and conspicuously. Maintenance personnel must
update tare weights on repaired rolling stock equipment after routine
equipment maintenance. The accuracy of the marked weight must be within
these limits:

! equipment up to 50 pounds: plus or minus 1 pound
! equipment from 51 to 100 pounds: plus or minus 2 pounds
! equipment over 100 pounds: plus or minus 3 pounds
! The sum of any ten similar containers, selected at random, must be

within plus or minus 1% of the sum of the marked weights.

You may use standard weights for equipment when the above criteria are
satisfied. Mail processing must review tare weights at least twice a year.

4-2.9.3.3 Maintenance:  Out-of-balance Scales

Mail processing employees must report out-of-balance scales to
maintenance, who will quickly repair or adjust them.

4-2.9.3.4 Mail Containers

Containers in which mail is weighed must always be free of non-mail objects
and debris that add to the volume weight.
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4-2.10 Inventory
Mail processing or customer service personnel must perform inventory at the
end of the reporting period to ensure that undistributed volumes are not
credited to the current period's production. These undistributed balances will
be deducted as an ending inventory and counted in the next period's
beginning inventory.

! Offices receiving daily reports must input daily inventories. Tour
reporting offices must inventory each tour; otherwise, all volumes
entered will be considered worked.

! PSDS offices can enter tour inventories up to one hour after the end
of each MODS tour and enter daily inventories up to one hour after
the end of each MODS day.  In PCMODS, these adjustments can be
made anytime during the day.

PSDS offices inventory mail volume by:
! weighing the mail through the MODS scale
! using locally designed forms
! recording the volume and tabulating all entries for recording

transaction codes 71 through 74, A1, or A2

PCMODS sites can manually enter inventory as pounds, pieces, or linear
measurement.

4-2.10.1 End-of-the-Tour or Daily Cutoff Procedures

4-2.10.1.1 Affixing Inventoried Labels

At the end of the tour or daily cutoff, follow these steps:

1. Collect all the volume information from Labels 139 or scale weight
tickets.

2. Attach a Label 141, Inventoried.

3. Tabulate the appropriate inventories for system inputs.

Disregard scale weight tickets that indicate that the mail has been inventoried
for system input.

4-2.10.1.2 Entering Inventoried Volume

Enter the inventoried volume using the distribution operation and the
appropriate inventory S/T code. Inventories are entered through the MODS
scale or transaction codes 71, 73, A1, or A2.  The inventory transaction
automatically credits the volume to the next tour or day and deducts the same
amount of volume for the current tour or day.

PCMODS sites enter inventoried mail either by pieces, weight, or linear
measurements.

4-2.10.1.3 Crediting Inventories



April 2000                                                                                                                                  58

Mail distributed into cases or automation/mechanization bins that has not
been swept or dispatched will be considered worked in the particular
operation in question. Because MODS automatically credits the SHP volume
based on the local mail flow densities, mail processing or customer service
must inventory these SHP volumes in the subsequent manual operation.

Inventory as FHP mail on ledges, carts, and in any postal equipment that has
been recorded into the operation as FHP. Take linear measurements of
inventory where necessary.
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4-2.11 The Transactor

4-2.11.1 Components
The transactor has three components:

! monitor: the video component that displays the main menu, sub menu
and transactor screens

! system module: the component that contains the processing unit and
the disk drive that stores data

! keyboard: the primary input component

4-2.11.2 Transactor Main Menu
The Transactor Main Menu is the first screen you see on the monitor after
successfully logging on to a transactor. This main menu displays one, several,
or all of the sub-menu selections in the next exhibit. The number of sub-
menus displayed corresponds to the user's access.
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Transactor Main Menu

4-2.11.3 Logon IDs - Authorization
The general supervisor of PSDS operations controls access to MODS sub-
menus and screens through PSDS equipment.

4-2.11.4 Sub-menu
The transactor sub-menu displays several screen selections that allow access
to the screen for data entry. The next exhibit lists all the transactor screens in
the sub-menu, "MODS-Main Office Facility Menu".  This section explains the
transactor screens in:

! MODS-Station/Branch Office Menu
! MODS-Main Collection Site Menu
! MODS-Data Collection Site Menu
! Data Collect Site Menu

This section also explains several screens in the Time and Attendance Menu.

USPS          MAIN MENU

USE UP & DOWN ARROW KEYS, OR TYPE SELECTION

MODS ST/BR MODS – Station / Branch Office Menu
MODS MO MODS – Main Office Facility Menu
MODS DCS MODS – Data Collection Site Menu
PERS Personnel Menu
DCS Data Collect Site Menu
SUPV Supervisor  Menu
T&A Time and Attendance Menu
GENERIC Generic Screen
EXIT Return to Menu

Type Selection
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MODS-Main Office Facility Menu

4-2.11.5 Transactor Screen
When you select from the sub-menu, you see a transactor screen, which
allows you to enter data (MODS, T&A) into PSDS. The first digit or the first
two digits in each screen (preset) selection is the transaction code or TR CD.

Example:  For selection 79 Overtime Estimate, the TR CD is 79, which is
used in MODS reports to uniquely identify each transaction. The entire entry
is a transaction.

For exhibits of transactor screens discussed in this chapter, see Appendix B.

Status Line

Transaction screens on a transactor always display the status message
"ONLINE" in the upper right corner of the screen, above the header.  When a
transaction is transmitted, the message "TRANSMITTING" briefly overlays the
on-line message. Also, if the user enters a transaction in prior or test mode,
this is shown to the left of the on-line message.

Header

The first item in the header is the screen name—the name you enter to
display that screen. The second field in the header is a description of the
screen, which serves as the title.

Input Field

The first input field in any transaction screen is the transaction code (TR CD)
field, which includes a protected value, the transaction code. When you first
see the screen, the cursor appears in the first field that accepts user input.

USPS          MODS-STATION/BRANCH  OFFICE MENU

USE UP & DOWN ARROW KEYS, OR TYPE SELECTION

71 & 72 Units Adjustments
73 & 74 Pieces Adjustments
75 Total Pieces Handling Adjustment (Mechanization

Equipment)
79 Overtime Estimate
94 Inquiry Request
95 Mechanization Recycle Rate
96 Mechanization Machine Mishandling Rate
97 Mechanization Run Time
98 Mechanization downtime
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To complete a transaction, follow these steps:

1. Type the data in the input fields.

When the field is filled, the cursor automatically advances to the next field
until the last input field is completed.

2. To transmit the data, press the Return key.

4-2.11.6 Input Field Description
This section describes the input fields specific to a given screen:

! what special codes mean
! whether the fields are alphanumeric, numeric, or alphabetic
! the validation requirements for each field

4-2.11.7 One-line Menu
Every transaction entry screen has a one-line menu near the bottom of the
screen. By moving the cursor to a transaction code and then pressing the
Return key, you access another screen and continue to input transactions.

4-2.11.8 Message Fields
There are two 79-character fields at the bottom of each screen for messages.

Transactor Screen 71 & 72

MODS UNITS ADJUSTMENTSSCREEN 71&72 ONLINE

SCREEN: 73&74 75 79 94 95 96 97 98 PD MENU

TR                             OPERATION/        SOURCE/    NU MBERS OF
CD        Type            LOCAL UNIT           TYPE               UNITS                 SRF

7        1             123-45             12                 123        12

TYPE :  ENTER 1 FOR PLUS TRANSACTION OR 2
                                                        FOR MINUS TRANSACTIONS
OPERATION :  OPERATION/LOCAL UNIT THE
                                                       ADJUSTMENT LOCAL UNIT GOES TO
NUMBER OF UNITS  :  POUNDS, SACKS, HAMPERS, ETC.
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4-3 Entering Data
To enter MODS data, follow these guidelines:

! A character is a single keystroke.
! A field is a character or series of characters delimited (blocked off) by

spaces at both ends of the display.
! The left or right arrow keys move the cursor from field to field.
! The backspace key is used to re-enter a character.
! The backspace key will not cross field boundaries.
! A tab moves the cursor to the next field.
! Illegal characters can not be entered. Example: In the input field

"TYPE", you can enter only 1 or 2. All other entries are illegal.
! You may edit screens as many times as necessary without

"transmitting"' or "saving" the transaction.
! All fields must be completely filled in.

4-4 Volume Transactions
Generally, MODS automatically records mail volume as the mail is weighed
through the MODS scale system. However, some inputs are made in units of
sacks, hampers, console readers, manual inventories, etc., using a
transactor.

To maintain records of transactor inputs, use Form 1476-E, Worksheet for
Use With Transaction Codes 7X, or locally designed forms. All transactor
inputs can be entered into the system for the current day from one hour after
the MODS day begins up to one hour after the daily cutoff time.

4-4.1 Transaction Screens 71&72
In these two screens, the second character (also a field) can be changed to 1,
2, 3, or 4. Together with the transaction code TR CD, they identify the
transaction and are commonly referred to as the TR CD.

! Transaction code 7—used with transaction types 1, 2, 3, or 4—
increases (adds to) or decreases (subtracts from) volume inputs,
inventories, and adjustments for the current day.

! Transaction codes 71 and 73 increase volume.
! Transaction codes 72 and 74 decrease volume previously entered.
! Transaction codes 71 and 72 adjust in pounds, sacks, units, etc.
! Transaction codes 73 and 74 adjust in pieces to the nearest 100.
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4-4.2 Transaction Code 7-1
This transaction is used to add pounds of mail that will be converted to pieces
by the system. Use transaction code 71 to enter volume in pounds, sacks, or
units. Use these character settings for these transactions:

! Character  1: Transaction code 7  (preset)
! Character  2: Transaction type 1  (1=plus)
! Characters 3-7: Operation Number
! Characters 8-9: Source/type code
! Characters 10-11: Number of pounds/units
! Characters 12-13: SRF code

MODS UNITS ADJUSTMENTSSCREEN
71&72

ONLINE

SCREEN: 73&74 75 79 94 95 96 97 98 PD MENU

TR                             OPERATION/        SOURCE/    NUMBERS OF SRF
CD        Type            LOCAL UNIT           TYPE               UNITS                 SRF

7        1             123-45            12               123        12

TYPE :  1 = plus transaction,
   2 = minus transaction

OPERATION :  Operation/Local Unit the adjustment
LOCAL UNIT       goes to
NUMBER OF UNITS :  Pounds, Sacks, Hampers, etc.
SRF :  Enter valid SRF

NUMBER OF UNITS :  POUNDS, SACKS, HAMPERS, ETC.
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4-4.3 Transaction Code 7-2
This transaction is used to minus pounds of mail that will be converted to
pieces by the system. Use transaction code 72 to delete volume entered with
a 71 transaction or the MODS scale system.  Use these character settings for
these transactions:

! Character 1: Transaction code 7  (preset)
! Character 2: Transaction type 2
! Characters 3-7: Operation Number
! Characters 8-9: Source/type code
! Characters 10-11: Number of pounds/units
! Character 12-13: SRF code

4-4.4 Sample Adjustment
Assume that 255 pounds of letters going to operation 918, DPS 1st Pass, from
operation 020, Originating Meter Mail Preparation, were erroneously entered
in operation 040, Outgoing Secondary/State. These two adjustments are
necessary to correct this:

! transaction code 71 to record into the correct operation 918
! transaction code 72 to reduce the incorrect operation 040 by the

amount of the error

Use these character settings for these transactions:
! 71:  91800 02 255
! 72:  04000 12 255
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Transaction Screen 73&74

MODS PIECES ADJUSTMENTSSCREEN 73&74 ONLINE

SCREEN: 71&72 75 79 94 95 96 97 98 PD MENU

TR                             OPERATION/        SOURCE/    NUMBERS OF SRF
CD        Type            LOCAL UNIT           TYPE              PIECES                 SRF

7        3             123-45            12               123                12

TYPE :  ENTER 3 FOR PLUS TRANSACTION OR 4
                                                        FOR MINUS TRANSACTION

OPERATION :  OPERATION/LOCAL UNIT THE
                                                       ADJUSTMENT
LOCAL UNIT    GOES TO

NUMBER OF PIECES : NUMBER OF PIECES TO NEAREST 100
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4-4.5 Transaction Code 73
To enter volume to the nearest hundred and you know the exact piece counts,
use transaction code 73. You can get them from mailer's statements:

! Form 3541, Statement of Mailing Second-Class Publications Except
Requestor Publications

! Form 3541-A, Statement of Mailing Second Class/Requestor
Publication

! Form 3602, Statement of Mailing Matter with Permit Imprints
! Form 3605, Statement of Mailing-Bulk Zone Rates
! mail volume reports generated by automation or mechanized

equipment

Use these character settings for these transactions:
! Character  1: Transaction code 7   (preset)
! Character  2: Transaction type 3
! Characters 3-7: Operation Number/LU
! Characters 8-9: Source/type code
! Characters 10-12: Number of pieces to the nearest hundred pieces
! Characters 13-14: SRF code

4-4.6 Transaction Code 74
To delete volume entered with a 73 transaction code, use transaction code
74.  Use these character settings for these transactions:

! Character  1: Transaction code 7
! Character  2: Transaction type 4
! Characters 3-7: Operation Number
! Characters 8-9: Source/type code
! Characters 10-12: Number of pieces to the nearest hundred
! Characters 12-13: SRF code
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Transaction Screen 75

4-4.7 Transaction Code 75
Use transaction code 75 to enter the console readings (pieces fed) from
mechanized and automated equipment (MPLSM, SPBS, FSM, OCR, BCS,
the meter readings from letter-canceling devices and parcel sorters, and
ACDCS totals).  Machine-canceled letters (operations 01-015) also is input
with a transaction code 75. Use these character settings for transaction code
7-5:

! Character  1: Transaction code 7
! Character  2: Transaction type 5
! Characters 3-7: Operation Number
! Character 8:              Value (1=plus, 2=minus)
! Characters 9-12: Console reading pieces (rounded to the nearest

100—up to 999,900 pieces)
!  Characters 13-14: SRF code

MODS TOTAL PIECES HANDLING ADJUSTMENTSCREEN 75 ONLINE

SCREEN: 71&72 73&74 79 94 95 96 97 98 PD

TR                             OPERATION/                         NUMBERS OF
CD                             LOCAL UNIT           VALUE       PIECES                 SRF

75                       123-45             1                 123                12

OPERATION :  OPERATION/LOCAL UNIT
VALUE :  1 = PLUS,  2 = MINUS
NUMBER OF PIECES :  NUMBER OF PIECES (TO NEAREST 100)
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Volume Transactions Screen A2

Transaction screen A2 allows users to enter any transaction code 7X (x
equals 1, 2, 3, 4, or 5), including those for an SRF other than the current
location. To accumulate A2 transactions, use Form 1476-E. Any transaction
code A2 will append machine ID number 5001 to the transaction by the
system for all transactors. Here are the character settings for A2 transactions:

! Character  1-2: Transaction code A2 (preset)
! Character  3-4: Transaction type 7x (71, 72, 73, 74, 75)
! Characters 5-9: Operation Number
! Characters 10-11: Source Type ( for transaction code 75 position 6

                                              is the value + or -; position 7 is volume in
                                              pieces)

! Characters 12-14: Mail volume in pounds (71&72) or pieces

MODS UNITS ADJUSTMENTSSCREEN A271&72 ONLINE

SCREEN: A273&74   A275   A279   MENU

TR                             OPERATION/        SOURCE/    NUMBERS OF SRF
CD        Type              LOCAL UNIT           TYPE               UNITS                 SRF

A27    1             123-45           12                123                12

TYPE :  ENTER 1 FOR PLUS TRANSACTIONS OR 2
                                                        FOR MINUS TRANSACTIONS
OPERATION/ :  ENTER VALID OPERATION NUMBER
LOCAL      / LOCAL UNIT
NUMBER OF UNITS :  POUNDS, SACKS, HAMPERS, ETC.
SRF :  ENTER VALID SRF
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! (73&74 or 75)
! Characters 15-16: SRF code

4-5 Volume Inquiries
Volume inquiries give you an online report processed on a 15-minute cycle by
a specified device of operation from the start of the MODS day to the time of
the request. The maximum number of requests allowed for a post office
during the 15-minute period is 20. Editing these reports will aid in providing
more accurate current day reports as well as reducing the number of after-
the-fact adjustments.

4-5.1 Transactor Screen 94
For a list of volume by a particular device or operation from the start of the
MODS day to the time of the request, use Transactor Screen 94, Inquiry
Request. You need to enter the current day of the pay period. Use these
character settings for these transactions:

! Characters 1-2: Transaction code 94 (preset)
! Characters 3-6: Device Number
! Characters 7-12: Device number of operation
! Characters 13-16: Time of request (hours and hundredths)
! Characters 17-18: DPP. Enter the current day period.

4-6 Automation/Mechanization Reporting Transactions
Transactor screens 95 through 98 are allocated to the mechanized and
automated mail processing equipment operations—Mechanization
Performance Evaluation.

! To enter a 95 through 98 transaction code, use DPP 01 through 14.
! To enter transactions for MODS days 15 through 28, use DPP.
! Use the DPP that corresponds to the MODS day on which transaction

codes 97 and 98 are to be applied.

Example: To enter transactions for MODS day 15, use DPP 01; for MODS
day 16, use DPP 02; etc.

4-6.1 Machine Identification Number
Each of the transactor screens 95 through 98 represents activity in a
particular operation (scheme) and machine identification number combination
for a given day.  The machine identification number is a locally assigned
2-digit number used to track machine performance.
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4.6.1.1 Unique Identification Numbers
Assign unique identification numbers for each type of equipment.  Unique
identification numbers are required within each of these groups:

! Letter sorting machines: MLOCR, MPBCS, DBCS, CSBCS
! Flat sorting machines: FSM881, FSM1000, AFSM100
! Cancellation machines: Micro Mark, M-36, Flyer, Half Mark, AFCS
! Parcel sorters, SPBS, LIPS
! ACDCS equipment

4.6.1.2 Numbering Scheme
Each of these groups can use identification numbers 01-99, but must be
uniquely identified.

Example: There may be an MLOCR number 03, an FSM881 number 03, and
an M-36 number 03. However, there may not be an MLOCR number 03 and
an MPBCS number 03; and there may not be an FSM881 number 04 and an
FSM1000 number 04.

4.6.2 Automation/Mechanization Reporting Requirements
If they are not automatically entered through the EOR application, you must
enter at least one runtime transaction code 97 and one downtime transaction
code 98 for the 3- or 5-digit operation for each machine used on any day in
which total piece handling (TPH) is reported. For each 3- or 5-digit operation
(scheme) and machine used, you must enter:

! a scheme recycle rate, transaction code 95
! a machine mishandling rate, transaction code 96

The system will accept a zero runtime and a zero downtime for a scheme;
however, the mechanization reports will be incomplete because these entries
are used for several calculations.
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4-7 Machine Mishandling Rate and Scheme Recycle Rate
- Local Option Only

These rates are developed by quality control when performing distribution
quality (DQ) tests and must be input for every automated and mechanized
operation being worked. This information is reported in the National Quality
Control Information System (NQCIS) Report 31.

Sample NQCIS Report 31

Management Operating Data Systems
Quality Control Inputs

Yourtown MSC
  AP01 FY 92

Recycle Mishandling
         Density    Rate

Test Operation     (%)     (%)

BH BCS XXX .2 13.2
XXX .0 11.2
XXX .1 12.1

MPFSM XXX .2 2.1
XXX .0 2.7
XXX .0 3.6

MPLSM XXX 7.9 11.7
XXX 6.7 8.9
XXX 3.9 6.5

OCR XXX 6.7 25.3
XXX 10.4 24.0

Total Office 6.7 14.1

DATE: 06/09/94 TIME: 10.01.51
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4-7.1 Definitions
The machine mishandlng rate is the percentage of mail mishandled by
automated or mechanized equipment; it is derived from DQ tests.

The scheme recycle rate is the percentage of mail recycled back from
automated or mechanized equipment; it is derived from DQ tests.

4-7.2 DQ Tests
To develop the machine mishandling rate, use the automated and
mechanized distribution quality sort tests.  A mishandling rate should be input
for each mechanized or automated operation.

4-7.3 Recycle and Mishandling Rate Inputs
These inputs are replacement entries. To correct an erroneous recycle or
mishandling rate transaction, wait at least one minute and enter the correct
transaction.  The last transaction entered during the day will replace a prior
recycle or mishandling rate transaction for that day.

Transaction codes 95 and 96 need only be made when there is a change in
recycle or mishandling rates. The rates entered will remain in the system until
another 95 or 96 transaction is entered. Transaction codes 95 and 96 will not
accept a recycle or mishandle rate of zero.

4-7.4 Transaction Screen 95
To enter scheme recycle rates, use transaction screen 95, Mechanization
Recycle Rate.  Use the following character settings for transaction code 95:

! Characters 1-2: Transaction code 95 (preset)
! Characters 3-7: Operation number
! Characters 8-9: Machine ID (locally assigned 2-digit number)
! Characters 10-12: Recycle rate (013 = 1.3%, for example)

! Characters 13-14: APDY—corresponds to MODS day
! Characters 15-16: SRF

4-7.5 Transaction Screen 96
To enter machine mishandling rates, use transaction code 96. These are the
character settings for transaction code 96:

! Characters 1-2: Transaction code 96 (preset)
! Characters 3-7: Operation number
! Characters 8-9: Machine ID (locally assigned 2-digit number)
! Characters 10-12: Recycle rate (013 = 1.3%, for example)

! Characters 13-14: APDY—corresponds to MODS day
! Characters 15-16: SRF
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4-8 Machine Runtime and Downtime

4-8.1 Defining Runtime and Downtime
Runtime is those hours in which a machine is processing volume.  Runtime
does not include downtime.

Downtime is those hours during a processing run in which a machine is not
processing volume because of a mechanical breakdown.  Downtime hours
include all non-processing time caused by:

! jams
! pauses in the processing run for cleaning an ink jet or read head
! any unscheduled maintenance that prevents the equipment from

being used for processing and terminates the processing run

Downtime does not include:
! planned corrective maintenance
! idle time resulting from lack of mail or operators
! sweeptime between processing runs
! sort program change time
! lunch and other breaks without relief
! warm-up time

4-8.2 Runtime and Downtime Fields

4-8.2.1 Value Field
The transaction codes 97 and 98 value field accepts only a 1 for plus, 2 for
minus.  Any other character in this field will generate an online error signal
message.  The error signal message is "INVALID VALUE."

4.8.2.2 Machine Run/Downtime Field
The machine run/downtime field is a 2-digit field consisting of hours taken to
one decimal.  To enter more than 9.9 hours, two transactions are necessary.
For example, runtime for operation 881, machine ID number 04, is 11.5 hours
on MODS day 06. You can enter this runtime using the following transactions
with a day 06 badge:

! 97 88100 04 1 99 10 00
! 97 88100 04 1 16 10 00

4-8.3 Prior Entries
Transactions 97 and 98 can be entered for the current day or any prior day of
the current week—but not for future days. These transactions are reflected on
the weekly and accounting period mechanization reports. Transactions for the
current week must be entered before the weekly MODS cutoff time (Sunday,
0600, 0700, or 0800) as established by the local office.
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Example:  Downtime for operation 881, machine ID number 02, was entered
incorrectly as 2.3 hours on MODS day 24 (actual downtime was 0.3 hours).
To correct this transaction, enter the following: 98 88100 02 2 20 2400.

4-8.4 Transaction Screen 97

To enter machine runtime, use Screen 97, Mechanization Machine
Mishandling Rate. These are the character settings for transaction code 97:

! Characters 1-2: Transaction code 97 (preset)
! Characters 3-7: Operation number
! Characters 8-9: Machine ID (locally assigned 2-digit number)
! Character 10: Value (1=plus, 2=minus)
! Character 11-12: Machine runtime (48=4.8 hours, for example)
! Characters 13-14: APDY
! Characters 15-16: SRF

TR        OPERATION/          MACHINE                      MACHINE RUN       AP
CD       LOCAL UNIT                 ID           VALUE             TIME             DAY          SRF

97      123-45                 12             1             12           12            12

MODS AUTOMATION/MECHANIZATION RUN TIME
SCREEN 97 ONLINE

SCREEN: 71&72, 73&74 75 79 94 95 96 98 PD MENU

OPERATION :  ENTER VALID OPERATION  NUMBER/
LOCAL UNIT    LOCAL UNIT
MACHINE ID     MACHINE ASSIGNED ID NUMBER
VALUE  :  1 = PLUS,  2 = MINUS
MACHINE RUN TIME :  (E.G.  23 = 2.3 HOURS)
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4-8.5 Transaction Screen 98

To enter machine downtime, use transaction 9-8, Mechanization Downtime,
These are the character settings for transaction code 98:

! Characters 1-2: Transaction code 97 (preset)
! Characters 3-7: Operation number
! Characters 8-9: Machine ID (locally assigned 2-digit number)
! Character 10: Value (1=plus, 2=minus)
! Characters 11-12: Machine runtime (48=4.8 hours, for example)
! Characters 13-14: APDY
! Characters 15-16: SRF

TR       OPERATION       MACHINE                      MACHINE RUN       AP
CD       LOCAL UNIT        ID                VALUE         TIME                     DAY
SRF

98      123-45             12                 1               12                    12          12

MODS AUTOMATION/MECHANIZATION
SCREEN 98

ONLINE

SCREEN: 71&72, 73&74 75 79 94 95 96  PD MENU

OPERATION :  ENTER VALID OPERATION  NUMBER
 LOCAL UNIT     LOCAL UNIT
MACHINE ID     MACHINE ASSIGNED ID NUMBER
VALUE  :  1 = PLUS,  2 = MINUS
MACHINE RUN TIME :  (E.G.  23 = 2.3 HOURS)
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4-8-6 Transactor Screen A1

To make normal mail volume inputs for a current day and adjustments for
prior period, use Transactor Screen A1, Mail Volume Adjustments. A prior
period is a prior day in the current account period.

These are the character settings for transaction code A1:
! Characters 1-2: Transaction code A1
! Characters 3-8: Operation Number
! Characters 9-10: Source/Type
! Characters 11-16: Whole volume units or pieces to nearest 100
! Character 17: Volume code (1 = LBS, 2 = PCS)
! Character 18:  Value (plus = +, minus = -)
! Characters 19-20: SRF code
! Character 21:  Frequency (1 = current day, 2 = prior day)
! Characters 22-23: Accounting Period (01-13)
! Characters 24-25: MODS day (01-28)

MODS MAIL VOLUME ADJUSTMENTSSCREEN A1 ONLINE

SCREEN:   A271&72  A273&74  A275  A279  A3  A4  A5  A7  A8&B A8C  A9 MENU

                                                                                                                                                DAY
TR    OPERATION/      ST/                              VOL.    VALUE                                           OF
CD    LOCAL UNIT     CODE    VOLUME    CODE       + -          SRF       FREQ   /P    A/P

1-1.1.2 A1       123-45         12       123456      1        +            12           1

VOLUME :  WHOLE VOLUME UNITS OR PIECES TO NEAREST 100   VOL.
CODE      :  1 = LBS.,  2 = PCS.
FREQ :  1 = CURR. DAY,  2 = PRIOR DAY
A/P  :  00 = YEAR TO DATE,  01 – 13 FOR DAILY
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4-8.7 MODS Operations Validity Updates: Transactor Screen
O1
To establish a 5-digit operation as either valid or invalid for an SRF in an
office, use transaction code O1 (ALPHA O). Changes entered before the
current MODS day cutoff will become effective after the MODS split for that
day (approximately 9:15 a.m. local time).  Zero-fill unused operation and
action code fields. Headquarters or Area/District operation numbers can only
be valid or invalid by Headquarters. When transaction code O1 is used, a
daily MODS validity table report will be transmitted. These are the character
settings for Transactor Screen 01:

! Characters 1-2: Transaction code O1
! Characters 3-4: SRF code (00-39)
! Character 5: Action Code

D = delete following operation (invalid)

I = insert following operation (valid)
! Characters 6-10: Operation Number
! Characters 11-47: Same as 5 & 6-10

4-8.8 MODS Scale Volume Adjustment: Transactor Screen
J2
To enter volume adjustments in the same format as the scale workstation
transaction, use the MODS Scale Volume Adjustment. Use this transaction
only to enter volume not entered into PSDS because of a hardware problem
at the MODS scale workstation. These transactions will appear on the Volume
Adjustment Report.

These are character settings for a transaction code J2:
! Characters  1-2: Transaction Code J2 (preset)
! Characters  3-6: Scale ID number (ie 3001)
! Characters  7-11: From operation number
! Characters  12-16: To operation number
! Characters  17-18: Transaction Type (01-09)
! Characters  19-20: Mail Type (01-66)
! Characters  21-24: Net Weight of mail volume
! Characters  25-30: Month, Day and Year of the transaction
! Characters  31-34: Time of the transaction



April 2000                                                                                                                                  79

4-9 Number of Machines in Automation and
Mechanization: Transactor Screen J1

Each local site must update its list of mechanical pieces of equipment in the
facility. To add or delete the pieces of equipment used by the facility by
operations, use transaction code J1. This transaction will generate a daily
Number of Machines report and update the operation "number of machine
field" of the Automation/Mechanization Report on Day 01 of the AP after the
transaction is entered. Also, an updated report that details the number of
machines and the operation will be generated on day 1 of each AP.

These are the character settings for transaction code J1:
! Characters  1-2: Transaction Code J1  (preset)
! Characters  3-7: Operation number
! Characters  8-10: Number of Machines
! Continue until complete

MODS NUMBER OF MACHINES BY OPERATION/LU

SCREEN J1
ONLINE

SCREEN:  MENU

TRANS
CODE SRF

OPERATION/
LOCAL UNIT

NUMBER OF
MACHINES

OPERATION/
LOCAL UNIT

NUMBER OF
MACHINES

J1 12 123-45 123 123-45 123

123-45 123 123-45 123

123-45 123 123-45 123

OPERATION/LOCAL UNIT :  ENTER COMPOSITE OPERATION/LOCAL
                                                        UNIT (EG; MPLSM = 080, MLOCR = 830)

NUMBER OF MACHINES :  ENTER LEADING ZEROS
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4-10 Planned Volume and Hours
The planned hours transactions codes are A3 and A5. Use them to enter plan
volume and work hours figures on the management summary and operating
reports to compare with actual volume and hours reported—by day, week, or
accounting period. Planned hours are optional.

4-10.1  MODS Planned FHP Volume: Transactor Screen A3
An office can plan FHP volumes for letters, flats, and parcels. Transaction
code A3 allows an office to enter planned FHP volumes by separate reporting
facility--daily, weekly, or by accounting period--for mail processing and
customer service.

! If the planned volumes are entered daily, the weekly and accounting
period plan will be the sum of the appropriate daily plans.

! If the planned volumes are entered weekly, the accounting period
plan total will be the sum of the four weekly plans.

The plan, if used, must be input for one accounting period at a time.  Inputs
can be made for the next accounting period up to the MODS day 28 cutoff of
the current accounting period.

These are the character settings for transaction code A3:
! Characters 1-2: Transaction code A3
! Characters 3-4: SRF code
! Character 5: Report Code

1 = Establish or replace current plan for next AP

2 = ADJ current plan for current or prior AP
! Characters 6-7: MP = mail processing, CS = customer service
! Character 8: Value (plus = +, minus = -)
! Characters 9-10: Day of the AP
! Character 11:  Week of the AP
! Characters 12-13:  Accounting Period
! Characters 14-16:  Mail Type

(LTR = Letters, FLT = Flats, PAR = Parcels)
! Characters 17-20: Volume in pieces to the nearest 1000
! Characters 21-41: same as 14-16, 17-20

4-10.2   Planned Hours by Operation: Transactor Screen A5
An office can plan hours by function to a 5-digit operation level. Transaction
code A5 allows an office to enter planned hours by separate reporting
facility—by day, week, or by accounting period.
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! If the plan is entered daily, the weekly and accounting period plan will
be the sum of the appropriate daily plans.

! If the plan is entered weekly, the accounting period plan total will be
the sum of the four weekly plans. Inputs can be made for the next
accounting period up to the MODS day 28 cutoff of the current
accounting period.

When a plan is established by accounting period, it may be changed (will
replace) to weekly or daily plan. When a daily plan is established, the site
cannot change the plan to a weekly or accounting period. The office will
receive a daily report of all plan hours entered in the MODS day and master
accounting period report on MODS day 02. These reports are discussed in
chapter 5.

! If there is a data entry error for the next accounting period plan, use
response code 1 to correct.

! If there is an error or update for the current accounting period plan,
use response code 2.

Use these settings for transaction code A5:
! Characters 1-2: Transaction code A5 (preset)
! Characters 3-4: SRF code
! Character 5: Action Code
1 = Establish or replace current plan for next AP
2 = Correct current plan for current or prior AP
! Character 6: Value + = increase or positive input (if RP CD

                                              =1, value must = +)

- = decrease or negative input
! Characters 7-8: Day of AP (for day, enter 01, 02…028; for

                                              week, AP, prior period correction, enter 00)
! Character 9:  Week of AP (for week, enter 1,2,3, or 4; for prior

                                               period  correction, enter 0)
! Characters 10-11: AP 01, 02…013; or 00 for prior APs
! Characters 12-16: Operation Number/LU
! Characters 17-21: Amount of hours
! Characters 22-99: same as 12-16, 17-21

4-11 Optional Reports
The office can request or delete optional MODS reports through transaction
codes J3, J4, J8, J9 JA, A7, or A9. For a more detailed look at these reports,
see Chapter 5.
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4-11.1 Tour Workhour Report: Transaction Screen J3
To control the frequency (by day, week, or AP) of the tour workhour and
volume adjustment reports, use transaction code J3.

To receive a report, enter the frequency code.
! To generate the requested report according to the regular reporting

cycle indefinitely, enter the day of the AP and AP. To receive a report
for 1 day only, ensure that the END REQUEST field shows 1 day later
than the BEGIN REQUEST field.

! To cancel a report, leave the BEGIN REQUEST field blank and fill in
the END REQUEST field. Weekly and AP tour work hour reports are
produced only for Mail Processing.

Use these character settings for a transaction code J3:
! Characters 1-2: Transaction Code J3 (preset)
! Character 3: Frequency

                                              D = daily, W = weekly, A = AP, X = all
! Characters 4-7: begin date of request
! Character 8-11: end date of request

4-11.2 VARS Chronological: Transactor Screen J4
To request a detailed chronological volume listing by MODS day, use
transaction code J4. The difference between this volume report and the detail
listing is the way volume transactions are listed on the report. VARS sorts and
lists volume transactions chronologically—by the time of day they were
entered during the MODS day.

! To generate the requested report indefinitely according to the regular
reporting cycle, enter the day of the AP and the AP. To receive a
report for one day only, ensure that the END REQUEST field is dated
one day later than the BEGIN REQUEST field.

MODS OPTIONAL REPORT REQUEST
VARS CHRONOLOGICAL LISTING

SCREEN J4 ONLINE

SCREEN:  MENU

REQUEST :  BEGIN OR END, BOTH BEGIN AND END, AT LEAST ONE
   (IF NOT END REQUEST ENTERED, REPORT WILL RUN
   INDEFINITELY)

TRANSACTION BEGIN REQUEST END REQUEST
CODE DAY OF AP / AP DAY OF AP / AP

J4   12  /  12   12  /  12



April 2000                                                                                                                                  83

! To cancel a report, leave the BEGIN REQUEST field blank and fill in
the END REQUEST field.

Use these character settings for a transaction code J4:
! Characters 1-2: Transaction Code J4 (preset)
! Characters 3-6: Begin request (day of AP and AP)
! Characters 7-10: End request (day of AP and AP)

4-11.3 Operation Validity Table: Transactor Screen J9
To request a copy of an operation validity table, use transaction code J9. The
operation validity table report lists all valid and invalid operations for the
facility by SRF. The report will be transmitted with the daily MODS reports for
the MODS day in which the transaction was generated.

These are the character settings for transaction code J9:
! Characters 1-2: Transaction code J9 (preset)
! Characters 3-4: SRF code

4-11.4   SRF Hours Summary Report: Transactor Screen JA
The Separate Reporting Facility Hours Summary Report is a management
summary report by SRF that lists functional work hours, plan hours, overtime,
and SPLY figures. This report can be generated only for sites that have
established SRFs.

! To request this report by SRF, use transaction code JA.
! To receive a report for a specific office, enter the SRF code or "xx" to

receive a report on all SRFs.

MODS OPTIONAL REPORT REQUEST
OPERATION VALIDITY TABLE

SCREEN J9
ONLINE

SCREEN:  MENU

SRF :  ENTER A SPECIFIC REPORTING FACILITY OR XX FOR ALL
                 FACILITIES
NOTE :  THIS TRANSACTION WILL PRODUCE AN OPERTION VALIDITY
                 REPORT

TRANSACTION SEPARATE REPORTING
CODE      FACILITY CODE

J9  XX
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! To generate the requested report indefinitely according to the regular
reporting cycle, enter the day of the AP and the AP. To receive a
report for 1 day only, be sure the END REQUEST field is dated 1 day
later than the BEGIN REQUEST field.

! To cancel a report, leave the BEGIN REQUEST field blank and fill in
the END REQUEST field.

Use these character settings for a transaction code JA:
! Characters 1-2: Transaction Code JA (preset)
! Characters 3-4: SRF code
! Characters 5-8: Begin request (day of AP and AP)
! Characters 9-12: End request (day of AP and AP)

4-11.5 Detail Listing: Transactor Screen A7
To request the volume detail listing by operation, use transaction code A7.
The list is a daily MODS report with transactions for a 24-hour period,
beginning at the start of the MODS day.  If the office requests the report to run
indefinitely, another A7 transaction is required to terminate the report.

Use these character settings for transaction code A7:
! Characters 1-2: Transaction Code A7 (preset)
! Characters 3-4: SRF code
! Characters 5-9: Beginning operation number
! Characters 10-14: Ending operation number
! Characters 15-18: Begin request (day of AP and AP)
! Characters 19-22: End request (day of AP and AP)

4-11.6 MODS Optional Reports Request: Transaction
Code A9

To request or terminate optional mail processing tour operating reports,
weekly activity reports, or separate Saturday and Sunday management
summary and operating reports, use transaction code A9.

The report will be generated continuously unless you enter an end-of-request
date into the transaction. An office can discontinue a report later by entering
another transaction code A9 with an end-of-request date. If the mail
processing report is discontinued in the middle of an A/P it will discontinue at
the end of the AP.

These are the character settings for transaction code A9:
! Characters 1-2: Transaction Code A9 (preset)
! Character 3: Report type:

     T = Mail Processing Activity Report
A = Weekly Mail Processing Activity Report
S = Separate Saturday and Sunday
Management Summary

! Characters 4-7: Begin request (day of AP and AP)
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! Characters 8-11: End request (day of AP and AP)
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4-12 Mail Flow Densities
To determine the flow of mail volume from a distribution operation, you must
identify the frequency of separation.  The SHP for manual, letter, and flat
operations is expressed as percentages of the total volume of an operation;
we refer to them as "Densities.”

4-12.1 Requirements
Distribution operations mail flow densities are required to project subsequent
handling (SHP) from the initial FHP count. These densities are locally
determined and must be based on sound statistical sampling or actual mail
counts.  Also, Handbook PO-401, Manual Distribution Operating Guidelines,
contains a general procedure for determining manual case densities. MODS
requires the combined percentage of mail flowing to each downstream
operation; it does not require a detailed density by individual separation or
bin. MODS does not provide piece handling credit for reworks; therefore, only
positive mail flows are valid.

4-12.2 Updates
The installation head or designee approves changes and updates to mail flow
densities every 6 months or whenever the mail flow pattern changes.  For
PSDS sites, the maximum update frequency is once per AP.  PCMODS can
be updated more frequently as needed.

4-12.3 Worksheets
Use these forms as worksheets for transaction code A8:

! 5800-A, Mail Flow Density Projections
! 5800-B, Operation 4300 Mail Flow Proportion
! 5800-C, Carrier Mail by Station and Total Station Box Mail

4-12.4 Mail Flow Density Projections
MODS uses mail flow matrixes to apply volume to subsequent distribution
operations using mail flow matrixes. First, MODS determines the total amount
of volume to be flowed from an operation by adding all S/T codes that
correspond to the mail flow code. A percentage of this total volume will be
added to each of the subsequent operations that will process the mail.
Densities will only flow mail between operations to the operation level.  In
PSDS offices, the total of the percentages must equal 100%. The computer
assumes that .9999 =100%.

For these projections, use the following:
! Form 5800-A Mail Flow Density Projections
! Form 5800-B, Operation 4300 Mail Flow Proportion
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Use these character settings for transaction code A8A&B and forms 5800-
A/5800-B:

! Characters 1-2: Transaction code A8 (preset)
! Character 3: Action Code A

5800A 1 = delete, 2 =delete, 3 = replace
5800B 4 = delete, 5 = add, 6 = replace

! Characters 4-5: 2-digit "From" SRF
! Characters 6-7: 2-digit "To" SRF
! Characters 8-12: From operation
! Character 13: Note B - Type Flow:

1 = FHP, 2 = SHP, 3 = TPH, 4 = FHP & SHP,
9 = combination of 1, 2, & 4 (must be used with
9 in note C)

! Character 14: Note C - Mail Category:
1 = stamped, 2 = metered, 3 = mixed,
4 = Standard Mail, 9 = combination of 1, 2, and
4 (must be used with 9 in note B)

! Characters 15-19: "To" operation
! Characters 20-25: Percentage of Mail going to operation in position

15-19

Note:  A Replace transaction is not valid when a mail flow combination has
more than one SRF.  Enter Delete action, then an Add action for the entire
mail flow combination.  One Delete transaction will delete an entire mail flow
combination regardless of the number of SRFs mail is flowed to.

4-12.5 Mail Flow Codes
Mail flow codes show the type of flow and mail category. Here is a cross-
reference of mail flow codes and the corresponding S/T codes.

Mail Flow Code Source Type Code
11 (FHP-STAMPED) 01, 11, 47, 51
12 (FHP-METERED) 02, 12, 03, 13, 52, 53
13 (FHP-MIXED) 06, 16, 54, 61, 55, 41, 42
14 (FHP-STANDARD) 04, 05, 07, 14, 15, 17, 65, 66
23 (SHP-MIXED) 10, 29
24 (SHP-STANDARD) 09
33 (THP-MIXED) MACHINE CONSOLE READINGS
43 (FHP & SHP-MIXED) 06, 16, 10, 29, 54, 55, 61, 64,
44 (FHP STANDARD) 65,66
99 FHP SHP STAMPED,
     METERED &
     STANDARD

ANY VALID COMBINATION OF MAIL FLOW CODES
FOR A GIVEN OPERATION NUMBER
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4-12.6 Combining Densities
To combine valid mail flow densities, use mail flow code 99. Mail flow code 99
will provide only flows of valid types.

Example: Four densities are required for operation 030, which may be
combined and entered using code 99. If you want specific densities for
stamped mail (flow code 11) and metered mail (flow code 12), you may use
code 99 to combine the other densities (flow codes 13 and 14).

4-12.7 Mail Flow Matrix
Given a mail flow matrix of 150 23 160 1201 161 0024 168 0101 240 0008
777 0023 888 8943 9999, MODS first determines the total amount of mixed,
total piece handling (mail flow code 23) volume for operation 150. MODS
does this by adding all S/T codes that correspond to the mail flow code.  S/T
codes 10 and 29 correspond to mail flow code 23.

4-12.8 Projecting Total Volume
MODS automatically adds a percentage of the total volume to subsequent
operations. The total of the percentages must equal 100%. The total volume
will be projected as follows:

! 12.01% of operation 150 mixed SHP volume are added to operation
160

! 1.24% of operation 150 mixed SHP volume are added to operation
161

! 0.08% of operation 150 mixed SHP volume are added to operation
240

! 0.23% of operation 150 mixed SHP volume are added to operation
777

! 86.43% of operation 150 mixed SHP volume are added to operation
888

4-12.9 Required Densities
The densities presented in Appendix D are required for all operations used by
an office. MODS will reject any operation, code, or downstream operation not
listed in Appendix D.

4-12.10 Station/Branch Distribution Projections
Station and Branch Distribution Projections represent decentralized
distribution—from a Distribution operation to a Station/Branch Distribution
operation.

! To flow incoming distribution mail to a specific station/branch number
(00-99), use the operation Mail Flow Proportion matrix (5800B Form).
MODS use Form 5800-A to determine the total amount of volume
from the distribution operation that flows to operation 240.
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! To flow operation 240 volume to individual stations or branches,
MODS uses the 5800-B matrix. The total percentages must equal
100%.

4-12.11 Form 5800-B, Operation Mail Flow Proportion
Offices with decentralized incoming distribution that want SHP volume by
station/branch must obtain densities from an operation that generates mail for
operation 240. Offices that choose to provide densities by station/branch must
use Form 5800-B, Operation Mail Flow Proportion; Mail Flow Density
Projections; and Operation Mail Flow Proportion Transactor Screen A8A&B.

Use the transactor screen A8A&B to enter Form 5800-B into the MODS.

Notes:
! The operation and flow code combination must be a combination that

appears on Form 5800-A flowing to operation 240.
! One delete action will delete the entire operation mail flow for the

operation/flow code combination indicated in character 4 through 13,
regardless of the number of TO operations.

! To remove a single operation from an operation mail flow
combination, use Action Code 6, replace, and enter "00.00" in the
percentage field for the operation to be deleted.

! Use add action only to establish the entire operation proportion for a
mail flow combination. To add to, remove from, or change an
operation mail flow combination, use Action code 6-replace.

4-12.12 Carrier Volume by Station
To flow incoming letter and flat mail to a specific branch number (00 through
99) and to the station box mail operation, use this Carrier Mail by Station and
Total Station Box Mail matrix. MODS determines the total amount of volume
that has been flowed to operations 777 and 778 from all distribution
operations, from the 5800-A mail flow matrix of all operations.

MODS uses the 5800-C matrix to flow operation 777 and 778 volume to
operation 713 (carrier volume) by individual branch numbers and to the
station box mail (operation 760).  The total of the percentages must equal
100%.

4-12.12.1 Form 5800-C, Carrier Mail By Station and Total
Station Box Mail

Enter the percentage of all incoming letters (operation 777) and flats
(operation 778) for carrier delivery by station and total station box mail from
Form 5800-C through transactor screen A8C.  To obtain the required
proportion of mail by station, weigh all letters and flats, including station box
mail, by station for at least one week.

These are the character settings for transaction code 8A, screen A8C, and
Form 5800-C:
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! Characters 1-2: Transaction code A8 (preset)
! Character 3: Action Code A

7 = delete, 8 = add,  9 = replace
! Characters 4-6: Note B - Mail Category

    777 = letters to be delivered by carriers & station
 boxes (excluding carrier bypass)
778 = flats (same as letters)

! Character 7: Carrier Box - Type Handling
C = Carrier Box, B = Station Box mail

MODS CARRIER MAIL BY STATION
   AND TOTAL STATION BOX MAIL

SCREEN AB C ONLINE

SCREEN:   A1   A3  A4  A5  A6  A7  A8A&B   A9  MENU

ACTION CODE : 7 = DELETE,  8 = ADD,  9 = REPLACE

LTR / FLT : 777 =  LETTERS FLOWED (FROM INCOMING SECONDARY)
              MAIL PROCESSING DISTRIBUTION.  FINALIZED TO ROUTE/BOX
778 =   FLATS FLOWED (FROM INCOMING SECONDARY)
               MAIL PROCESSING DISTRIBUTION.  FINALIZED TO ROUTE/BOX

CARRIER / BOX : C = CARRIER ROUTE MAIL,  B = STATION BOX MAIL

TR   ACTION    LTR/   CARRIER/      STA   % OF STA    % OF    STA   % OF     STA      % OF
CD   CODE       FLT   BOX      ZIP   MAIL ZIP    MAIL    ZIP    MAIL      ZIP        MAIL

A8 7     777    B     12 1234 12   1234    1     1234    12      1234

 STA   % OF STA    % OF    STA   % OF     STA      % OF    STA   % OF    STA   % OF       STA    % OF
 ZIP   MAIL ZIP    MAIL    ZIP    MAIL      ZIP        MAIL     ZIP     MAIL   ZIP    MAIL       ZIP       MAIL      ZIP

12 1234 12   1234    1     1234    12      1234   12     1234  12   1234      1     1234
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! Characters 8-9: Station/Branch Code (2 digits)
Delete = enter BX and hyphen-fill 12-81
Add/replace = 00-99 or BX (station box mail)

! Characters 10-13: Percentage of mail in Characters 8-9, for
add/replace

! Characters 14-83: same as 11-12 and 13-16

Notes:
! An Add action can be used only to establish an entire 0077 or 0078

matrix.
! A Replace action can be used to add or change station/branches in

an existing 0077/0078 matrix.
! To delete a station/branch, an office must delete the entire

0077/0078 matrix and input an ADD transaction for the new
0077/0078 matrix.

4-12.12.2 Mail Flow Matrix
The mail flow matrix flows incoming letter and flat mail to a specific branch
number (00 through 99) and to the station box mail operation. Given a mail
flow matrix of 777 C 01 1125 02 0700 03 1080 16 1040 22 1260 37 1120 47
1900 777 B BX 1775, MODS uses Form 5800-A to determine the total
amount of volume flowed to operations 777 and 778 from all distribution
operations.

4-12.13 Total Volume Projections
To flow operation 777 and 778 volume to operation 713 (carrier volume) by
individual branch numbers and to the station box mail operation 769, MODS
uses the 5800-C matrix. The total of the percentages must be 100%. The
volume will be projected as follows:

! 11.25% of the volume flowed to operation 777 will be credited to
operation 713, branch number 01

! 7.00% of the volume flowed to operation 777 will be credited to
operation 713, branch number 02

! 10.80% of the volume flowed to operation 777 will be credited to
operation 713, branch number 03

! 10.40% of the volume flowed to operation 777 will be credited to
operation 713, branch number 16

! 12.60% of the volume flowed to operation 777 will be credited to
operation 713, branch number 22

! 11.20% of the volume flowed to operation 777 will be credited to
operation 713, branch number 37

! 19.00% of the volume flowed to operation 777 will be credited to
operation 713, branch number 47

! 17.75% of the volume flowed to operation 777 will be credited to
operation 769, branch number 00
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4-12.14 Density Procedure
This procedure can help you develop density data for establishing case
diagrams:

1. Obtain representative samples of the mail entering the operation.

2. Distribute each sample into an empty case and count the pieces
sorted to each separation.

3. Summarize the sampling results and calculate density percentages
for each separation on the case.

4. Use one of these methods to perform the actual calculations of the
density percentages:

! manually, according to the instructions in chapter 6, Handbook PO-
401Manual Distribution Operating Guidelines

! using the Density Analysis System (DAS), a computerized system
that generates or refines density

4-12.15 Maintaining Accuracy
These sampling, distribution, counting, and calculation tasks should be
closely supervised to ensure that:

! the samples are truly representative
! accuracy is maintained throughout the procedure

4-12.16 Determining Mail Flow Density Projections
The industrial engineering coordinator (or equivalent) determines the mail flow
density projections and manages the following:

! the proper use of instructional materials
! the training and monitoring of data collectors
! the quality of the projections established
! the documentation of the task results

4-12.16.1 Scheduling the Sampling
The sampling should take place on Tuesdays, Wednesdays, and Thursdays
of weeks that are not subject to unusual mailings (for instance, holidays,
month-ends, and elections). Take one per day that represents the mail
processed during the normal working period for the operation studied.

Example:  If an operation 030 runs from 1500 hours until 2100 hours, take the
sample from the containers of unworked mail in operation 030 during that
entire time period.
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4-12.16.2 Summarizing the Daily Samples
To record the number of pieces sorted to each bin, use Form 4217, Density
Test Calculation Worksheet.  At the end of the sampling period, summarize
the daily samples and post the required information on Form 5800-A.
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4-13 Alphanumeric PC
The PSDS application software for the alphanumeric device provides two
menus:

! the Batch Menu
! the Badge Menu

4-13.1 Batch Menu
The alphanumeric device can access the Batch Menu to enter transactions in
the On-Line or Batch mode:

! BAPPEND Append transactions to current batch
! BCOPY Make a copy of a batch of transactions
! BCREATE Create a new batch of transactions
! BDELETE Delete a transaction from the current batch
! BERASE Erase an entire batch
! BRENAME Rename a batch of transactions
! BSELECT Select a batch for batch mode entry
! BVIEW View the transactions in a batch
! BXMIT Transmit a batch of transactions to the host
! ONLINE Enter on-line transmission mode
! QUIT Terminate

To make a selection, follow these steps:

1. Use the up and down arrow keys or type in your selection.

2. Then press the Enter key.

On-Line Mode

When you select ONLINE, the alphanumeric device works the same as a
transactor allowing you to transmit MODS or T&A transactions to the host. In
this mode, you can use all but transaction codes 71 through 75. If these
codes are sent from the alphanumeric, the on-line system at Wilkes-Barre
PDC will reject them. Rejected transactions appear on the next 2-hour error
signal report.

Batch Mode

Batching is the process of preparing up to 100 PSDS (MODS, T&A)
transactions in advance and storing them in one of 40 batch files on the
MFDC. The operator can transmit this file. These batch files can be created,
copied, renamed, and erased. Individual transactions in the batch file can be
added or deleted. The only MODS transactions that should be used for
batching are plan hours transaction code A5 or plan volume A3.
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4-13.2 Badge Menu
The operator can use the badge menu to create employee badge cards
through the Badge Preparation Equipment (BPE). The employee can then
record work hours into PSDS through the employee badge reader.
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5 End of Run

End of Run (EOR) is a software application that allows end users to retrieve,
view, and store various statistics from automated mail processing equipment .
EOR is used primarily in mail processing facilities.

EOR collects data from all the automated mail processing equipment—on a
user-defined time interval from an on-site VAX—and then imports it into an
Oracle database.  EOR generates a set of standard reports with essential
data for operating decisions. End users also can use Crystal Reports to
design their own reports using the same information.

EOR supplies information through data files for these systems:
! Management Operating Data System (MODS) / PCMODS:  EOR

allows configurations to identify the type of MODS site.  MODS I
offices can make a direct FTP connection to send information daily.
PCMODS offices make output files on disk to transfer to the system.

! Finalization on Automation Secondary Tracking (FAST):  At the end
of each AP, end users must use EOR to create a file for FAST to
upload to San Mateo.

! Carrier Piece Count (CPC):  End users identify all the offices
participating in the carrier piece count. When EOR identifies a run
with information for that office, it creates (or appends) a file with the
required information.

5-1 Site Configuration
When the program is installed, any user with the “Configure EOR” privileges
can enter local settings. To access these settings, follow these steps:

1. From the Config menu, select Site Configuration.

2. Enter this information:
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! SITENAME:  Identify your site. The name appears at the top of each
End of Run report.

! SITECODE:  Prepare and transmit FAST data. Follow the format
"Zxxxxx"; xxxxx is the 5-digit ZIP Code for your site.

! MODS/PCMODS: Use the drop-down arrows to select from these
options:

MODS For MODS I sites with an FTP
connection to the MFDC: Enter the
IP Address. (If you don't know the
address, contact local  IS.)

PCMODS
LOCAL

For PCMODS sites that run
PCMODS on the same computer

PCMODS EXT For PCMODS sites that run
PCMODS on a different computer

5-1.1 NDSS Configuration
End of Run can download data through an FTP (File Transfer Protocol)
connection. For this to work, you must configure the FTP address.  Follow
these steps:

1. From the Config menu, select NDSS Configuration.

2. Enter this information:
! Username: DMSEOR
! Password: RUNEOR
! HOST: the FTP Address  (It should resemble 56.xx.nn.11 for a

direct poll to the NDSS.)

3. Enter the Number of Days to look back on the NDSS for any new
data.  Enter the number of previous days to check.  (The NDSS
compresses—zips—files older than 3 days. Files in this format cannot
be imported into EOR; they must be un-compressed first. )

4. To exit without saving,
! To accept, select OK.
! To exit without saving, select Cancel.

5-1.2 AFCS/ISS Opn Mappings
End of Run data is transmitted to the MODS program every day. End of Run
will credit the MODS with FHP as generated from AFCS.

1. From the Config menu, select AFCS/ISS Opn Mappings or click on
the MODS icon.

2. Enter a 6-digit operation number that identifies the following downflow
operation to receive the FHP credit:
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! CAT A - is FIM mail; the typical mapping is 871000 or 891000.
! CAT B- is Script mail; the typical mapping is 881000.
! CAT C- is “Readable” mail; the typical mapping is 831000.
! CAT B_ISS - is Script mail where the image was lifted at the

AFCS; typical mapping is 971000 or 271000.
! CAT C_ISS - is “Readable” mail where the image was lifted at

the AFCS; typical mapping is 971000 or 271000.

3. When all selections are complete
! To save the entries and continue, click Save.
! To exit without saving the entries, click Cancel.

A valid social security number must be configured for any EOR user who is to
transmit MODS data.  MODS uses it to identify the person responsible for the
transmitted data. Social security numbers are typically configured for each
user ID when they are established. However, if a user ID does not have a
social security number configured, one must be configured.

5-1.3 FAST Upload Configuration
FAST data can be sent to a server daily at 9:00 a.m. This data will in turn be
loaded to the Corporate Data Base. This option is used to set the
configuration needed to process the upload.

Fill in these fields:
! Username: Enter Anonymous.
! Password: Enter your e-mail address (the first initial
                                               of your first name, your  last name, and
                                               email.usps.gov).
! Host:             Contact Area EOR coordinator for host
   IP address.
! FAST ID: Enter your  5-digit ZIP Code.
! Mainframe ID:              for future use

5-1.4 EOR Server Configuration
The EOR Server is a separate computer responsible for downloading data,
doing daily backups, and creating a carrier piece count file. To properly
configure the EOR Server, follow these steps:

1. On the main menu, select EOR-Server Configuration from the
Config option.

2. Fill in these fields:
! Server Name:   Enter the site’s name.
! Server ID:   Enter  the site’s 9-digit zip.
! Server Address: Enter the server address.

3. To change the password on the server, fill in these fields:
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! Old Password: Enter the password.
! New Password: Enter the new password.
! Confirm New Password: Enter the new password.

5-2 MODS Transactions
EOR transmits machine run data to the MODS application every day.  Each
site has its own MODS cutoff—the time by which the data must be transmitted
for the data to appear on the daily reports. With EORWIN 1.X or higher, there
are no time restrictions. If the cutoff time is missed, a time stamp on each
transaction is placed to ensure posting to the proper day.  Volumes will not be
reflected until the weekly report.

! MODS I offices use an FTP connection to the MFDC, which then
transmits to Minneapolis for daily consolidation.

! PCMODS offices output the MODS transactions to a file, which can
then be imported to the local PCMODS program.

Before transmitting to MODS, check all runs for accuracy and edit them.

5-2.1 MODS/PCMODS Transmission Configuration
To transmit data to MODS, you must set two configurations.

! The first is located under the site configuration where the type of site
is selected—PCMODS (PSDS), PCMODS (local), or PCMODS
(external). This configuration selection prepares EOR for the data
transfer.

! The Configuration button on the MODS menu is to determine the
next handling after the AFCS.  This configuration requests the
operation number (6 digits) for each of these fields:

Field Description Typical Entry
CAT A FIM Mail 871000 or

891000
CAT B Script Mail 881000 or

281000
CAT C Enriched Mail 831000 or

881000
CAT B ISS Script Mail – image lifted

on AFCS
971000 or
271000

CAT C ISS Enriched Mail – image
lifted on AFCS

971000 or
271000

BYPASS Mail not canceled 081000 or blank

The operations listed in the configuration will receive FHP volume based on
the data received from the AFCS.  The default for entries left blank is
operation 881000.
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5-2.2 Preparing MODS Transactions
EOR transmits an ASCII file to MODS with all the necessary data for each
machine type. In the MODS I and PCMODS version 2.x environment, other
transactions with adjustments for FHP are also transmitted.

EOR creates MODS transactions and writes them to a file with a numerical
batch name and file extension of TAC. EOR creates PCMODS transactions
and writes them to a file named PCMODS.TAC.  In both cases, the file is
commonly referred to as the TAC file. The TAC file resides in the directory
specified by the user.

To prepare MODS transactions for transmission, follow these steps:

1. From the Utilities menu, select MODS or click on the MODS icon.

2. Select the MODS DATE for which you want to prepare transactions—
either by entering the date in the field or by using the spin buttons.

You see a list of machine types for which transactions can be prepared.

3. To select machine types, click on either the corresponding check box
or on the machine type itself.
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EOR prepares the transactions and stores them the TAC file until they are
transmitted. After transmission, the file is deleted.

Preparing transactions when TFRSCALE.TAC already exists simply appends
the additional transactions to the end of the file.  In the MODS I environment
this creates an additional file that duplicates previously transmitted
information.

5-2.3 Transmitting MODS Transactions
To transmit transactions to MODS, you must configure EOR as described in
the Site Configuration section for MODS. To transmit the transactions:

!  Select the Transmit button.

The .TAC file is then created and either transmitted to the MFDC computer or
output as an ASCII file to a user-defined location.

If there is an error, you can un-transmit records.

5-3 MODS Reports
After transactions have been prepared and transmitted, MODS reports
become available.  The End of Run system under the MODS option provides
two reports:

! Detail Listing Report
! Mechanization Report

These reports are available only for MODS 1 offices.

5-3.1 MODS Detail Listing Report
The MODS Detail Listing Report lists all volume transactions by each SRF
and operation number.  This report gives you this information:

Field Description
SRF Separate Reporting Facility
TRANS MODS Transaction Code

7-3:  to enter volume to the nearest
hundredth, when exact piece counts are
known
7-4:  to delete volume entered with a 7-3
transaction
7-5:  to enter the console readings (pieces
fed) from mechanized and automated
equipment

OPN # Operation #
MAIL TYPE MODS 2-digit source/type codes that identify

the size, shape, and class of mail
PCS Exact number of pieces
VOLUME Number of pieces in thousands
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Field Description
TOUR Tour on which the volume was processed
TRANSDATE MODS date for the volume transmitted to the

MODS system (AC appears in the column
when data was processed after the MODS
cutoff time.)

AP/DAP AP and MODS day when the volume was
processed

5-3.2 MODS Mechanized Report
The MODS Mechanized Report lists all 9-7 and 9-8 MODS transactions by
each SRF and operation number. This report gives you the following
information:

Field Description
SRF Separate Reporting Facility
TRANS MODS Transaction Code

9-7:  to enter machine runtime
9-8:  to enter machine downtime

OPN # Operation #
MODS ID Machine number
RUN Machine runtime for 9-7 transactions or

machine downtime for 9-8 transactions
TOUR Tour on which the run was processed
TRANSDATE Date when the runtime and downtime were

transmitted to the MODS system
AP/DAP AP and MODS date when the run was

processed
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6 The MODS System Reports

6-1 The MODS Reports
The MODS System produces a wide range of useful reports, which are
described in this section.

6-1.1 Management Summary Report

6-1.1.1 Overview
The Management Summary Report, produced seven days a week for the
plant manager or installation head, summarizes workhours by functional
category and subcategories. A consolidated Saturday/Sunday report includes
volume and hours for both days.

! For a crosswalk of the labor distribution codes, see Handbook F-2,
Functional Management.

! For the column headings of the Management Summary Report.

The Management Summary Report does the following:
! expresses volumes in thousands, rounded to the nearest first

decimal place, and workhours (including overtime hours) to the
nearest whole hour

! lists total office workhours by supervisor, clerk/mailhandler, delivery,
maintenance, and overall office total, including SPLY workhours and
overtime for the current period and period to date

! shows a percentage of difference (% DIFF) comparison between
actual and planned hours for the current period and period to date

! shows a percentage of difference comparison between actual and
SPLY workhours for the current period and the period to date
(Overtime is shown LDC and by functional total.)

If the current period is a day, the period to date is the AP. If the current period
is a week, the period to date is the AP.  If the current period is an AP, the
period to date is the year to date.
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List of PSDS MODS Reports

Management Summary:
Operating Report
Operations Support
Mail Processing
Delivery Services
Operations Maintenance
Customer Services
Finance and Planning
Human Resources
Customer Services Support
Administration Field
Training

Detail Listings:
By Operation
Chronological (VARS)

Mail Processing Tour Workhour Report
Tour Workhour Report
Mail Flow Reports:

Mail Flow Density Matrix
777-778 Proportion File

Planned Hours/Volume Report
MODS Mail Volume Adjustments
Volume-Hours Comparison

Mechanization Performance Evaluation
Mechanization Scheme Analysis
Mail Processing Activity
Trend Analysis
Volume Inquiry
OT Transaction Report
Hourly FHP Flow Operation
MODS Daily Error Transactions Report
National Operation Code Validity Report
Mail Flow Reports
Mail Volume Factoring Error Report
Mechanization Transactions Reports
Workhour Transfer
Error Signal Report
Mail Processing Work Credit Summary
Report
FHP Letter Volume Extract
Originating Letters Summary Report
Work Hour Study by Operation Code
Source Type by Area Report
Out of Bounds Report
Stale Transaction Report

SRF Hours Summary Reports
Mail Processing Tour Operating Report
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Management Summary Report

Management Summary

FRI DAY 28 AP 01 FY 99

-----CURRENT PERIOD WORKHOURS--------  ------PERIOD TO DATE WORKHOURS----

ACTUAL  PLAN  %DIFF  OT  SPLY  %DIFF  OT  ACTUAL  PLAN  %DIFF  SPLY  %DIFF OT

Saturday and Sunday Reports:

On request, the PSDS MODS can produce separate reports for Saturday and
Sunday.

! To request or terminate separate Saturday and Sunday reports, use
transaction code A9.

SRF Hours Summary Report – PSDS Offices only:

The SRF Hours Summary Report is the same as the Management Summary
Report, but contains only workhour data by functional category and
subcategory. This report lists data for:

! actual workhours
! planned workhours
! percentage of difference
! SPLY workhours
! percentage of difference
! overtime for the current period and the period to date

There is no volume information on this report.

• To request the SRF Hours Summary Report, use transaction
code JA.

6-1.1.2 Workhour Summary
The Management Summary Report lists workhour totals for supervisor,
clerk/mail handler, delivery, and maintenance. Here are the equations for
these productivity calculations:

Supervisor = 01 + 10 + 20 + 30 + 35 + 40 + 50 + 60 + 70 + 80 + 81 + 88 +
89 +90 + 91 + 92 + 93 + 94 + 95 + 96 + 97 + 98

Clerk/Mail handler = 02 + 03 + 04 + 05 + 07 +  08 + 09 + 11 + 12 + 13 + 14 +
15 + 17 + 18 + 41 + 42 + 43 + 44 + 45 + 46 + 47 + 48 + 49 + 51 + 52 + 53 +
54 + 55 + 56 + 57 + 61 + 62 + 63 + 64 + 65 + 71 + 72 + 73 + 74 + 75 + 76 +
77 + 78 + 79 + 82 + 83 + 85 + 89 + 90 + 91 + 94 + 95 + 96 + 97 +  98
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Delivery = 21 + 22 + 23 + 24 + 25 +  26 + 27 + 28 + 29 + 92

Maintenance = 31 + 32 + 33 + 34 + 36 + 37 + 38 + 39 + 93

6-1.1.3 First Handling Pieces (FHP) Volumes
The Management Summary Report:

! lists FHP volumes and planned FHP volumes to the nearest
thousand pieces for the current period, actual, and SPLY—for period
to date,  actual, and SPLY

! shows the percentage of difference between the actual and planned
FHP volumes and between the actual and SPLY volumes

! shows separate total FHP volumes for mail processing and customer
service by letters, flats, parcels, and a total FHP for each (The Total
Office FHP is the sum of total mail processing FHP and total
customer service FHP.)

! reports presort volumes by operation definition (operation numbers
002 through 009) to the nearest thousand pieces along with a
preferential and standard totals (These presort volumes are not
added to FHP, TPH, or work credit.)

6-1.1.4 Cancellations
The Management Summary Report shows volumes to the nearest thousand
pieces for cancellation (both machine and hand-canceled pieces) and
metered mail (including meter bypass mail).

6-1.1.5 FHP Productivities
This section shows FHP productivities. These are the equations:

MP FHP/MP NON-SUPV WKHRS = Total mail processing FHP divided by
mail processing clerk and mail handler workhours (not including supervisors)

MP FHP/MP TOTAL WKHRS = Total mail processing FHP divided by total
mail processing workhours (clerk, mail handler, and supervisor)

MP FHP/MP+TRAINING HRS = Total mail processing FHP divided by total
mail processing workhours including training hours

CUST SV FHP/CUST SV WKHR = Total Customer Service FHP divided by
total customer service workhours

DISTRIBUTION PRODUCTIVITY INDICATOR = Total office FHP divided by
total mail processing and customer service workhours, including training
hours (Total LDC 91 + 94) minus LDC 45 & 47

TOT OFC WKHR = Total office FHP divided by total office workhours

This equation shows TPH productivity:

TPH PRODUCTIVITY = MP TPH/MP + TRAINING HOURS = Total mail
processing TPH divided by mail processing workhours, including training
hours
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6-1.1.6 SPLY FHP Productivities
The Management Summary Report shows:

! SPLY FHP volume productivities for mail processing clerk and
mailhandler workhours (MP FHP/MP NON-SUPV WKHRS)

! total SPLY workhours mail processing (MP FHP/MP TOTAL
WKHRS)

! customer service SPLY workhours (Customer Service
FHP/Customer Service Total Workhours)

! total office SPLY workhours (TOT OFC FHP/TOT OFC WKHRS)

6-1.1.7 Letter and Flat Processing
The Management Summary Report shows the percentage of FHP and TPH
letters processed on the automation LDCs, mechanization LDCs, and manual
LDCs. Here are the equations for these percentages:

6-1.1.7.1 Mail Processing Volume by Distribution Type

%FHP—AUTOMATED = FHP Mail Processing Letters (Automated) divided by
FHP Mail Processing Letters (Automated, Mechanized, Manual)

%FHP—MECHANIZED = FHP Mail Processing Letters (Mechanized) divided
by FHP Mail Processing Letters (Automated, Mechanized and Manual)

%FHP—MANUAL = FHP Mail Processing Letters (Manual) divided by FHP
Mail Processing Letters (Automated, Mechanized and Manual)

% TPH INCOMING SECONDARY LETTERS—AUTOMATED = TPH
automated incoming secondary letters divided by TPH Mail Processing
Letters (Automated, Mechanized and Manual)

% TPH INCOMING SECONDARY LETTERS—MECHANIZED = TPH
mechanized incoming secondary letters divided by TPH Mail Processing
Letters (Automated, Mechanized and Manual)

% TPH INCOMING SECONDARY LETTERS—MANUAL = TPH manual
incoming secondary letters divided by TPH Mail Processing Letters
(Automated, Mechanized and Manual)

%FHP FLATS—MECHANIZED = FHP mechanized flats divided by total FHP
Mail Processing flats (Mechanized and Manual)

%FHP FLATS—MANUAL = FHP manual flats divided by total FHP Mail
Processing flats (Mechanized and Manual)

%TPH INCOMING SECONDARY FLATS—MECHANIZED = TPH
mechanized flats divided by TPH Mail Processing flats (Mechanized and
Manual)

%INCOMING SECONDARY FLATS—MANUAL = TPH manual flats divided
by TPH Mail Processing flats
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6-1.1.7.2 Customer Service Volume by Distribution Type

%FHP—AUTOMATED = FHP Customer Service Letters, Automated divided
by FHP Customer Service Letters, Automated, Mechanized, Manual

%FHP—MECHANIZED = FHP Customer Service Letters, Mechanized divided
by FHP Customer Service Letters, Automated, Mechanized, Manual

%FHP—MANUAL = FHP Customer Service Letters, Manual divided by FHP
Customer Service Letters, Automated, Mechanized and Manual

%TPH—AUTOMATED = TPH Customer Service Letters, Automated divided
by TPH Customer Service Letters, Automated, Mechanized, Manual

%THP—MECHANIZED = THP Customer Service Letters, Mechanized divided
by TPH Customer Service Letters, Automated, Mechanized, Manual

%THP—MANUAL = TPH Customer Service Letters, Manual divided by TPH
Customer Service Letters, Automated, Mechanized, Manual

6-1.1.8 Manual Workhour Ratios
This section of the Management Summary shows manual workhour ratio
percentages for mail processing by:

! manual vs. automated/mechanized distribution (LADDER A MAIL
PROC)

! mail processing and customer service by manual vs.
automation/mechanization (LADDER B MAIL PROC)

! for mail processing, customer service, and city delivery by
automation/mechanization (LADDER C MAIL PROC & CUST SERV
& CITY DEL)

Here are the equations for these calculations:

LADDER A MAIL PROC (mail processing) = Total workhours (LDC 14)
divided by LDC 11, 12, 13 and 14

LADDER B MAIL PROC (mail processing plus customer service) = Total
workhours (LDC 14, 43, and 44) divided by LDC 11, 12, 13, 14, 41, 42, 43,
and 44

LADDER C MAIL PROC & CUST SERV & CITY DEL = Total workhours (LDC
14,43,44,21, 28 and 29) divided by LDC 11,12,13,14,41,42,43,44, 21,28 and
29

6-1.1.9 Key Automation Indicators
The Key Automation Indicators on the Management Summary show the
percentage of:

! FHP mail volume processed on automated equipment (OUTGOING
PRIMARY FHP ON AUTOMATION)

! TPH mail volume finalized to the route or box section (FINALIZED
TO ROUTE/BOX ON AUTOMATION)
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! TPH finalized on automated equipment to delivery sector/segment
(FINALIZED TO SECTOR/SEGMENT ON BCS).

Here are the equations for these calculations:

% OUTGOING PRIMARY FHP ON AUTOMATION = Measures effectiveness
of outgoing automation processing strategy.  Outgoing primary automated
FHP (831 + 841 + 851 + 861 + 871 + 881 + 891 + 971 + 261 + 271 + 281) /
All outgoing Primary FHP (030C + 841 + 851 + 861 + 871 + 881 + 891 + 971
+ 261 + 271 + 281)

% FINALIZED TO INCOMING SECONDARY ON AUTOMATION = Measures
incoming secondary finalized to carrier route/box section/sector/segment and
DPS.  Incoming Secondary automated TPH (836 + 837 + 846 + 847 + 856 +
857  + 866 + 867 + 868 + 876 + 877 + 878 + 886 + 887 + 896 + 897 + 898 +
976 + 977 + 978 + 266 + 267 + 276 + 277 + 278 + 286 + 287 + 908 + 910  +
911 + 914 + 916 + 918 + 925) / All manual, mechanized, and automated
incoming secondary TPH (160C + 168C + 086 + 087 + 089 + 096 + 097 + 099
+ 836 + 837 + 846 + 856 + 857 + 866 + 867 + 868 + 876 + 877 + 878 + 886 +
887 + 896 + 897 + 898 + 976 + 977 + 978 + 266 + 267 + 276 + 277 + 278 +
286 + 287 + 288 + 908 + 909 + 910 + 911 + 914 + 916 + 918 + 925)

% FINALIZED TO SECTOR/SEGMENT ON BCS = Measures incoming
secondary finalized to sector/segment. Sector/Segment TPH (868 + 878 +
898 + 978 + 278 + 288 + 908) / All Manual, mechanized, and automated
incoming secondary TPH (160C + 168C + 086 + 087 + 089 + 096 + 097 + 099
+ 836 + 837 + 846 + 847 + 856 + 857 + 866 + 867 + 868 + 876 + 877 + 878 +
886 + 887 + 896 + 897 + 898 + 976 + 977 + 978 + 266 + 267 + 276 + 277 +
278 + 286 + 287 + 288 + 908 + 909 + 910 + 911 + 914 + 916 + 918 + 925)

% FINALIZED TO DELIVERY POINT SEQUENCE ON BCS = Measures
incoming secondary finalized to delivery point sequence.  Delivery Point
Sequence Volume TPH (911+ 914 + 916 + 918 + 925 / All Manual,
mechanized, and automated incoming secondary TPH (160C + 168C + 086 +
087 + 089 + 096 + 097 + 099 + 836 + 837 + 846 + 847 + 856 + 857 + 866 +
867 + 868 + 876 + 877 + 878 + 886 + 887 + 896 + 897 + 898 + 976 + 977 +
978 + 266 + 267 + 276 + 277 + 278 + 286 + 287 + 288 + 908 + 909 + 910 +
911 + 914 + 916 + 918 + 925)

6-1.2 Operating Reports
The Operating Report gives data to the operational level, volume (FHP &
TPH), actual and planned workhours, and overtime for current period and
period to date—by day, week, and AP. Each functional category also
produces a separate operating report:

! Operations Support
! Mail Processing
! Delivery Services
! Operations Maintenance
! Customer Services
! Controller
! Human Resources
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! Marketing and Communications
! Administration
! Training

Each separate reporting facility (SRF) produces an individual Operating
Report and a consolidated report by functional category—by day, week, and
AP.

LDCs for Operating Reports

Operations Support Operating Report
01 SUPERVISION - OPERATIONS SUPPORT
02 QUALITY CONTROL ACTIVITIES
03 INDUSTRIAL ENGINEERING ACTIVITIES
04 ADDRESS INFORMATION SYSTEMS
05 CONTROL LOGISTICS & TRANSPORTATION
07 ENVIRONMENTAL
08 ADMINISTRATIVE & CLERICAL
09 DELIVERY & RETAIL PROGRAMS
Mail Processing Operating Report
10 SUPERVISION MAIL PROCESSING
11 AUTOMATED LETTERS/MLOCR
12 MECH LETTERS/MPLSM MIXED
13 MECHANIZED/PARCEL SORTER
14 MANUAL LETTERS, FLATS & PARCELS
15 REMOTE BAR CODE SORTER (and LMLM)
17 PLATFORM OPERATIONS (OTHER DIRECT OPER)
18 REGISTRY (INDIRECT/OTHER RELATED)
Delivery Service Operating Report
20 SUPERVISION  -  DELIVERY SERVICE
21 CITY DELIVERY - OFFICE TIME
22 CITY DELIVERY - STREET TIME
23 CITY DELIVERY – OTHER
24 SPECIAL DELIVERY
25 RURAL DELIVERY
26 CUSTOMER SUPPORT
27 COLLECTIONS – MIXED
28 [TIERATY?] CITY CARRIER
29 ROUTER
Operations Maintenance Operating Report
Vehicle Services
30 SUPERVISOR - VEHICLE SERVICES
31 ADMINISTRATIVE & CLERICAL
32 VEHICLE MAINTENANCE
33 VPO SUPPORT
34 VEHICLE OPERATIONS
Plant & Equipment Maintenance
35 SUPERVISION – PLANT & EQUIPMENT MAINTENANCE
36 POSTAL OPERATING EQUIPMENT
37 BUILDING SYSTEMS EQUIPMENT
38 BUILDING SERVICES
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39 MAINTENANCE PLANNING, CONTROL & STORES
Customer Services Operating Report
40 SUPERVISION – CUSTOMER SERVICES
41 AUTOMATED DISTRIBUTION – LETTERS
42 MECHANIZED DISTRIBUTION - LETTERS & FLATS
43 MANUAL DISTRIBUTION - LETTERS, FLATS, PARCELS
44 POST OFFICE BOX DISTRIBUTION - MANUAL
45 WINDOW SERVICES
46 VENDING EQUIPMENT
47 ASSOCIATE OFFICE (CAG H-L)
48 ADMINISTRATIVE/MISCELLANEOUS
49 COMPUTERIZED FORWARDING SYSTEM
Controller Operating Report
50 SUPERVISION – FINANCE
51 REVENUE ASSURANCE
52 ACCOUNTING SERVICES
53 PSDS OPERATIONS
54 BUDGET & FINANCIAL ANALYSIS
55 SYSTEMS COMPLIANCE
56 ADMINISTRATIVE & CLERICAL
57 STATISTICAL PROGRAMS
58 OTHER TIMEKEEPING ACTIVITIES
Human Resources Operating Report
60 SUPERVISION – HUMAN RESOURCES
61 LABOR RELATIONS ACTIVITIES
62 PERSONNEL SERVICES
63 SAFETY & HEALTH
64 EEO/AFFIRMATIVE ACTION
65 TRAINING SUPPORT
66 INJURY COMPENSATION
68 LIMITED DUTY
69 REHABILITATION
Marketing & Communication Operating Report
70 SUPERVISION – MARKETING & COMMUNICATION
71 ACCOUNT MANAGEMENT
72 POSTAL BUSINESS CENTER
73 EXPEDITED MAIL SERVICE
74 RETAIL MARKETING
75 CLAIMS & INQUIRIES/DEAD MAIL
76 CONSUMER AFFAIRS
77 ACCOUNTABLE PAPER
78 ADMINISTRATIVE & CLERICAL
79 MAIL REG & BUSINESS MAIL ENTRY
Administration Operating Reporting
80 POSTMASTER/INSTALLATION HEAD
81 SUPERVISION - ADMINISTRATION (FIELD)
82 ADMINISTRATIVE & CLERICAL
83 PROCUREMENT
84 INFORMATION SYSTEMS
85 FACILITIES
88 MANAGEMENT PROJECTS - SUPERVISION
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89 MANAGEMENT PROJECTS - NON-SUPERVISION
Training Operating Report
90 TRAINING - OPERATIONS SUPPORT
91 TRAINING - MAIL PROCESSING
92 TRAINING - DELIVERY SERVICES
93 TRAINING - MAINTENANCE
94 TRAINING - CUSTOMER SERVICES
95 TRAINING - CONTROLLER
96 TRAINING - HUMAN RESOURCES
97 TRAINING - MARKETING & COMMUNICATION
98 TRAINING - ADMINISTRATION

Saturday and Sunday Reports:

On request, MODS can produce separate operating reports for Saturday and
Sunday.

! To request or terminate separate Saturday and Sunday reports, use
transaction code A9.

6-1.2.1 Operations Support Operating Report
The Operations Support Operating report lists:

! actual and planned workhours by LDC
! percentage difference between actual and plan
! overtime for current period and period to date

The report expresses workhours by LDC to the nearest whole hour and
includes overtime; overtime workhours are reported for each LDC.

For the major column headings of the Operations Support Operating Report,
see the next exhibit.

OPERATIONS SUPPORT
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

---------CURRENT PERIOD ------------------      ----------PERIOD TO
DATE -------------

SUPV NONSUPV PLANNED SUPV NONSUPV PLANNED

LDC OPN-LU WORKHRS WORKHRS WORKHRS %DIFF O/T WORKHRS WORKHRS WORKHRS %DIFF OT
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6-1.2.2 Mail Processing Operating Report
The Mail Processing Operating Report shows the following for all mail
processing LDCs:

! volume (FHP, TPH, WKLD UNITS)
! productivity calculations (FHP/HR, TPH/HR, WKLD/HR, WC/HR)
! workhours (actual and planned)
! overtime data for all mail processing LDCs (The report recaps all

column items by LDC, lists a total of LDCs 10-18, and has work
credits.)

The report expresses FHP, TPH, WKLD, and WORK CREDITS in thousands,
rounded to the first decimal place.  It expresses workhours to the nearest
whole hour, including overtime, and reports overtime hours for each LDC for
the current period and period to date.

On request, an optional daily, weekly, and AP tour mail processing Operating
Report is available.

! To request or terminate this report, use transaction code A9.

The tour report lists data in the same format as the daily operating report and
divides the data into separate tours. We recommend that a request tour
reporting begin or end at the beginning of an AP. Requests entered during an
AP will result in incomplete period-to-date data. When the report is terminate
in the middle of an AP, the report will continue until the end of the AP.

For the major column headings of the Mail Processing Operating Report, see
the next exhibit.

MAIL PROCESSING
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

---------CURRENT PERIOD ----------------     ----------------PERIOD TO
DATE ----------

FHP TPH WORK PLANNED FHP TPH WORK PLANNED

LDC OPN-LU FHP TPH /HR /HR HOURS WORKHRS O/T FHP TPH /HR /HR HOURS WORKHRS O/T

6-1.2.3 Delivery Services Operating Report
The Delivery Service Operating Report shows:

! carrier volumes
! actual and planned workhours
! percentage difference between actual and plan
! overtime hours for all delivery services functions by LDC
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The carrier volumes are listed as letters, flats, and parcels as flowed to each
2-digit station code and summarized as a line total under LDC 22. The report
lists actual workhours, planned workhours, and total overtime for the current
period and period to date. Overtime hours are reported for replacements and
other categories at the LDC level.

The report expresses carrier volumes in thousands, rounded to the nearest
first decimal place (hundreds).  It expresses workhours to the nearest whole
hour including overtime.

For the major headings of the delivery services operating report, see the next
exhibit.

DELIVERY - SERVICES
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

---------CURRENT PERIOD -------------     ----------------PERIOD TO
DATE -------------

DELIVERY ACTUAL PLANNED DELIVERY ACTUAL PLANNED

LDC OPN-LU VOLUME WORKHRS WORKHRS %DIFF O/T WORK WORKHRS WORKHRS %DIFF OT

6-1.2.4 Operations Maintenance Operating Report
The Operations Maintenance Operating Report shows:

! workhours (actual and planned)
! percentage difference between actual and plan
! total overtime data for all vehicle and maintenance LDCs for the

current period and period to date
! individual totals for Vehicle Services LDCs and Plant and Equipment

Maintenance LDCs

The report expresses workhours to the nearest whole hour and includes
overtime.

For the major column headings of the Operations Maintenance Operating
Report, see the next exhibit.
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OPERATIONS - MAINTENANCE
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

------------CURRENT PERIOD ------------------------       ---------------PERIOD TO DATE -------
ACTUAL PLANNED ACTUAL PLANNED

LDC OPN-LU WORKHRS WORKHRS %DIFF O/T WORKHRS WORKHRS %DIFF OT

6-1.2.5 Customer Services Operating Report
The Customer Service Operating Report shows the following information for
the current period and period to date:

! volume (FHP & TPH) and productivity calculations (FHP/HR,
TPH/HR)

! manual distribution volumes for letters, flats and parcels (FHP, TPH)
! workhours (actual and planned)
! overtime hours (replacement and other) for customer services by

LDC

The manual distribution volumes consist of FHP and TPH volumes recorded
in LDC 43.  This volume will appear to a station/branch level if the office
records FHP in LDC 43. This would require a Form 5800-B. (See chapter 4.)
This volume is then totaled for letters, flats, and parcels.

The report expresses distribution volumes in thousands, rounded to the first
decimal place (hundreds). It expresses workhours to the nearest whole hour
including overtime. Overtime hours are reported for replacement and other
overtime.

For the major headings of the Customer Services Operating Report, see the
next exhibit.

CUSTOMER SERVICES
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

---------CURRENT PERIOD -----------------     -----------PERIOD TO
DATE --------------

WORK PLANNED WORK PLANNED

LD

C

OPN-LU FHP TPH HOURS WORKHRS O/T FHP TPH HOURS WORKHRS O/T
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6-1.2.6 Finance & Planning Operating Report

The Finance Operating Report shows the following information for the current
period and period to date:

! workhours (actual and planned)
! percentage difference between actual and plan
! overtime data for all Finance LDCs

The report expresses workhours to the nearest whole hour, including
overtime, and lists overtime hours for each LDC.

For the major headings of the Finance Operating Report, see the next exhibit.

FINANCE
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

---------CURRENT PERIOD --------------      ----------PERIOD TO DATE -
----------------

ACTUAL PLANNED ACTUAL PLANNED

LD

C

OPN-LU WORKHRS WORKHRS % DIFF O/T WORKHRS WORKHRS % DIFF O/T

6-1.2.7 Human Resources Operating Report
The Human Resources Operating Report shows the following information for
the current period and period to date:

! workhours (actual and planned)
! percentage difference between actual and plan
! overtime data for all human resources LDCs

The report expresses workhours to the nearest whole hour, including
overtime, and list overtime hours for each LDC.

For the major column headings of the Human Resources Operating Report,
see the next exhibit.
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HUMAN RESOURCES
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

---------CURRENT PERIOD ---------------      ----------PERIOD TO DATE
----------------

ACTUAL PLANNED ACTUAL PLANNED

LD

C

OPN-LU WORKHRS WORKHRS %DIFF O/T WORKHRS WORKHRS % DIFF O/T

6-1.2.8 Customer Service Support Operating Report and
the Administration – Field Operating Report

The Customer Service Support Operating Report and the Administrative-Field
Operating Report both show the following information for the current period
and period to date:

! workhours (actual and planned)
! percentage difference between actual and plan workhours
! overtime data for all Customer Service Support LDCs and for all

Administration-Field LDCs

The reports express workhours to the nearest whole hour, including overtime,
and report overtime hours for each LDC.

For the major column headings of the Customer Service Support Operating
Report, see the next exhibit.

CUSTOMER SERVICE SUPPORT
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

---------CURRENT PERIOD -------------------      ----------PERIOD TO
DATE ------------

ACTUAL PLANNED ACTUAL PLANNED

LD

C

OPN-LU WORKHRS WORKHRS % DIFF O/T WORKHRS WORKHRS % DIFF O/T

For the major column headings of the Administration – Field Operating
Report, see the next exhibit.
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ADMINISTRATION - FIELD
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

---------CURRENT PERIOD ------------------      ----------PERIOD TO
DATE -------------

ACTUAL PLANNED ACTUAL PLANNED

LD

C

OPN-LU WORKHRS WORKHRS % DIFF O/T WORKHRS WORKHRS % DIFF O/T

6-1.2.9 Training Operating Report
The Training Operating Report shows the following information for the current
period and period to date:

! workhours (actual and planned)
! percentage difference between actual and plan workhours
! overtime data for all Training LDCs

The report expresses workhours to the nearest whole hour, including
overtime, and lists overtime hours for each LDC.

For the major column headings of the Training Operating Report, see the next
exhibit.
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TRAINING
OPERATING REPORT

FRI DAY 28 AP 01 FY 99

---------CURRENT PERIOD ------------------      ----------PERIOD TO
DATE -------------

SUPV NONSUPV PLANNED SUPV NONSUPV PLANNED

LDC OPN-LU WORKHRS WORKHRS WORKHRS % DIFF O/T WORKHRS WORKHRS WORKHRS % DIFF O/T

6-1.3 Adjustment Reports

6-1.3.1 Mail Volume Adjustment Report
Produced daily, the Mail Volume Adjustment Report reflects all transaction
codes 71, 72, 73, 74, 75, 79, A1, A2, and J2 inputs entered during the day.
The report lists the entries in ascending numerical LDC. After the volume
adjustment entries, the report lists overtime adjustment entries 79 and MODS
scale volume adjustment transactions. These are the report's major column
headings and descriptions.

6-1.3.2 Special A1
If a communication interruption or hardware failure in PSDS causes mail
volume data to be transmitted after the MODS cutoff, MODS will generate
transaction code A1 for MODS Scale System transactions or transaction code
AC for transaction codes 71, 72, 73, 74, 75, and A2. The transactions will
apply the volume to the correct MODS day.

Example: A communication failure occurs in the PSDS lower network at 07:00
am, MODS day 04, in an office with an 08:00 am MODS cutoff. The problem
is corrected by 09:30 am, and the data is transmitted to the host. The volume
data will appear in the MODS day 05 reports, and volume data between 07:00
and 08:00 am are reflected in the period-to-date section of the Management
Summary and Operating Reports.

MODS-generated A1 transaction codes are identified with an asterisk in the
volume adjustment report, VARS, and detail listing in the first digit in the
social security field in the A1. The next eight digits are the month, day, and
year the transaction was entered (mmddyyyy).  System-generated TCs are
defined by the letters AC in the transaction type field of the transaction.

For the major column headings of the Mail Volume Adjustment Report, see
the next exhibit.
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MODS MAIL VOLUME ADJUSTMENTS         DY 24 AP13 FY 1999 PAGE 1

OPN-LU ST TIME TR-CD DPP MACH AUTH--SSN PIECES UNITS FREQ

OPN-LU Operation Number
ST Source/Type Code
TIME Transmission time of entry
TR CD Transaction code
DPP Day of pay period
MACH Machine number of equipment on which transaction was entered
AUTH-SSN Social security number of employee who enter the transaction
PIECES Number of pieces entered

(units x conversion rate if entered with a transaction code 71 or 72)
UNITS Pounds, sacks, workload units, etc. from characters  11-13 in transaction code 71 or 72
FREQ Frequency code from A1or 79 transactions only.  Note:  The frequency code is shown for the

A1 in the FREQ field:
1 = Current Period
2 = Prior Period
Note:  The frequency code is shown for the 79 in the FREQ field:
1 = Current Day
2 = Prior Period

6-1.4 Workhour Transfer Report
The Workhour Transfer Report is a daily report that shows all transaction
code A4 entered in PSDS in the MODS day listed in the header of the report.
The report shows the number of workhours transferred from one LDC to
another or the number of hours added to a LDC. These are the column
headings and descriptions:

MODS WORK HOUR TRANSFER   AP13  DY 24 09/15/99
OPN-LU OPN-LU FACILITY FACILITY WORK AP

FROM TO FROM TO MACH TIME HOURS CRAFT DAY FREQ AUTH--SSN

Column Description

OPN-LU FROM Operation number hours are transferred from
OPN-LU TO Operation Number hours are transferred to
FACILITY FROM SRF code workhours are transferred from
FACILITY TO SRF code workhours are transferred to
MACH Machine number of equipment on which transaction was entered
TIME Transmission time of entry
WORKHOURS Number of workhours to be transferred
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CRAFT Craft code (1 = Clerk, 2 = Mailhandler, 3 = Supervisor)
AP DY Day of accounting period
FREQ Frequency of transaction (current or prior AP)
AUTH-SSN Social security number of authorized user who enter transaction

6-1.5 Additional Reports

6-1.5.1 Detail Listing Report
The Detail Listing Report is a daily report you can request by entering
transaction code A7 and receive continuously as required. A request or
termination of this report will occur on the MODS day after transaction code
A7 is entered. The listing is in time sequence, in increments of 0.01 hours,
and totaled by S/T code in each requested operation number. Volume entries
for transaction code 71, 72, 73, 74, 75, A1, and A2 are reflected as units or
pieces, depending on input transaction, but not both. These are the column
headings and descriptions:

MODS DETAIL LISTING  AP13  DY 24 DA 02  PAGE 5

MACH OPN-LU TIME TRANSTYP MAILTYP WEIGHT PIECES ADJUST ST/BR RF AUTH--SSN

Column Description
MACH Machine number of equipment on which transaction was entered
OPN-LU Operation number
TIME Transmission time of entry
TRANSTYP Transaction code (71, 72, 73, 74, 75, A1, A2)
MAILTYP Mail type (Source/type code)
WEIGHT Pounds, workload units, sacks, hampers, etc. (from 71, 72, A2

transaction)
PIECES Number of pieces entered with transaction code 73, 74, 75, A1
ADJUST Adjustment type (PLUS or MINUS transaction type)
ST/BR Separate reporting facility code
RF Report frequency of transaction code A1 (current, prior)
AUTH SSN Social security number of authorized user who enters transaction

6-1.5.2 Chronological (VARS) Detail Listing Report
The Chronological Detail Volume Listing Report is a daily report you can
request by entering transaction code J4 and receive continuously as needed.
The request for or termination of the report will occur the MODS day after the
transaction is entered. The listing is in time sequence starting with an offices
MODS cutoff, in increments of  0.01 hours. Volumes entries for transaction
code 71,72,73,74,75,A1,and A2 are expressed as weight or pieces,
depending on input transaction, but not both. These are the column headings
and descriptions:
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MODS FHP VARS CHRONOLOGICAL DETAIL LISTING   PP04  DAY 14
FY 1999 AP 05 DAY 28

TIME OPN-LU ST WEIGHT PIECES TR-TYP MACH PP DA RF SB AUTH--SSN

TIME Transmission time of entry
OPN-LU Operation Number
ST Source/Type code
WEIGHT Pounds, workload units, sacks, hampers, etc. (from 7-1, 7-2, A-2 transactions)
PIECES Number of pieces entered with transaction
TR-TYP Transaction Code (71, 72, 73, 74, 75, A1, A2)
MACH Machine number of equipment on which transaction was entered
PP Pay period
DA Day of the pay period (01-14)
RF Report frequency of transaction code A1 (current, prior)
SB Separate Reporting facility code

6-1.5.3 Tour Workhour Report
The Tour Workhour Report is produced daily for all functional areas and
weekly each AP for mail processing. This report shows workhours and
overtime by operation for each of all three tours. Overtime is shown as a
"non-add" item (included in workhours) below the operation workhours for
each tour as well as the daily total.  Tours are 8-hour periods beginning with
the MODS day cutoff (tour 2, 3, and 1).

For the major column headings of the Tour Workhour Report, see the next
exhibit.

TOUR WORKHOUR REPORT
WEEK 4 AP 07 FY 1999

OPN-LU TOUR 2 TOUR 3 TOUR 1PIECES TOTALS

6-1.5.4 Error Signal Report and Error Signal Report—
Mechanization

The Error Signal Report is printed in intervals established by the local site
through the Wilkes-Barre Postal Data Center customer support branch. The
report has two parts: volume and hours. Each covers errors that have
occurred since the previous report cutoff time.

For the major column headings of the Error Signal Report, see the next
exhibit.
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MODS ERROR SIGNAL REPORT – VOLUME 1831    05/25/99

MACH TIME AUTH SSN CD-TP OPN-LU FC VAL FREQ TCDE VOLUME SIGNAL

If you see these errors, correct them by entering the correct data. (The
abbreviations appear in parentheses.)

! Invalid Function Operation Number (INV VOL OP): An invalid
operation number was used—either as a volume entry or as an
employee clock ring. If the entry is for volume, the entry is rejected
and must be corrected by inputting the correct data. However, if the
error is an employee's clock ring, the ring is accepted for pay
purposes. If an erroneous clock ring is not corrected by means of
transaction code 5 adjustment before the time and attendance cutoff
time, the elapsed hours represented by the error ring are
accumulated as undistributed labor.  These errors are lumped into
operation 999.

! Inconsistent Operation Number-Source/Type Code (INCONS OPN-
LU/ST): The operation number does not agree with the source/type
code (a letter distribution operation number used with a source/type
code applicable only for flats, for example).

! Invalid From/To Operation Number (INV FROM/TO LDC): A scale
transaction is made with an invalid from or to LDC.

! Invalid OT Frequency (INV OT FREQ): The frequency code in a
transaction code 79 entry is other than 1, 2, or 3.

! Invalid LBS-PCS Code (INV LBS-PCS): The LBS-PCS Code in
transaction code A1 is other than 1 or 2.

! Invalid Value Code (INV VALUE): The value code in a transaction
code 75 is other than 1 or 2; or in a transaction code 79 is other than
1, 2, or 3.

! Invalid FREQ Code (INV FREQ: The frequency code in a transaction
code A1 is other than 1 or 2.

! Unidentified Transaction Error (UNIDENT TRANS): A transaction
cannot be identified (incorrect data in one or more fields).

! Invalid Accounting Period (INV ACCT PD): The accounting period in
a transaction code A1 or A4 is entered as other than 00-13.
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! Invalid Day of Accounting Period (INV AP DAY): The day of
accounting period in a transaction code A1 or A4 is entered as other
than 00-28.

! Invalid Value Plus and/or Minus (INV VALUE +/-): The value in a
transaction code A1 is other than + or -.

Error Signal Report—Mechanization

This report is produced for these errors that may occur when entering
information necessary to produce the mechanization reports:

! Invalid Operation (INV VOL OP): Numbers other than automation or
mechanization operation numbers are used with transaction code 95
through 98.

! Invalid Machine Number (INV MACH NO):  A machine number is
other than 01-99 in a transaction code 95 through 98.

! Invalid Day of Pay Period (INV DPP): Transaction code 95 through
98 are entered for a future day, or before the current week.

! Run or Downtime Not Numeric (RUN TIME 00):  The run or
downtime entered in a transaction code 97 or 9-8 is other than 0-9.

! Non-numeric Data

! Invalid Date

6-1.5.5 Out-of-Bounds Report
Out-of-Bounds Reports are both on-line and off-line reports for MODS volume
and workhours by operation number for each site. Out-of-bounds data is
more than 25% higher each day than the average daily volume (FHP or TPH)
or workhours by operation number over the last 13 APs.

For example, to determine the average daily FHP volumes for a given LDC,
add the FHP for the previous 13 Aps for the site and divide the total by 364
MODS days.

On-Line Reports:

If an on-line error condition is detected, the site will receive a report at the
next 2-hour time and attendance processing interval (see F-22 640). The
report lists on-line checks for individual transactions by operation number for
workhours greater than 25% higher than daily average and a standard
message that the amount is out of bounds.

If a site receives this report, it must verify the warning condition and make any
necessary adjustment.
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Off-Line Reports:

The off-line report checks for volume (FHP & TPH) and workhours greater
than 25% higher than the daily average and negative volume conditions. A
separate off-line out-of-bounds report is generated for each site after the daily
volume adjustments reports. The report is in ascending LDC order (by
operation number) and lists the following for the error condition:

! average daily FHP
! current day FHP
! average daily TPH
! current day TPH
! average daily workhours
! current day workhours

If an error condition is not detected for any one of the three conditions—FHP,
TPH, or workhours—the column is zero-filled.

Example: If an error condition was detected for operation number 875 for FHP
only, the report will list the average daily FHP, current day FHP, and zero-fill
these columns: average and current TPH, and workhours.

6-1.5.6 Planned Hours/Volume Report
Produced each AP, the Planned Hours/Volume Report reflects planned hours
entered with transaction code A5 and A6 and planned FHP volumes entered
with a transaction code A3.

6-1.5.7 Mail Flow Reports

6-1.5.7.1 Mail Flow Density Matrix

The Mail Flow Density Matrix Report reflects the mail flow densities
established by each office that are entered with a transaction code A8. The
report, produced at the beginning of each AP, lists data in ascending
operation sequence by separate reporting facility. The report shows the
percentages of mail, by type, flowing from one operation to another. For the
major headings of this report, see the next exhibit.
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MAIL FLOW DENSITY MATRIX SUMMARY  09/19/1999
OPERATING REPORT

NOTE A 1=FHP 2=SHP 3=TPH 4=FHP/SHP 9=ALL

NOTE B 1= STAMPED 2=METERED 3=MIXED 4=BULK BUS 9=ALL

FROM FROM NOTE -----TO-

---

------

TO----

------TO-

---

------TO-

---

------TO-

---

------TO-

---

------TO-

---

SRF OPN A B OPER % OPER % OPER % OPER % OPER % OPER % OPER %

6-1.5.7.2 Matrix/777-778 Mail Flow Proportion-File Report

The operation number Mail Flow Proportion Report shows the percentage
proportion entered with transaction code A8 of volumes flowed to each branch
for carrier and box mail for operation numbers 777 and 778 from the Mail
Flow Density Matrix, Form 5800-A. This report is produced at the beginning of
each accounting period. To document the percentage changes, use Form
5800-C, Carrier Mail by Station and Total Station Box Mail. For the major
headings of this report, see the next exhibit.
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MAIL FLOW DENSITY 777-778 PROPORTION FILE REPORT   09/19/1999

TR/ TYPE --------------------------------PROPORTION PERCENTAGES TO STATIONS ----------------------------------------

MST OPER MAIL ST % ST % ST % ST % ST % ST % ST % ST % ST % ST %

6-1.5.7.3 Mail Volume Factoring Error Report

The Mail Volume Factoring Error Report is produced daily for each office. It
reflects volumes entered into operation numbers for which no density flow has
been provided. These transactions credit volumes to the operation number
identified, but do not flow to downstream operations. Use the information on
the factoring error report as a guide to update mail flow densities that have
not been entered.

Diagnostics and Actions

Here is a list of messages generated by MODS on mail flow reports when
matrix entries are rejected or accepted. Each post office is required to take
the appropriate action to correct any error condition.

Add Transaction Rejected – Already in File

The system has rejected a subsequent matrix entry because a matrix for that
operation and SRF is already on file. The plant must verify the original matrix
entry to determine whether a subsequent matrix is a duplicate. The office can
either delete or replace the original matrix.

Delete Transaction Rejected – Not in File

The system has rejected a matrix entry because there was no matrix for that
operation and SRF on the file. The plant must determine which matrix it
attempted to delete and reenter it correctly.

Rev Transaction Rejected – Not in File

The system has rejected the matrix Not in File entry because there was no
matrix for that operation number and SRF on the file. The plant must
determine which matrix it attempted to replace and reenter it correctly.

Error—Density Percentage Does Not Equal 100%

The system has accepted the matrix entry; however, because the total
percentage for all "to'' operations does not equal 100%, no volume will be
flowed. The post office must reenter the transaction with densities in the "to''
operations that total 100%.
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Error—030 Matrix Missing

030 is a mandatory operation that requires a matrix for the SRF indicated.
The post office must submit a matrix for operation 030 for the SRF indicated
in the diagnostic. If the operation 030 is not used in that SRF, an 030 matrix
must still be submitted to satisfy the system requirements. A matrix flow to
operation 888 with a percentage of 99.99 can be used to satisfy this
requirement.

Error--150 Matrix Missing

150 is a mandatory LDC that requires a matrix for the SRF indicated.  The
office must submit a matrix for operation 150 for the SRF indicated in the
diagnostic.  If operation 150 is not used in that SRF, a 150 matrix must still be
submitted to satisfy the system requirements. A matrix flow to operation 888
with a percentage of 99.99 can be used to satisfy this matrix requirement.

Duplicate Operation Dropped

The system has read two identical operations in the "to'' fields. The first
operation number is dropped, and the second one is accepted. The diagnostic
will indicate the operation number and percentage dropped. The plant must
verify the matrix entry for that operation and SRF and make the necessary
correction.

ERROR—Mail flowed to shp operation 150, original 168, or 170. A required matrix entry for one
of more of these operations not in the file.
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The system has accepted the original matrix entry. However, SHP mail is
flowing to one or more of these operations, and there is no SHP matrix for
them. The post office must submit a matrix for one of these:

! 150 mail flow code 23
! 150 mail flow code 99
! 168 mail flow code 43
! 170 mail flow code 43

The plant must verify the matrix entry to determine whether an entry for 150,
168, or 170 was omitted.

Add Transaction Accepted—Above Data Added

The add matrix is accepted. No action is required.

Delete Transaction Accepted—Above Data Deleted

The delete matrix is accepted. No action is required.

Rev XXXXXXXXXXX Prior Data XXXXXXXXXX Revised Data

The replace matrix is accepted. The first line of data indicates the matrix
formerly in the system; the second line is the new matrix. No action is
required.

Matrix Analysis Correct

The matrix entry satisfies all the requirements for a valid matrix.  No action is
required.

777 Proportion Record Less Than 100%

Letter mail matrix entries are less than 100%. The system has summed all the
percentages for the branch codes and the box mail, and the total is less than
100%. The plant must verify the matrix entry and resubmit a matrix that
equals 100%.

778 Proportion Record Less Than 100%

Flat mail matrix entries are less than 100%. The system has summed all the
percentages for the branch codes and the box mail, and the total is less than
100%. The post office must verify the matrix entry and resubmit a matrix that
totals 100%.

777 Proportion Record Greater Than 100%

Letter mail matrix entries are greater than 100%. The system has summed all
the percentages for the branch codes and the box mail, and the total is
greater than 100%. The plant must verify the matrix entry and resubmit a
matrix that totals 100%.
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778 Proportion Record Greater Than 100%

Flat mail matrix entries are greater than 100%. The system has summed all
the percentages for the branch codes and the box mail, and the total is
greater than 100%. The plant must verify the matrix entry and resubmit a
matrix that totals 100%.

777/778 Proportion Record Greater Than 100%

Both letter and flat mail matrix entries are greater than 100%. The system has
summed all the percentages for the branch codes and the box mail, and the
total is greater than 100%. The plant must verify the matrix entry and resubmit
a matrix that totals 100%.

777/778 Proportion Record Less than 100%

Both letter and flat mail matrix entries are less than 100%.  The system has
summed all the percentages for the branch codes and the box mail, and the
total is greater than 100%. The plant must verify the matrix entry and resubmit
a matrix that totals 100%.

6-1.5.8 Operation Validity Table Listing
The Operation Validity Table Report is produced daily with transaction code
O1, or on request with a transaction code J9. The listing is produced when:

! an office changes the local oper validity tables
! national operation number validities are changed by the PDC
! an office enters a transaction code J9

The report is transmitted with the daily MODS reports. The validity table lists
all operation numbers. An "X" beside the oper number means the oper
number is invalid.

6-1.5.9 Originating Letters Summary Report
The Originating Letters Summary Report summarizes originating letter FHP
volume by source type—weekly and by AP. The report has three sections:
mail processing, customer services, and total office. This report does the
following:

! lists volume in thousands, rounded to the first decimal place
(hundreds)

! shows first total FHP volume by source type, then the percentage of
this volume against the total originating FHP and total originating
letters volume

! gives subtotals for machinable, non-machinable, preferential, and
bulk business presort letter volume

! gives totals for presort, originating volume, letter FHP, and total letter
volume

For the major headings of this report, see the next exhibit.
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WEEKLY ACTIVITY REPORT
  WEEK 4  AP 01  FY 1999      ORIGINATING LETTER SUMMARY

MAIL PROCESSING CUSTOMER SERVICES TOTAL OFFICE

S/T % TOTAL % TOTAL % TOTAL % TOTAL % TOTAL % TOTAL

CODE DESCRIPT. FHP ORIG FHP ORIG VOL FHP ORIG FHP ORIG VOL FHP ORIG FHP ORIG VOL

6-1.5.10 Mechanization Reports

6.1.5.10.1 Mechanization Transactions Report

The Mechanization Transaction Report lists all mechanization transactions
entered during the MODS day, including:

! scheme recycle rate (95)
! machine mishandling rate (96)
! machine run time (97)
! machine downtime (98)

These are the report column headings and descriptions:

Column Description
TR Transaction type
OPN Operation Number
MACH NR Machine identification number
MACH-OPN HOUR
PERCENT

Percentage of mishandling or recycle rate: or number of
workhours of run or downtime

DAY Day of pay period of transaction
TIME Transmission time of entry
AUTH—SSN Social security number of user who enter transaction
BR Separate reporting facility code
ADJU Adjustment code

6-1.5.10.2 Mechanization Performance Utilization Report

MODS produces a separate report for each automated and mechanized
scheme for volume reported daily, weekly, and each AP to the operation level.
The report lists operation numbers in ascending order for the following:
CANCELLERS, ML-OCR, SL-OCR, OCR AS BCS, MP-BCS, DBCS, FSM-
BCS, AFSM-BCS, MPLSM, SPLSM, LSM AS BCS, AFSM, PARCEL
SORTER, SPBS, ACDCS SHRINK MACH, AND BCS-ABC.

For the major headings, see the next exhibit.
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MECHANIZATION REPORT
PERFORMANCE EVALUATION – WEEKLY

AP 01 WEEK 2 FY 2000  OPERATION 141 DATE 09/15/1999 PAGE 2

SAT SUN MON TUES WED THURS FRI TOTAL

A separate page of the report summarizes data for letters and for flats.

Report Structure:

The columns of the daily reports show the individual schemes by operation
number, equipment summaries, and mail category summaries. The weekly
report columns indicate the 7 weekdays and the weekly total; the AP report
columns indicate the 4 weeks and the AP total.

Unique Calculations:

Because the office calculates and enters recycling and mishandling rates for
daily application, these values must be recalculated both weekly and each
AP. The computer does the following:

! adds all of the pieces fed for the week or the AP, the pieces
recycled, and the pieces mishandled

! divides the total pieces fed into the total pieces recycled or the total
pieces mishandled

! multiplies that result by 100 for the resulting weekly and AP recycle
or mishandled rate

Line Item Descriptions—Mechanization Performance Evaluation Report

Line Item Description
1 PIECES FED From transaction code 75 in thousands, to first decimal place
2 RECYCL RATE (Scheme Recycle Rate) Percentage recycled to same OPN from

DQ Test (input with transaction code 95)
3 PCS RECYCLD Result of recycle rate (line 2) times pieces fed (line 1)
4 PCS NOT DST Total of the following:

S/T 27 - Total Source/Type Code 27 Transactions
S/T 39 - Total Source/Type Code 39 transactions
S/T 40 - Total Source/Type Code 40 Transactions
S/T 50 - Total Source/Type Code 50 transactions

5 TPH Pieces fed (line 1) less PCS NOT DST (line 4)
6 GROSS AC RT TPH (line 5) divided by PIECES FED (line 1) =  (Gross Acceptance

Rate) times 100
7 %FHP OPN FHP divided by the total FHP (letter, flat, or parcel)
8 % TPH OPN TPH divided by the total TPH (letter, flat, or parcel)
9 MSHLG RATE Percentage of mishandling rate from DQ Test input with transaction

code 96
10 PCS MSHLD

Pieces Mishandled
Pieces fed (line 1) times MSHLG RATE (line 9)
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11 PCS CR HLD
Pieces correctly
handled

PIECES FED (line 1) minus PCS MSHLD (line 10)

12 NO OF MACHS
Number of machines

Number of unique machine IDs for which 95 through 98
transactions are entered each day.  Week = total number of unique
IDs reported during the week.  AP = sum of the four weekly totals.

13 FED/MACH PIECES FED (line 1) divided by the NO OF MACHS (line 12)
14 MACH RUNTIM Runtime input with a transaction code 97
15 RUNTIM/MACH MACH RUNTIME (line 14) divided by the NO OF MACHS (line 12)
16 MACH DWNTME Downtime input with a transaction code 98
17 RUN + DWNTME (Run Time Plus Downtime) The sum of MACH RUNTIM (line 14)

and MACH DWNTIME (line 16)
18 PCT DWNTME MACH DWNTME (line 16) divided by MACH RUNTME  +  MACH

DWNTME (line 17) times 100
19 TOT WKHRS Workhours from the mail processing operating report
20 FED/MACH HR FED/MACH HR(Pieces Fed per Machine Hour) PIECES FED (line

1) divided by RUN+DNTME (line 17)
21 PCT CR HLD PCS CR HLD (line 11) divided by PIECES FED (line 1) times 100
22 TPH/WKHR TPH (line 5) divided by TOT WKHRS (line 19) times 1000
23 STAFF INDEX TOT WKHRS (line 19) divided by the RUN + DWNTME (line 17)

6-1.5.10.3 Mechanization Scheme Analysis Report

The Mechanization Scheme Analysis Report is produced for each region
daily, weekly, and by AP. Separate reports are produced for each scheme.
Source data is extracted from the post office MODS performance evaluation
reports and the MODS mail processing operating report.  Each office and the
area summary are listed as line items. For the columns of the report, see the
next exhibit.

Line Item Descriptions—Mechanization Scheme Analysis Report

Line Item Description
1 PCS FED (Pieces Fed) Total pieces fed in thousands, to first decimal place
2 TPH (Total Pieces Handled) PIECES FED (line 1)  less PCS NOT DST (line 4)
3 GROSS AC (Gross Acceptance

Rate)
TPH (line 2) divided by PCS FED (line 1) times 100

4 PCT FHP (Percent of FHP) OPN FHP divided by the total FHP (letter, flat, or parcel)
5 PCT TPH (Percent of TPH) OPN TPH divided by the total TPH (letter, flat, or parcel)
6 NUM MACH Number of unique machine IDs reported
7 RUN/MACH RUNTIME divided by NUM MACH
8 PCT DWN MACH DWNTME divided by (MACH RUNTME + MACH

DWNTME) times 100
9 FED/MACH PIECES FED divided by NO OF MACHS
10 FED/MACH HR (Pieces Fed per

Machine Hour)
PIECES FED divided by RUN + DNTME (RUNTIME
PLUS DOWNTIME)

11 PCT CORHD (Percent Correctly
Handled)

PCS CR HLD divided by PIECES FED times 100
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12 TPH/WKHR (Total Pieces
Handled per Workhour)

TPH divided by total workhours times 1000

13 STAFF IND (STAFF INDEX) TOT WKHRS divided by the RUN +   DNTME (runtime
plus downtime)

6-1.5.10.4 Number of Machines Report

The Number of Machines Report is a daily report generated whenever the
PSDS office updates the number of automated or mechanized pieces of
equipment in the office. The AP Number of Machines Report summarizes
pieces of equipment by operation number in the site.  For the major columns
of this report, see the next exhibit.

6-1.5.11 Trend Reports

6.1.5.11.1 Volume/Hours Comparison Report

For each mail processing operation number that reports volume, the
Volume/Hours Comparison Report shows FHP, TPH, HOURS, FHP/HR, and
TPH/HR:

! by day
! the total for each week
! the total for each AP

For the major column headings of this report, see the next exhibit.

MODS VOLUME – HOURS COMPARI
DAILY WEEK 4 AP 07

OPN-LU SAT SUN MON TUES WED THURS FRI TOTAL

6-1.5.11.2 Trend Analysis Report

The Trend Analysis Report lists volumes (FHP and TPH), workhours, and
productivity (FHP/HR and TPH/ HR) in mail processing operations that report
volume, for the most recent 14 APs. The report is generated each AP for each
of the separate facilities reporting to the plant. For the major column headings
of this report, see the next exhibit.

MODS VOLUME – HOURS COMPARI
DAILY WEEK 4 AP 07

AP AP AP AP AP AP AP AP AP AP AP AP AP AP

OPN-LU 1 2 3 4 5 6 7 8 9 10 11 12 13 AVERAGE SPLY
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6-1.5.12 Mail Processing Activity Report
The Mail Processing Activity Report is produced weekly by request (A9) for all
separate reporting facilities. There is no office consolidation of this report.
The report contains the following information for each volume recording
operation:

! FHP volume inputs, by operation number, in ascending source/type
code sequence

! mail flows to an operation from other operations, in ascending
operation numbers

! mail flows to other operation numbers, in ascending operation
numbers

! workhours, by operation number
! overtime, by operation number
! total volume by operation number
! productivity by operation number
! year-to-date, FHP, SHP, TPH, and workhours, by operation number

6-1.5.13 Volume Inquiry Report
The Volume Inquiry Report lists all volume transactions entered from the start
of the MODS day to the time of request. The report will be produced
approximately fifteen minutes after the request. It can be produced for a
device (scale or transactor) or a specific operation number.

Requesting the Report:

To request the report, use transaction code 94 (see 4xx). The following edits
are made in transaction code 94:

No Volume Transaction for This Request.

Volume not entered into operation number or device up to time of request.

No Volume Illegal Request.

Wrong DPP used.

Excessive Inquiry Report.

Special online report listing those requests exceeding 20 inquiries during a
15-minute update.

Note:  The use of transaction code 94 is to be controlled through the data
collection site.
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6-1.5.14 MODS Hour Inquiry
The MODS Hour Inquiry Report lists all employee social security numbers for
the requested operation numbers by MODS day. You can request this data up
to 7 previous MODS days from the current MODS day. If multiple requests
are made for the same MODS day, a consolidated report listing operation
numbers in ascending order is generated for the requesting office. The report
will be produced approximately 15 minutes after the request. Six requests can
be entered within a 15-minute period with only one exclusion, the requestor is
restricted to one request when he/she enters XX for SRF and XXXXXX for an
operation number in this period.

Requesting the report:

To request the report, use transaction code (see 4xx). The following edit is
made in transaction code PA and appears on the next 15-minute update:

"No Record Found.  There are no workhours charged for the requested LDC."

6-2 Retaining Reports
Retention periods are optional unless otherwise specified or required by
responsible officials.

Processing and Distribution Centers and Facilities (PSDS and PCMODS
Offices) retain reports for the following periods:

Report Retention
MODS Management Summary
Daily, Weekly until the end of the current AP, if all adjustments

are completed
AP 14 APs
SRF Hour Summary
Daily, Weekly until the end of the current AP, if all adjustments

are completed
AP 14 APs
MODS Operating Reports
Daily, Weekly until the end of the current AP, if all adjustments

are completed
AP 14 APs
MODS Volume Adjustments 1 Year
MODS Workhour Transfer 1 Year
MODS Error Signal Report 1 AP
Mechanization Transactions 1 AP
Mechanization Performance Evaluation 1 AP
MODS Volume/Hours Comparison 6 AP
Trend Analysis Report 1 AP
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6-3 Separate Reporting Facilities (SRFs)

6-3.1 Designation
The plant manager of a separate mail processing facility (SRF), such as a
parcel post annex or an airport mail facility, may receive separate MODS
reports with the approval of Headquarters, Processing Operations. The plant
manager must submit written requests for changes to the Manager,
Processing Operations. The maximum number of SRFs is 39.

6-3.2 Adding and Deleting SRFs
Effective dates:

To add or delete an SRF, submit requests no later than one full AP before the
effective implementation date so the files can be updated to reflect year-to-
date data.  Additions or deletions are effective on day 01 of the AP in which
the change is implemented.

Required Information

Include this information in your request:
! Processing and Distribution Center (Facility) name
! SRF name (2-16 alphanumeric characters, including spaces)
! SRF number (00 through 39)
! number of the SRF where the data for the deleted SRF will be

consolidated (only if deleting an SRF)
! effective date of change

If an SRF is deleted, renumber the remaining SRFs in ascending order. No
gap in the SRF numbering convention is allowed. (Example: If an office with
SRFs 01 through 06 deletes number 04, SRF 05 and 06 must be re-
numbered so no gap occurs.)

6-3.3 Site Preparation
The local office is responsible for updating machine identification numbers for
all devices (EBR, Transactor, Scale Workstation) in the lower network
affected by the addition or deletion of SRFs. Additions or deletions must be
implemented on day 01 of the AP period in which the change is effective.  All
updates to devices are done through the DSMO console.

6-3.4 Machine Number Ranges for SRFs
The next exhibit lists the allowable machine identification numbers by SRF
codes. The machine type determines the first position of the machine
identification number.
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Machine Identification Number by SRF Code

SRF Machine SRF Machine
Code ID No. Code ID No.

00 X001-X275 20 X801-X810
01 X276-X385 21 X811-X820
02 X386-X435 22 X821-X830
03 X436-X485 23 X831-X840
04 X486-X620 24 X841-X850
05 X621-X630 25 X851-X860
06 X631-X640 26 X861-X870
07 X641-X660 27 X871-X880
08 X661-X670 28 X881-X890
09 X671-X680 29 X891-X900
10 X681-X690 30 X901-X910
11 X691-X700 31 X911-X920
12 X701-X710 32 X921-X930
13 X711-X720 33 X931-X940
14 X721-X730 34 X941-X950
15 X731-X740 35 X951-X960
16 X741-X750 36 X961-X970
17 X751-X780 37 X971-X980
18 X781-X790 38 X981-X990
19 X791-X800 39 X991-X999

Machine Type
1  Transactor          3  Scale Workstation     5  Alphanumeric Device
6  Employee Badge Reader

6-4 Corporate Data Base
Corporate Information System - Corporate Data Base (CDB) is an on-line
source for the statistical files of postal financial and operating systems. You
can use this system to answer questions designed by the user (called AD
HOC QUERIES - using FOCUS) or in pre-programmed statistical reports
(called CANNED REPORTS) that analyze Postal Service performance.

The Corporate Data Base is located in the National Information Systems
Support Center (NISSC) Raleigh, NC. For access to CBD, you must first
submit a PS Form 1357, User's Request for Computer ID, through
Minneapolis ISSC.
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6-4.1 MODS Data
The Wilkes-Barre ISSC forwards weekly and AP data to the Corporate Data
Base—Sunday MODS days 09, 16, 26, and 02. The data has a 3-year
retention period. Here is the list of volume and workhours data transmitted:

! FHP, by LDC
! TPH and Workload unit, by operation number
! PIECES FED for automation and mechanization operation number
! workhours for all operation numbers and LDCs by function
! overtime, by operation number
! machine runtime and downtime, by operation number
! number of machine, by operation number
! FIM A through C totals

6-4.2 Year-to-Date Adjustments
Any year-to-date volume or workhour (transaction code A1s & A4s)
adjustments are excluded from data forwarded to the MODS CDB. Any
correction to the MODS CDB for YTD adjustments must be submitted in
writing by the requesting offices to the Area office.
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7 MODS Audits

7-1 Objectives
Each MODS office must conduct a MODS System review at least once each
year. The review covers all phases and requirements of the MODS System
and helps to determine the accuracy of MODS reporting procedures.  All
review team members must be familiar with MODS, and the team leader must
have a good working knowledge of the system.  Ideally, team members will be
from another facility.  Each office may perform a self-review periodically to
ensure that everyone is using proper procedures and collecting accurate
information.

7-2 Review Requirements
The review lasts at least one week, from MOD tour 2, Saturday, through MOD
tour 1, Friday.  On each tour the team must observe the scales and
verification process at least part time and for at least four days. The team also
must observe operations and make Time and Attendance checks for at least
three days.

The review team leader gives the plant manager a report identifying all
deficiencies and requesting corrective action.  Except when indicated, the
review team performs the procedures described in this chapter.

7-3 Review Procedures

7-3.1 Ensure Proper Condition of all Volume Recording
Equipment

During the week before the review, the team leader must ensure that floor
scales are calibrated to zero. Verify that all equipment is maintained and
repaired in a timely manner.

7-3.2 Spot-check Tare Weights
To verify that the tare weight is clearly and conspicuously marked on all rolling
stock equipment for transporting mail to distribution operations, spot-check
the tare weights of mail transport equipment.
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7-3.3 Analyze and Verify Accuracy of Reports
Verify that MOD System reports are retained as required.

7-3.4 Productivity Reports
To analyze productivity, use the Mail Processing Operating Report. Compare
productivity for the review period (day, week, or AP) with productivity for
similar prior periods.

7-3.5 Trend Analysis Report
To observe productivity trends, use the Volume/Hours Comparison Report
and the Trend Analysis Report. Identify operations that show a significant
change in productivity and do not show probable causes for the change.

7-3.6 Mail Volume Adjustment Report
For PSDS offices, the Plant Manager (or designee) must review the Mail
Volume Adjustment Report, which lists volume transactions and adjustments.

! Determine the justification of volume adjustments (TR A-1).
! Verify documentation for all transactor volume entries, using either

Form 1476D MOD Worksheet for Mail Volume Adjustments or locally
designed volume forms.

! Verify the accuracy of transactor inputs (TR7) of volumes that are
normally weighed—mail from preparation and opening units—and
identify the reason for transactor entry.

7-3.7 MODS Daily Detail Listing
To verify that volume was recorded correctly (particularly withdrawal
transactions), use the Daily Detail Listing Report provided each day by the
PSDS Data Collection Site. This report lists all volume entries from scales and
transactors.

! Verify that all volume withdrawn from an operation to another
operation is entered in this report.

! To correct duplicate volume transactions, verify the use of a TR A-1
entry.

7-3.8 Verify the Entry of Planned Hours
Verify that planned hours have been entered by labor distribution code (TR A-
6) by week in each accounting period since the last review.

7-3.9 Ensure Proper Inventory Procedures
Ensure that inventory procedures are observed and verify the following:

! that volumes and mail types are stated correctly with inventoried mail
at the end of each MOD day—or at the end of each tour if the office
is tour reporting



142

! that type and origin correctly identify the inventoried volumes for
each distribution operation with mail volume on hand

! that first and subsequent handling pieces, preferential and standard
volumes, and machinable and nonmachinable mail volumes are
inventoried separately

7-3.10 Verify Proper Volume Reporting Procedures
Verify that employees observe all volume recording procedures. These are
the requirements for the review team:

! Monitor scale transaction at the floor scales for proper recording
procedures. The mail processing employee identifies the originating
and designating operation numbers, mail type, source type,
containers, transport equipment, and tare weight. Preferential,
Standard, and machinable and nonmachinable letters and flats are
weighed separately.

! Verify that the mail processing employee identifies the correct source
type.

! Verify that all volumes are recorded into distribution operations.
! Verify that all operation numbers used for activities in the office

conform to the operation number definitions in Appendix A.
! Verify that workload units are entered for all work credit operations

used by the office. Also, verify that data collection, conversion factors
and workload unit recording procedures meet all requirements.

! Verify that letter, flat, priority, and parcel post volumes are identified
and entered by source type code as required.

7-3.11 Verify Proper Procedures for Generating Mail Flow
Density Matrix

The Mail Flow Density Matrix Report reflects all the mail flow densities
entered for the office. The report is produced at the beginning of each
accounting period. The plant manager (or designee) must approve the mail
flow matrix every six months or whenever there is a significant change in mail
flow pattern. Mail flow densities must be updated every six months.

Verify the following:
! that the methods for generating the densities for all operations are

based on sound statistical sampling or actual mail counts
! that all required densities have been entered for all operations used

by the office
! that proportions of mail by station have been obtained
! that carrier mail has been entered by station and total station box to

establish the 777/778-proportion file

7-3.12 Verify Correct Workhour Reporting Procedures
Determine whether employees are clocked into the operation in which they
are working. To identify employees clocked into an operation, use either
PSDS or ETC/TACS.
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If it is not possible to resolve differences between employee, badge card, and
inquiry listings, use employee inquiries to check the employee clock rings in
question.

7-3.13 Operations
Verify that hours for automation and mechanization operations are being
recorded properly. Ensure that employees are charged to the correct
operation, especially when additional temporary help is being used for
dispatches or for final closeout.  All allied labor hours must be charged to the
correct manual, mechanization, or automation distribution operation.

7-3.14 Adjustments
Verify that adjustments are properly made.

7-3.15 Unassigned or Invalid Operation Numbers
Verify that adjustments are made to transfer all MODS hours that have
accumulated in operation 999 for unassigned or invalid operation numbers.

7-3.16 Workhours Transfer Report
The workhours transfer report is a list of all TR A-4 entries. The plant
manager (or designee) must approve hours that have been transferred. Use
workhour transfer entries sparingly—never to control productivity or instead of
normal employee clock rings.

7-3.17 Overtime
Verify that overtime hours are accumulated so that total MODS overtime
hours can be reconciled with paid overtime hours within a tolerance of 5% per
pay period. To enter overtime resulting from TR 6 entries or forced by the
Time and Attendance System, use the overtime adjustment transaction TR7-
9.

7-3.18 Verify Proper Mechanization Automation
Verify the following:

! that a scheme recycle rate and machine mishandling rate have been
entered for each mechanization and automation operation used in
the office (These rates must agree with the most recent distribution
quality tests conducted by the Quality Control Office.)

! that at least one runtime transaction and one downtime transaction
have been entered for each machine the office used on any day in
which total piece handling is reported

! that unique machine identification numbers are assigned to
equipment in each group as required
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7-3.19 Review Report
The review team leader must submit a report to the plant manager no later
than one week after completing the review. The report must identify:

! all findings
! the cause of each discrepancy
! recommended corrective action

7-3.20 Corrective Action
Initiate corrective action promptly.  Conduct follow-up monitoring to ensure
that actions to correct all discrepancies are implemented. The plant manager
is responsible for ensuring that timely corrections are made.
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8 PCMODS, Version 3.1: for MODS 2
Offices

8-1 Overview
The Postal Service uses PCMODS (Personal Computer Management
Operating Data System) to collect, process, and transmit data on work hours
and mail volume. This information enables local and national postal
management personnel to maintain and assess productivity. PCMODS
imports data from other USPS information systems:

! Work hour data is imported from the Electronic Time Clock (ETC)
system.

! Volume data is imported from the End-of-Run (EOR) and Scales
systems.

To meet weekly national reporting requirements, PCMODS transmits data
directly to the Corporate Data Base (CDB).

Figure 8-1 shows how PCMODS interfaces with other USPS information
systems.



146



147

PCMODS generates four kinds of reports to help postal managers:
! plan and estimate mail volumes
! plan and estimate work hours
! monitor processing performance
! monitor equipment usage

PCMODS generates four reports:
! Management Summary Report
! Operating Report
! Mail Processing Recap
! Auto/Mech Report

All of the reports can be generated daily, weekly, and by Accounting Period
(AP). All except the Management Summary can also be year to date (YTD).

PCMODS also provides a Graphical Reporting function that enables local
Postal personnel to create custom graphs and grids to display information.

At each site, the Postmaster/installation head ensures that the site:
! enters the required data into PCMODS
! transmits that data to the Corporate Data Base (CDB) each week
! installs new software releases for PCMODS according to the

instructions in the release notes

Failure to install each release could prevent a site from sending data to the
CDB and/or making prior period adjustments to PCMODS data. Currently, the
CDB performs the final update on Monday at 16:00 Central Time, except
when Monday is a holiday.

8-2 Finance Numbers, SRFs, Operations, Local Units,
and Tour Data

This section shows you how to work with Finance Numbers, Separate
Reporting Facilities (SRFs), Operations, Local Units, and Tour Data to do
these tasks:

! adding
! deleting
! editing

Finance Numbers are linked to Separate Reporting Facilities, Operations, and
Local Units, if applicable.

! If your site does not use Local Units, specify Local Unit 00.
! If your site does not use SRFs, specify SRF 00.
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8-2.1 Adding a Finance Number, SRF, Operation, or Local Unit
Adding a Finance Number activates SRFs, Operations, and Local Units for
that Finance Number. To add a Finance Number, SRF, Operation, or Local
Unit, follow these steps:

>> From the PCMODS Main Menu, select Config>Finance
Numbers/SRFs/Operations.

You see the Finance Numbers/SRFs/Operations window.

            

Figure 8-2.  Finance Numbers/SRFs/Operations Window

The values that appear in the Finance Number and SRFs boxes have already
been entered into PCMODS.

To add a Finance Number,

>> Under the Finance Numbers box, click Add.

You see the Finance Number Data window.
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Figure 8-3.  Finance Number Data Window

On the Finance Number Data Window, follow these steps:

1. In the Finance Number Field, type a 6-digit (only) Finance Number.

2. In the Name field, type the name of your facility.

3. Select the option bullets that apply to your facility and click OK.

The system shows you the Finance Numbers/SRFs/Operations window and
highlights the Finance Number you just added. An arrow points to the SRFs
box.

To add SRF data,

>> Under the SRFs box, click Add.

You see the Select SRF to Add window.
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Figure 8-4.  Select SRF to Add Window

On the Select SRF to Add Window,

>> Click one number.

You see the Separate Reporting Facility Data window.

                
Figure 8-5.  Separate Reporting Facility Data Window
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On the Separate Reporting Facility Data Window,

>> Enter the Separate Reporting Facility name and click OK.

The system shows you the Finance Numbers/SRFs/Operations window and
highlights the SRF you just added. An arrow points to the Operations box.

To select an operation, follow these steps:

1. Type the Operation Number or click on the Operations drop-down list
box.

2. Highlight the operation you want to add.

After you select the Operation Number, the system highlights the Operation
you just added. An arrow points to the Local Units box.

To select a Local Unit for this Finance Number,

>> Under the Local Units box, click Add.

You see the Select LU to Add window.

                           
Figure 8-6.  Select LU to Add Window
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On the Select LU to Add window,

>> Click on one number.

You see the Local Unit Data window.

                         

Figure 8-7.  Local Unit Data Window

On the Local Unit Data window, you see the name of the operation and the
Tour Validity for that operation. If the Finance Number does not perform Tour
reporting, these boxes are disabled (shown in gray).

Verify that these are correct:
! If they are correct, click OK.
! If they are not correct, enter the correct information and then click

OK.

8-2.2 Editing a Finance Number, SRF, Local Unit, or Tour Data
To edit a Finance Number, SRF, Local Unit, or tour data, follow these steps:

>> Under the box with the data you want to change, click Edit.

The system shows you the appropriate Data window.

>> Change the data and click OK.

8-2.3 Deleting a Finance Number, SRF, Local Unit, or Tour Data
To delete Finance Number, SRF, Local Unit, or tour data:

>> Under the box with the data you want to delete, click Del.

You see a message about what will happen if you delete the data.
! If you do not want to delete this data, click No.
! If you want to delete this data, click Yes.
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8-3 Flow and Flow Percentage
If your site flows manual operations, follow these steps to set up your flow
percentages:

>> From the PCMODS Main Menu, select Config>Flow.

You see the Flow Setup window.

Figure 8-8.  Flow Window Setup

On the Flow Setup Window, follow these steps:

1. Highlight the Finance Number.

2. Select from SRF, Operation, and Local Unit.

3. Select the To SRF and Operation. (The From and To operations you
select must be valid flows in the Flow Validity Table.)

4. Click Add.
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When you see a list of Local Units on the window,

>> Select one.

You see the Enter Flow Percentage window.

Figure 8-9.   Enter Flow Percentage Window

On the Enter Flow Percentage Window, follow these steps:

1. Type a percentage that does not exceed 100 in the Enter
Percentage field and click OK. (The total percentage of flows for an
operation must not exceed 100%. The table shows the flows that you
have defined so far.)

2. To copy the data, save it, or export it to Excel, click the appropriate
button:

! Copy: 

! Save: 

! Export to Excel: 

3. To continue adding flows, repeat these steps.

4. To delete flows, you see the Confirm Flow Deletion window.
! To delete the flow, click Yes.
! If you do not want to delete the flow, click No.
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8-4 Entering Data

8-4.1 Entering Workhour Data
Workhour data applies to a Finance Number, SRF, Operation Number, local
unit, and if applicable, Tour. Sites with Finance Numbers that do not perform
Tour reporting select the Finance Number, SRF, operation, and local unit.
Table 4-1 describes the Work Hour data fields that you need to complete.

Work Hour Data Entry Field Descriptions

Field Description Range Notes
Operation
Number

Any 3-digit number 001 to
999

Local Unit Any 2-digit number 00 to 99
Hours Any number up to 5

digits
0 to
99999

Enter hours, OT
hours, or both.

OT Hours Any number up to 5
digits

0 to
99999

Enter hours, OT
hours, or both.

To enter Work Hour data into PCMODS, follow these steps:

>>  From the PCMODS menu bar, select Data>Entry>Work Hour.

You see the Select Date window.

Figure 8-10.  Select Date Window
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On the Select Date Window,

>> Select the MOD day date.

The date that is highlighted is the previous MOD day. If you select a different
date, the FY, AP, Week, and Day information on the right-hand side of the
window will change to reflect the date you choose.

You see the Work Hour Entry window and the MOD day you selected.

Figure 8-11.  Work Hour Entry Window

On the Work Hour Entry Window, follow these steps:

1. Select a Finance Number, SRF, and if applicable, Tour.
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2. Enter the Operation Number.

Figure 8-12 . Craft LDC on Work Hour Entry Window

3. Enter the Local Unit.

4. Enter the hours or overtime (OT) hours or both.

To enter the data in the PCMODS database,

>> Click Process.

You see the data you entered in the spreadsheet at the bottom of the window.
The spreadsheet shows the following information:

To copy the data, save it, or export it to Excel,

>> Click the appropriate button:

! Copy: 

! Save: 

! Export to Excel: 

To exit the screen and clear all data from the window,

>> Click Close.

8-4.2 Entering Cancellation Data
Cancellation data applies to a Finance Number, SRF, Operation Number,
Local Unit, and if applicable, Tour. Sites with Finance Numbers that do not
perform Tour reporting select the Finance Number, SRF, operation number,
and local unit. The next exhibit describes the Cancellation data fields that you
need to complete.
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Cancellation Data Entry Field Descriptions
Field Description Range Notes
Operation
Number

Any 3-digit number 001 to 999 Must be cancellation
operation

Local Unit Any 2-digit number 00 to 99
Cancellation
Count

Any number up to 7
digits

0 to
9999999

The procedures for cancellation Operation 015 are different from the
procedures for other cancellation operations. The next sections provide step-
by-step procedures for each type of cancellation count entry.

8-4.2.1 Entering Data for Cancellation Operations Other Than 015
To enter Cancellation data for Operation Numbers other than 015, follow
these steps:

>> From the PCMODS menu bar, select 
Data>Entry>Cancellation.

You see the Select Date window.

>> Select the MOD day date.

You see the Cancellation Entry window and the MOD day you selected.

Figure 8-13. Cancellation Entry Window

On the Cancellation Entry Window, follow these steps:

1. Select a Finance Number, SRF, and if applicable, Tour.
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2. In the Oper field, type the operation number.

3. In the LU field, type the local unit.

4. In the Cancellation Count field, type the number of pieces canceled.

5. To enter the data in the PCMODS database, click Process.

You see the data you entered in the spreadsheet at the bottom of the window.

6. To enter the data in the PCMODS database, click Process.

7. To copy the data, save it, or export it to Excel, click the appropriate
button:
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! Copy: 

! Save: 

! Export to Excel: 

8. To exit the screen and clear all data from the window, click Close.

8-4.2.2 Manually Entering Data for Cancellation Operation 015
If End of Run fails to report operation 015 cancellation volume, use this
option. To enter cancellation data for Operation 015, follow these steps:

>> From the PCMODS menu bar, select Data>Entry>Cancellation.

You see the Select Date window. On this window,

>> Select the MOD day date.

You see the Cancellation Entry window and the MOD day you selected.

Figure 8-14.  Operation 015 Cancellation Entry Window

On the Operation 015 Cancellation Entry Window, follow these steps:

1. Select a Finance Number, SRF, and if applicable, Tour.

2. In the Oper field, type 015.

3.  In the LU field, type the local unit.

4. In the Cancellation Count field, type the number of pieces canceled.
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5. Type the Images Lifted and Images Not Lifted data in the appropriate
fields.

6. To enter the data in the PCMODS database, click Process.

You see the data you entered in the spreadsheet at the bottom of the window.
To copy the data, save it, or export it to Excel, click the appropriate button:

! Copy: 

! Save: 

! Export to Excel: 

7. To exit the screen and clear all data from the window, click Close..

8-4.3 Entering Machine Runtime/Downtime Data
Runtime/Downtime data applies to a Finance Number, SRF, Operation
Number, Local Unit, and if applicable, Tour. Sites with Finance Numbers that
do not report Tours select only the Finance Number and SRF. Table 8-3
describes the Runtime/Downtime data fields that you need to complete.
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Table 8-3.  Runtime/Downtime Data Entry Field Descriptions
Field Description Range Notes
Operation
Number

Any 3-digit number 001 to
999

Must be automated or
mechanized operation

Local Unit Any 2-digit number 00 to 99
Runtime Any number up to 5

digits
Enter runtime,
downtime, or both.

Downtime Any number up to 5
digits

Enter runtime,
downtime, or both.

Machine
Number

Any number up to 2
digits

Required field.

To enter Machine Runtime/Downtime data, follow these steps:

>> From the PCMODS menu bar, select
Data>Entry>Runtime/Downtime.

You see the Select Date window. On this window,

>> Select the MOD day date.

You see the Runtime/Downtime Entry window and the MOD day you
selected.

Figure 8-15.   Runtime/Downtime Entry Window
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On the Runtime/Downtime Entry window, follow these steps:

1. Select a Finance Number, SRF, and if applicable, Tour.

2. Enter the Operation Number and Local Unit.

3. Enter the Runtime and/or Downtime for a particular machine.

4. Enter the Machine number that corresponds to the runtime/downtime
data.

5. To enter the data in the PCMODS database, click Process.

You see the data you entered in the spreadsheet at the bottom of the window.

6. To copy the data, save it, or export it to Excel, click the appropriate
button:

! Copy: 

! Save: 

! Export to Excel: 

7. To exit the screen and clear all data from the window, click Close.

8-4.4 Entering Volume Data
Volume data applies to a Finance Number, SRF, Operation Number, Local
Unit, and if applicable, Tour. Sites with Finance Numbers that do not perform
Tour reporting should select only the Finance Number and SRF. Table 8-4
describes the Volume data fields that you need to complete.

Table 8-4  Volume Data Entry Field Descriptions
Field Description Range Notes
Operation
Number

Any 3-digit number 001 to
999

Must be an operation
that allows volume
input.

Local Unit Any 2-digit number 00 to 99

To enter volume data, follow these steps:

1. From the PCMODS menu bar, select Data>Entry>Volume.

You see the Select Date window.

2. Select the MOD day date.
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You see the Volume Entry window and the MOD day you selected.

Figure 8-16.  Volume Entry Window

On the Volume Entry Window, follow these steps:

3. Select a Finance Number, SRF, and if applicable, Tour.

4. Enter the Operation Number and the Local Unit.

5. You have the option of selecting the turnover feature.

6. Select the volume of measurement by clicking the appropriate option
button.

7. Click Next.
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If you select pieces for the Volume Measurement, you see the Volume Data
Entry window. Proceed to step 10.

If you select pounds or feet, you see the Select Source Type window for the
type of mail represented by the Operation Number.

Figure 8-17. Sample Select Source Type Window

8. On the Select Source Type window, select one type by clicking the
appropriate option button.

9. To move to the Volume Data Entry window, click Next.
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Figure 8-18.   Volume Data Entry Window

10. On the Volume Data Entry window, enter volume data (either a
positive or negative number) in the appropriate fields and click
Process to update the database.
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! You see the Volume Entry window and the data you entered in
the spreadsheet at the bottom of the window.

8-5 Viewing and Adjusting PCMODS Data
The View and Adjust Data window has a notebook format with separate
folders for:

! Work Hours
! FHP/TPH/TPF/SHP
! Auto/Mech
! Encode
! Advanced Facer/Canceller System (AFCS)

The availability of these folders depends on the Operation Number you enter.

Example:  Operation Number 015 makes all folders available except Encode,
and Operation Number 881 makes all folders available except AFCS.

To view and adjust data, follow these steps:

>> From the PCMODS menu bar, select Data>View and Adjust.

You see the View and Adjust Data window.

Figure 8-19.  View and Adjust Data Window
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On the View and Adjust Data Window,

>> Select the Finance Number, SRF, Operation Number, Local Unit,
and if applicable, Tour.

The View and Adjust Data Window shows you five separate folder tabs. If you
want to just view the data, click the appropriate folder tab. The following
subsections give step-by-step procedures for adjusting the data in each of
these folders.

To adjust Work Hours data:

1. Click the Work Hours folder tab.

Figure 8-20. View and Adjust Data (Work Hours) Window

2. Move the cursor to the field after the kind of hours you want to
change (for example, CRAFT Regular).

3. Type the value you want to add or subtract from the value in the
Current Total column and press the Enter key.

4. Continue to adjust data as needed.

To adjust FHP/TPH/TPF/SHP data:

1. Click the FHP/TPH/TPF/SHP folder tab.
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Figure 8-21. View and Adjust Data (FHP/TPH/TPF/SHP) Window

2. Move the cursor to the field after the kind of data you want to change
(for example, TPH).

3. Type the value you want to add or subtract from the value in the
Current Total column and press the Enter key.

4. Continue to adjust data as needed.

To adjust Machine Runtime/Downtime data:

1. Click the Auto/Mech folder tab.
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Figure 8-22.  View and Adjust Data (Auto/Mech) Window

2. Move the cursor to the field after the kind of data you want to change
(for example, Runtime).

3. Type the value you want to add or subtract from the value in the
Current Total column and press the Enter key.

4. Continue to adjust data as needed.

To adjust encoded data:

1. Click the Encode folder tab.
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Figure 8-23.  View and Adjust Data (Encode) Window

2. Move the cursor to the field after the kind of data you want to change
(for example, Bc-'A').

3. Type the value you want to add or subtract from the value in the
Current Total column and press the Enter key.

4. Continue to adjust data as needed.

To adjust AFCS data:

1. Click the AFCS folder tab.
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Figure 8-24.  View and Adjust Data (AFCS) Window

2. Move the cursor to the field after the label for the kind of data you
want to change (for example, CAT-A or OCR).

3. Type the value you want to add or subtract from the value in the
Current Total column and press the Enter key.

4. Continue to adjust data as needed.

5. When you have finished entering your adjustments to data, click
Process to update the database. If you do not want to update the
database, click Close to erase your entries.

8-6 Using PCMODS Data Load
To access PCMODS data load, follow these steps:

1. Start PCMODS.

2. From the PCMODS main menu, complete one of the following steps:
! Select File>Load External Data.

OR
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! Click the Load External Data icon. 

You see the PCMODS Data Load window.

Figure 8-25. PCMODS Data Load Window

You use the PCMODS Data Load window to load EOR, ETC, Scales, and
Plan data. The next sections give you step-by-step procedures for each type
of data.

8-6.1 Loading EOR Data
To load EOR data, follow these steps:

>> From the PCMODS Data Load Window, select File>EOR Data

Load or click the EOR Interface icon. 

You see the EOR window.

Figure 8-26. EOR Window

On the EOR Window, follow these steps:

1. If the file name on the EOR window is not the one you want, enter the
path and file name or click Browse to select the file you want.

2. To exit the EOR Interface without processing data, click OK or click
Return.
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If you click OK, the system begins processing the data for display and
verification. You see processed data in the Display EOR Data window.

Figure 8-27. Display EOR Data Window

On this window, follow these steps:

1. Edit the data, if necessary, by highlighting the cell and entering the
correct value.

2. To copy the data, save it, or export it to Excel, click the appropriate
button:

! Copy: 

! Save: 

! Export to Excel: 

3. To load this data into the database, click Update Database.

                            
Figure 8-28. Cancel Update Confirmation Window

4. If the database was successfully updated, you see the Database
Update Complete window. Click OK.

5. If any errors occurred, you see a message with the number of error
transactions (see Figure 8-29). Click OK.
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Figure 8-29. Interface Error Window

6. To correct data, click the Process Error Data button on the EOR
window and click OK.

         
Figure 8-30. EOR Window (with Errors)

The error data is displayed and flagged on the Display EOR Data.

Figure 8-31. Display EOR Window (with Errors)

1. When you have corrected your data, click Update Database again.

When you see the Database Update Complete window,

2. Click OK.
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To load more EOR data, repeat the steps or click Return to go back to the
PCMODS Data Load window.

8-6.2 Loading ETC Data
To load ETC data, follow these steps:

1. From the PCMODS Data Load Window, select File>ETC Data
Load or click the ETC Interface icon. 

You see the ETC window.

                  
Figure 8-32. ETC Window

On the ETC Window, follow these steps:

1. If the file name on the ETC window is not the one you want, enter the
path and file name or click Browse to select the file you want.

2. To exit the EOR Window without processing data, click OK or click
Return.

If you click OK, the system begins processing the data for display and
verification. You see processed data in the Display ETC Data window.

Figure 8-33.  Display ETC Data Window
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3. On the Display ETC Data Window, edit the data, if necessary, by
highlighting the cell and entering the correct value.

4. To copy the data, save it, or export it to Excel, click the appropriate
button:

! Copy: 

! Save: 

! Export to Excel: 

5. To load this data into the database, click Update Database.

If the database was successfully updated, you see the Database Update
Complete window.

6. Click OK.

If any errors occurred, you see a message that indicates the number of error
transactions on the Interface Error Window.

                  
Figure 8-34. Interface Error Window

7. To correct data, click the Process Error Data button on the ETC
window and click OK.

                  
Figure 8-35. ETC Window (with Errors)
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The error data is displayed and flagged on the Display ETC Data window.

Figure 8-36. Display ETC Data Window (with Errors)

8. When you have corrected your data, click Update Database again.

When you see the Database Update Complete window,

9. Click OK.

10. To load more ETC data, repeat steps 2 through 9 or click Return to
go back to the PCMODS Data Load window.

8-6.3 Loading Scales Data
To load Scales data, follow these steps:

From the PCMODS Data Load Window,

>> Select File>Scales Data Load OR click the Scales Interface icon.

You see the Scales window.

Figure 8-37. Scales Window
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On the Scales Window, follow these steps:

1. If the file name on the Scales window is not the one you want, enter
the path and file name or click Browse to select the file you want.

2. To exit the EOR Interface without processing data, click OK or
Return.

If you click OK, the system begins processing the data for display and
verification. You see processed data in the Display Scales Data window.

Figure 8-38. Display Scales Data Window

On the Display Scales Data Window, follow these steps:

1. Edit the data, if necessary, by highlighting the cell and entering the
correct value.

If the database was successfully updated, you see the Database Update
Complete window.

2. Click OK.

Figure 8-39. Cancel Update Confirmation Window

If the database was successfully updated, you see the Database Update
Complete window.

1. Click OK.
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If any errors occurred, you see a message with the number of error
transactions (see Figure 8-40).

Figure 8-40. Interface Error Window

2. To correct data, click the Process Error Data button on the Scales
window and click OK.

Figure 8-41. Scales Window (with Errors)

The error data is displayed and flagged on the Display Scales Data window.

Figure 8-42. Display Scales Data Window (with Errors)

3. When you have corrected your data, click Update Database again.

You see the Database Update Complete window.

4. Click OK.
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To load more Scales data, repeat steps 2 through 9 or click Return to go
back to the PCMODS Data Load window.

8-7 Generating Reports

8-7.1 Overview
This section gives you the procedures for generating PCMODS reports. The
following reports are available:

! Auto/Mech
! Mail Processing Recap
! Management Summary
! Operations

The reports show the data for a selected time frame—by day, week, AP, or
FY.

You can generate reports automatically or manually. All reports must be sent
to a queue (the Auto report function does this for you). You can access the
queue to show the report on your computer screen or print the report to a
printer or to a file. If you want to show the report on your computer screen,
you must select one report at a time. When you select the print reports option,
PCMODS prints all the reports in the queue to the printer or file you specified.

The next section gives you the steps to generate PCMODS reports manually.

8-7.2 Generating Reports Manually
When you specify reports with this function, you can print to a file or a printer
or you can display the report on your computer screen. These rules apply to
printing:

! When you are not viewing messages in the queue, you cannot
use the button to display the report on your computer screen.
(Only one report can be displayed on the computer screen at a
time.)

! When you are not viewing the queue, you can print all reports at
once.

! When you are viewing the queue, you must select the reports
that you want to print.

! When you are viewing the queue and select one report, you can
display that report on your computer screen.

The Report Options Window enables you to select the type of processing for
the SRF data:

! Individual:  PCMODS breaks down the record data by the SRFs
you selected.

! Sum:  PCMODS adds the record data together from the
selected SRFs. The report heading will show that this is a
summary report.
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! All:  PCMODS breaks down the record data for each SRF and
also generates a summary report.

To generate reports manually, follow these steps:

From the PCMODS Main Menu,

>> Select Reports>Manual.

You see the Report Options window with today’s date automatically selected.

Figure 8-43. Report Options Window

On the Report Options Window, follow these steps:

1. Select the name of the report you want to generate in the Print Which
Report? list box.

2. To change the date of the report, click Change and select a new
date.

3. Select a Finance Number.

4. Select an SRF and, if applicable, a Tour.

5. If you want an Individual SRF, a Summary of the selected SRFs, or all
SRFs, click the appropriate check box under the SRF box.

6. From the Time Period list box, select the appropriate period.

7. Click Send to Queue to save your report selection.

8. To select more reports, repeat steps 2 through 7.

9. To view your report selections, click Show Queue.
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You see the Report Options window with a list of the report selections you
have queued.

Figure 8-44. Report Options (Queue) Window
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You can delete a report from the print queue by deleting the row from the
Show Queue table. You cannot edit individual cells.

>> To print your queued reports or save them to a file, select the specific

reports you want to print and click the printer  or file  icon.
PCMODS prints or saves all the reports in the queue.

>> To display a specific report on your computer screen, select the report

from the queue and click the screen  icon.

8-8 Transmitting PCMODS Data

8-8.1 Overview
PCMODS keeps track of the transmission status of data by placing a flag on
database records. These flags show that the record has or has not been
transmitted since it was last updated. When you are ready to transmit data,
PCMODS generates a temporary file that includes all data that has not been
transmitted. You can preview the data in that temporary file. Once you
transmit that file, each of the records in the file is flagged as transmitted in the
database.

The temporary file you generated remains in the system until you generate
unsent data again. If the transmitted data does not reach the CDB, you can
use a recovery feature between data transmissions.

Example: If you transmit data on a Friday afternoon and realize on Monday
morning that the transmission did not get through, you can use the recovery
feature to re-transmit the data in the temporary file.

If the data you transmitted is not recoverable because the temporary file has
been overwritten, you must re-transmit an entire week’s data.

Example:  The CDB staff calls you in May and tells you that they did not
receive your data for the first week of April. Because the temporary file has
been overwritten, you must re-transmit that entire week’s data.

The next sections give you step-by-step procedures for preparing a data
transmission file and transmitting data for stand-alone sites and network sites.
Please follow the appropriate instructions for your specific site:

! Network sites: Follow the instructions in the network site section
if your site uses a Gold Tape Environment or is a Remote
Encoding Center.

! Stand-alone sites: Follow the instructions in the stand-alone site
section if your site uses Personal Oracle and is not a Gold Tape
Environment or a Remote Encoding Center.
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8-8.2 Network Site Instructions

8-8.2.1 Preparing a Data Transmission File
To prepare a data transmission file for the CDB, follow these steps:

1. From the PCMODS menu bar, select Transmit>Unsent
Data>Generate Unsent Data File.

You see two messages—"Generating Transmission Data" and "Generating
Machine Counts"—and then the Transmit Unsent Data window.

Figure 8-45. Transmit Unsent Data Window

On the Transmit Unsent Data Window,

2. To look at the data that was generated, click Preview.

You see the Transmission Data Preview window.

Figure 8-46. Transmission Data Preview Window
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3. To exit this window, click Close.

4. Click Transmit.

PCMODS copies the data to your C: drive.

8-8.2.2 Transmitting PCMODS Data
After you have prepared the transmission file, you see the FTP transmission
window.

Figure 8-47. FTP to sm07tn Window

From this window, follow these streps:

1. Select PCMODS.

2. Click Connect.

3. Type your mainframe ID and password in the appropriate fields, when
prompted. Press <Enter> after each entry. (You can get the ID and
password from Form PS-1357.)

The system connects you to the mainframe computer.
! If your PCMODS transmission data file is on the C: drive,
        >> Select Commands>Run Command File.
! If your PCMODS transmission data file is on a diskette,

1. Put the diskette in the A: drive.
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2. Select Commands>Run Command File.

You see a dialog box and you are prompted to type a filename.
! If your transmission data file is on the C: drive,

1. In the dialog box, type c:\WINDOWS\TEMP or c:\TEMP

PCM_XMIT.TAK will be present in either location according to your
system settings.

2. Select PCM_XMIT.TAK and click OK.
! If your transmission data file is on a diskette,

>> In the dialog box, type a:\PCM_XMIT.TAK

The command file automatically transmits the data, logs off from the
mainframe, and exits the FTP software program.

8-8.2.3 Recovering and Retransmitting Data
To recover a data file and re-transmit the data, follow these steps:

1. From the PCMODS menu bar, select Transmit>Unsent
Data>Recover Last Unsent Data File.

You see the Transmit Unsent Data window.

2. To look at the data that was generated, click Preview.

You see the Transmission Data Preview window.

3. To exit the preview window, click Close.

4. Click Transmit.
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If you are using a Gold Tape environment, PCMODS copies the data to your
C: drive.

To re-transmit an entire week’s data, follow these steps:

>> From the PCMODS menu bar, choose Transmit>Select a Week’s
Data.

You see the Re-Transmit Data window.

Figure 8-48. Re-Transmit Data Window

On the Re-Transmit Data Window,

>> Highlight the specific data file that you want to re-transmit and click
Transmit.

In the Gold Tape environment, PCMODS automatically copies the data to
your C: drive.

8-8.3 Stand-alone Site Instructions

8-8.3.1 Transmission Setup (Establishing Dial-up Connection)
Before you can transmit PCMODS data, you must connect to the Postal
Routed Network (PRN). You make this connection with Windows 95 Dial-Up
Networking and a modem.

To create a dial-up connection, follow these steps:

1. Minimize PCMODS and all applications so the workstation desktop is
clear.

2. From the workstation desktop, double-click the My Computer icon.

3. Double-click the Dial-Up Networking icon.

4. Double-click the PCMODS CDB icon.

5. Verify and insert the username and password. (You can get the
username and password from Form PS-3037.)
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6. Click Connect.

You see the Connecting to PCMODS CDB window, and you hear dial tones
and modem noises. When this window is minimized, the dial-up connection
has been established.

7. From the task bar icon, maximize PCMODS.

8-8.3.2 Preparing a Data Transmission File
To prepare a data transmission file for the CDB, confirm that you have
established a dial-up connection and that PCMODS is maximized. Then
follow these steps:

1. From the PCMODS menu bar, select Transmit>Unsent
Data>Generate Unsent Data File.

You see two messages—"Generating Transmission Data" and "Generating
Machine Counts"—and then the Transmit Unsent Data window.

Figure 8-49. Transmit Unsent Data Window

On the Transmit Unsent Data Window,

2. To look at the data that was generated, click Preview.
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You see the Transmission Data Preview window.

Figure 8-50. Transmission Data Preview Window

3. To exit the preview window, click Close.

4. Click Transmit.

If you are using a stand-alone environment, PCMODS shows you the
message, "Generating Transmission File", and then the Choose Data
Destination window.

Figure 8-51. Choose Data Destination Window

5. Click the appropriate drive button and click OK.
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8-8.3.3 Transmitting PCMODS Data
After you prepare the transmission file, you see the FTP transmission window.

Figure 8-52. FTP to sm07tn Window

On this window, follow these steps:

1. Select PCMODS.

2. Click Connect.

3. When prompted, type your mainframe ID and password in the
appropriate fields. Press <Enter> after each entry. (You can get the
ID and password from Form PS-1357.)

The system connects you to the mainframe computer.

4. Complete one of these steps:
! If your PCMODS transmission data file is on the C: drive,

>>  Select Commands>Run Command File.
! If your PCMODS transmission data file is on a diskette:

1. Put the diskette in the A: drive.

2. Select Commands>Run Command File.

You see a dialog box and you are prompted to type a filename.

5. Complete one of these steps:
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! If your transmission data file is on the C: drive,

1.  In the dialog box, type c:\WINDOWS\TEMP or c:\TEMP

PCM_XMIT.TAK will be present in either location according to
your system settings.

2.  Select PCM_XMIT.TAK and click OK.
! If your transmission data file is on a diskette,

>> In the dialog box, type a:\PCM_XMIT.TAK

The command file automatically transmits the data, logs off from the
mainframe, and exits the FTP software program.

8-8.3.4 Transmission Setup (Disconnecting Dial-Up Session)
After transmitting PCMODS data, you must disconnect from the Postal
Routed Network (PRN).

To disconnect from the PRN via Dial-Up Networking, follow these steps:

1. Minimize PCMODS and all applications so the workstation desktop is
clear.

2. From the workstation desktop, double-click the My Computer icon.

3. Double-click the Dial-Up Networking icon.

4. Double-click the PCMODS CDB icon.

5. Click the Disconnect button.

6. Maximize PCMODS for continued activities.

8-8.3.5 Recovery Instructions
To recover a data file and re-transmit the data, follow these steps:

1. From the PCMODS menu bar, select Transmit>Unsent
Data>Recover Last Unsent Data File.

You see the Transmit Unsent Data window.

2. To look at the data that was generated, click Preview.

You see the Transmission Data Preview window.

3. To exit the preview window, click Close.

4. Click Transmit.
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In a stand-alone environment, PCMODS shows you the message,
"Generating Transmission File", and then the Choose Data Destination
window.

>> On this window, click the appropriate drive button and click OK.

To re-transmit an entire week’s data, follow these steps:

1. From the PCMODS menu bar, choose Transmit>Select a Week’s
Data.

You see the Re-Transmit Data window.

Figure 8-53. Re-Transmit Data Window

2. Highlight the specific data file that you want to re-transmit and click
Transmit.

If you are using a stand-alone environment, PCMODS shows you three
messages—"Generating Transmission Data", "Generating Machine Counts",
and "Generating Transmission File"—and then the Choose Data Destination
window.

3. On this window, click the appropriate drive button and click OK.
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MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

FUNCTION 0 OPERATIONS SUPPORT

03 581 INDUSTRIAL ENGINEER     
02 582 QUALITY IMPROVEMENT

01 07 593 ENVIRONMENTAL MANAGEMENT
01 04 594 ZIP+4 ADDRESS INFO SYSTEM
01 04 595 CRIS ADDRESS INFO SYSTEM

04 596 5 DIGIT ZIP INFO SYSTEM 
05 645 PRODUCTION PLANNING
09 646 DELIVERY & RETAIL ANALYST
08 668 ADMIN & CLERICAL - OPERATIONS SUPPORT 
05 672 ADMIN & CLERICAL - PRODUCTION PLANNING
03 673 ADMIN & CLERICAL - INDUSTRIAL ENGINEERING
04 674 ADMIN & CLERICAL - ADDRESS MANAGEMENT SYSTEM
09 675 ADMIN & CLERICAL - DELIVERY & RETAIL PROGRAMS

01 08 900 TRAVEL - OPERATIONS SUPPORT    
01 920 MANAGER, OPERATIONS PROGRAMS SUPPORT
01 922 MANAGER, IN-PLANT SUPPORT
01 924 MANAGER, ADDRESS SYSTEMS

FUNCTION 1 MAIL PROCESSING

17 002C Consolidated for Presort
17 002 PRESORT PREF-CARRIER
17 003 PRESORT BULK-CARRIER/SATURATION
17 004 PRESORT PREF-3/5 DIGIT  
17 005 PRESORT BULK-3/5 DIGIT/BASIC
17 006 PRESORT PREF-ZIP+4      
17 007 PRESORT BULK-ZIP+4      
17 008 PRESORT PREF-ZIP+4 BARCODED
17 009 PRESORT BULK-ZIP+4 BARCODED
17 010C Consolidated Mail Preparation - Stamped
17 010 HAND CANCELLATIONS
17 011 MICRO MARK              
17 012 M - 36                  
17 013 MARK II/HALF MARK       
17 014 FLYER                   
17 015 ADVANCED FACER CANCELLER SYSTEM 
17 016 FLAT CANCELLATIONS      
17 017 ALLIED LABOR - CANCELLATIONS
17 018 ALLIED LABOR - CANCELLATIONS
17 019 ALLIED LABOR - CANCELLATIONS
17 020C Consolidated Mail Preparation - Metered
17 02B MAIL PREPARATION-METERED BYPASS
17 021 MAIL PREPARATION-METERED 
17 022 MAIL PREPARATION-METERED 
17 023 MAIL PREPARATION-METERED 
17 024 MAIL PREPARATION-METERED 
17 025 MAIL PREPARATION-METERED 
17 026 MAIL PREPARATION-METERED 
17 027 MAIL PREPARATION-METERED 
17 028 MAIL PREPARATION-METERED 
14 029 RIFFLE LETTER MAIL      LTR MANL

14 030 MANUAL LTR-OUTGOING PRIMARY LTR MANL

14 032 MANUAL LTR-INTERNATIONAL OUTBOUND LTR MANL
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July 21, 1999 MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

14 033 MANUAL LTR-INTERNATIONAL INBOUND LTR MANL

14 033C Consolidated - Manual LTR International
14 040 MANUAL LTR-OUTGOING SECONDARY LTR MANL

14 043 MANUAL LTR-STATE DISTRIBUTION LTR MANL

14 044 MANUAL LTR-SCF DISTRIBUTION  LTR MANL

14 045 MANUAL LTR-STANDARD LTR MANL

11 046 Return to Sender ISS LTR AUTO

11 047 Return to Sender OSS LTR AUTO

14 050 PRIORITY - MANUAL, OUTGOING LTR MANL

14 055 PRIORITY - MANUAL, INCOMING LTR MANL

13 052 GPL -INTERNATIONAL EXPRESS OUTBND SPBS MIX MECH

13 053 GPL -INTERNATIONAL STANDARD OUTBND SPBS MIX MECH

13 054 GPL -INTERNATIONAL ECONOMY OUTBND SPBS MIX MECH

13 056 GPL -INTERNATIONAL EXPRESS INBND SPBS MIX MECH

13 057 GPL -INTERNATIONAL STANDARD INBND SPBS MIX MECH

13 058 GPL -INTERNATIONAL ECONOMY INBND SPBS MIX MECH

14 060 MANUAL FLT-OUTGOING PRIMARY FLT MANL

14 062C Consolidated - Manual FLT International
14 062 MANUAL FLT-INTERNATIONAL OUTBOUND FLT MANL

14 063 MANUAL FLT-INTERNATIONAL INBOUND  
14 069 RIFFLE FLAT MAIL        FLT MANL

14 070 MANUAL FLT-OUTGOING SECONDARY FLT MANL

14 073 MANUAL FLT-STATE DISTRIBUTION FLT MANL

14 074 MANUAL FLT-SCF DISTRIBUTION  FLT MANL

14 075 MANUAL FLT-BULK BUSINESS FLT MANL

12 080C Consolidated MPLSM
12 081 MPLSM-OUTGOING PRIMARY  LTR MECH

12 082 MPLSM-OUTGOING SECONDARY LTR MECH

12 083 MPLSM-MANAGED MAIL LTR MECH

12 084 MPLSM-SCF               LTR MECH

12 085 MPLSM-INCOMING PRIMARY  LTR MECH

12 086 MPLSM-INCOMING SECONDARY LTR MECH

12 087 MPLSM-BOX SECTION       LTR MECH

12 088 MPLSM-BAR CODE READ, OUTGOING     LTR MECH

12 089 MPLSM-BAR CODE READ, INCOMING     LTR MECH

12 090C Consolidated - LSM - International 
12 090 LSM-INTERNATIONAL INBOUND    LTR MECH

12 091C Consolidated SPLSM/DBCS KEYING
12 091 SPLSM/DBCS KEYING-OUTGOING LTR MECH

12 092 LSM-INTERNATIONAL OUTBOUND LTR MECH

12 093 SPLSM/DBCS KEYING-MANAGED MAIL LTR MECH

12 094 SPLSM/DBCS KEYING-SCF               LTR MECH

12 095 SPLSM/DBCS KEYING-INCOMING PRIMARY  LTR MECH

12 096 SPLSM/DBCS KEYING-INCOMING SECONDARY LTR MECH

12 097 SPLSM/DBCS KEYING-BOX SECTION LTR MECH

12 098 SPLSM BAR CODE READ, OUTGOING      LTR MECH

12 099 SPLSM BAR CODE READ, INCOMING LTR MECH

14 100 MANUAL PARCELS-OUTGOING PP MANL

14 102C Consolidated - Manual Parcels - International
14 102 MANUAL PARCELS-INTERNATIONAL OUTBOUND PP MANL

14 103 MANUAL PARCELS-INTERNATIONAL INBOUND PP MANL

13 104 Global Priority Mail - Outbound MIX MECH

13 105 MECHANIZED PARCEL SORTER PP MECH

13 106 Global Priority Mail - Inbound MIX MECH

13 107C Consolidated - Parcel Sorter - International
13 107 PARCEL SORTER-INTERNATIONAL OUTBOUND  PP MECH

13 108 PARCEL SORTER-INTERNATIONAL INBOUND  PP MECH
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July 21, 1999 MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

18 109 DAMAGED PARCEL REWRAP   
17 110C Consolidated - Opening Unit Outgoing
17 110 OPENING UNIT - OUTGOING PREF
17 111 OPENING UNIT - OUTGOING PREF
17 112 OPENING UNIT - OUTGOING PREF
17 113 OPENING UNIT - OUTGOING PREF
17 114 OPENING UNIT - OUTGOING PREF
17 115 OPENING UNIT - OUTGOING STANDARD
17 116 OPENING UNIT - OUTGOING STANDARD
17 117 OPENING UNIT - OUTGOING STANDARD
17 118C Consolidated - Air Contract DCS
17 118 ACDCS OUTGOING
17 119 ACDCS INCOMING          
17 120C Consolidated Pouching Operations
17 120 POUCHING OPERATIONS     
17 121 POUCHING OPERATIONS     
17 122 POUCHING OPERATIONS     
17 123 POUCHING OPERATIONS     
17 124 POUCHING OPERATIONS     
17 125 POUCHING OPERATIONS     
17 126 POUCHING OPERATIONS     
17 127 POUCHING OPERATIONS     
17 128 POUCHING OPERATIONS     
17 129 POUCHING OPERATIONS     
14 130 MANUAL PARCELS-SCF PP MANL

18 131C Consolidated - Express Mail Distribution
18 131 EXPRESS MAIL DISTRIBUTION
18 132 INTELPOST               
13 134C Consolidated SPBS Outgoing 
13 134 SPBS OUTGOING PREF
13 135 SPBS OUTGOING STANDARD
13 136C Consolidated - SBPS Incoming
13 136 SBPS INCOMING PREF
13 137 SPBS INCOMING STANDARD
13 138C Consolidated SPBS-Priority
13 138 SPBS-PRIORITY, OUTGOING MIX MECH

13 139 SPBS-PRIORITY, INCOMING MIX MECH

12 140C Consolidated MPFSM
12 141 MPFSM-OUTGOING PRIMARY  FLT MECH

12 142 MPFSM-OUTGOING SECONDARY FLT MECH

12 143 MPFSM-MANAGED MAIL FLT MECH

12 144 MPFSM-SCF               FLT MECH

12 145 MPFSM-INCOMING PRIMARY  FLT MECH

12 146 MPFSM-INCOMING SECONDARY FLT MECH

12 147 MPFSM-BOX SECTION       FLT MECH

12 148 MPFSM-INCOMING NON-SCHEME FLT MECH

14 150 MANUAL LTR-INCOMING PRIMARY LTR MANL

14 160 MANUAL LTR-INCOMING SECONDARY LTR MANL

14 168C Consolidated Manaul Letters
14 168 MANUAL LTR-PRIMARY BOX LTR MANL

14 169 MANUAL LTR-SECONDARY BOX LTR MANL

14 170 MANUAL FLT-INCOMING PRIMARY FLT MANL

14 175 MANUAL FLT-INCOMING SECONDARY FLT MANL

14 178C Consolidated - Manual Flats
14 178 MANUAL FLT-PRIMARY BOX FLT MANL

14 179 MANUAL FLT-SECONDARY BOX FLT MANL

17 180C Consolidated - Opening Unit
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July 21, 1999 MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

17 180 OPENING UNIT-INCOMING,PREF
17 181 OPENING UNIT-INCOMING,PREF
17 182 OPENING UNIT-INCOMING,PREF
17 183 OPENING UNIT-INCOMING,PREF
17 184 OPENING UNIT-INCOMING,PREF
17 185 OPENING UNIT-INCOMING,STANDARD
17 186 OPENING UNIT-INCOMING,STANDARD
17 187 OPENING UNIT-INCOMING,STANDARD
17 188 OPENING UNIT-INCOMING,STANDARD
17 189 OPENING UNIT-INCOMING,STANDARD
12 190C Consolidated - SPFSM
12 191 SPFSM-OUTGOING PRIMARY  FLT MANL

12 192C Consolidated - FSM - Inernational 
12 192 FSM-INTERNATIONAL OUTBOUND FLT MANL

12 193 FSM-INTERNATIONAL INBOUND    FLT MANL

12 194 SPFSM-SCF               FLT MANL

12 195 SPFSM-INCOMING PRIMARY  FLT MANL

12 196 SPFSM-INCOMING SECONDARY FLT MANL

12 197 SPFSM-BOX SECTION FLT MANL

14 200 MANUAL PARCELS-INCOMING PP MANL

14 202 Global Package Link - Express - International Outbound 
14 203 Global Package Link - Standard - International Outbound 
14 204 Global Package Link - Economy - International Outbound 
14 205 Global Package Link - Express - International Inbound 
14 206 Global Package Link - Standard - International Inbound 
14 207 Global Package Link - Economy - International Inbound 
17 208C Consolidated - Scan-Where-You-Band
17 208 SCAN-WHERE-YOU-BAND, OUTGOING
17 209 SCAN-WHERE-YOU-BAND, INCOMING
17 210C Consolidated Platform Load/Unload    
17 210 PLATFORM LOAD/UNLOAD    
17 211 PLATFORM LOAD/UNLOAD    
17 212 PLATFORM LOAD/UNLOAD    
17 213 PLATFORM LOAD/UNLOAD    
17 214 PLATFORM LOAD/UNLOAD    
17 215 PLATFORM LOAD/UNLOAD    
17 216 PLATFORM LOAD/UNLOAD    
17 217 PLATFORM LOAD/UNLOAD    
17 218 PLATFORM LOAD/UNLOAD    
17 219 PLATFORM LOAD/UNLOAD    
17 220 PLATFORM LOAD/UNLOAD    
17 221 PLATFORM LOAD/UNLOAD    
17 222 PLATFORM LOAD/UNLOAD    
17 223 PLATFORM LOAD/UNLOAD    
17 224 PLATFORM LOAD/UNLOAD    
17 225 PLATFORM LOAD/UNLOAD    
17 226 PLATFORM LOAD/UNLOAD    
17 227 PLATFORM LOAD/UNLOAD    
17 228 PLATFORM LOAD/UNLOAD    
17 229 PLATFORM LOAD/UNLOAD    
17 230C Consolidated - Platform Miscellaneous
17 230 PLATFORM MISCELLANEOUS  
17 231 PLATFORM MISCELLANEOUS  
17 232 PLATFORM MISCELLANEOUS  
17 233 PLATFORM MISCELLANEOUS  
17 234 PLATFORM MISCELLANEOUS  
17 235C Consolidated  MANUAL SORT-SACKS/OUTSIDES
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SUPV        NON-SUPV OPER

17 235 MANUAL SORT-SACKS/OUTSIDES
17 236 MANUAL SORT-SACKS/OUTSIDES
17 237 MANUAL SORT-SACKS/OUTSIDES
13 238C Consolidated  MECHANIZED SORT-SACKS/OUTSIDES
13 238 MECHANIZED SORT-SACKS/OUTSIDES
13 239 MECHANIZED SORT-SACKS/OUTSIDES
11 241C Composite for the Mail Cartridge System LTR AUTO

11 241 Mail Cartridge System - Outgoing Primary LTR AUTO

11 242 Mail Cartridge System - Outgoing Secondary LTR AUTO

11 243 Mail Cartridge System - MMP LTR AUTO

11 244 Mail Cartridge System - Incoming SCF LTR AUTO

11 245 Mail Cartridge System - Incoming Primary LTR AUTO

11 246 Mail Cartridge System - Incoming Secondary LTR AUTO

11 247 Mail Cartridge System - Box Mail LTR AUTO

11 248 Mail Cartridge System - Sector Segment, 1st Pass LTR AUTO

11 249 Mail Cartridge System - Sector Segment, 2nd Pass LTR AUTO

11 250 Mail Cartridge System - Delivery Point Sequence, 1st Pass LTR AUTO

11 251 Mail Cartridge System - Delivery Point Sequence, 2nd Pass LTR AUTO

13 254C COMPOSITE INCLUDES OPERATIONS 254, 255
13 254 LINEAR INTEGRATED PARCEL SYSTEM -OUTGOING PREF
13 255 LINEAR INTEGRATED PARCEL SYSTEM - OUTGOING STANDARD
13 256C COMPOSITE INCLUDES OPERATIONS 256,257

13 256 LINEAR INTEGRATED PARCEL SYSTEM - PREF

13 257 LINEAR INTEGRATED PARCEL SYSTEM - STANDARD
13 258C COMPOSITE INCLUDES OPERATIONS 258,259
13 258 LIPS - PRIORITY OUTGOING MIX MECH

13 259 LIPS -PRIORITY INCOMING MIX MECH

11 260C COMPOSITE DBCS-OCR INCLUDES 261 - 267
11 261 DBCS-OCR - OUTGOING PRIMARY LTR AUTO

11 262 DBCS-OCR - OUTGOING SECONDARY LTR AUTO

11 263 DBCS-OCR - MANAGED MAIL LTR AUTO

11 264 DBCS-OCR - INCOMING SCF PRIMARY LTR AUTO

11 265 DBCS-OCR - INCOMING PRIMARY LTR AUTO

11 266 DBCS-OCR - INCOMING SECONDARY LTR AUTO

11 267 DBCS -OCR - BOX SECTION LTR AUTO

11 270C COMPOSITE DBCS-OSS INCLUDES 270-279,925,926
11 271 DBCS-OSS - OUTGOING PRIMARY LTR AUTO

11 272 DBCS-OSS - OUTGOING SECONDARY LTR AUTO

11 273 DBCS-OSS - MANAGED MAIL LTR AUTO

11 274 DBCS-OSS - INCOMING SCF PRIMARY LTR AUTO

11 275 DBCS-OSS - INCOMING PRIMARY LTR AUTO

11 276 DBCS-OSS - INCOMING SECONDAY LTR AUTO

11 277 DBCS-OSS - BOX SECTION LTR AUTO

 11 278 DBCS-OSS - SECTOR/SEGMENT, 1ST PASS LTR AUTO

11 279 DBCS-OSS - SECTOR/SEGMENT, 2ND PASS LTR AUTO

11 280C Composite DBCS - ISS
11 281 DBCS  ISS - Outgoing Primary LTR AUTO

11 282 DBCS  ISS - Outgoing Secondary LTR AUTO

11 283 DBCS  ISS - Managed Mail LTR AUTO

11 284 DBCS  ISS - Incoming SCF LTR AUTO

11 285 DBCS  ISS - Incoming Primary LTR AUTO

11 286 DBCS  ISS - Incoming Secondary LTR AUTO

11 287 DBCS  ISS - Box Section LTR AUTO

11 290C Composite - DBCS-ISS/OSS MODE
11 291 DBCS-ISS/OSS MODE - Outgoing Primary LTR AUTO

11 292 DBCS-ISS/OSS MODE - Outgoing Secondary LTR AUTO

11 293 DBCS-ISS/OSS MODE - Managed Mail LTR AUTO
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LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

11 294 DBCS-ISS/OSS MODE - Incoming SCF LTR AUTO

11 295 DBCS-ISS/OSS MODE - Incoming Primary LTR AUTO

11 296 DBCS-ISS/OSS MODE - Incoming Secondary LTR AUTO

11 297 DBCS-ISS/OSS MODE - Box Section LTR AUTO

11 298 DBCS-ISS/OSS MODE - Reserved LTR AUTO

11 299 DBCS-ISS/OSS MODE - Reserved LTR AUTO

11 300C Composite MLOCR - ISS - International
11 301 MLOCR - ISS - International Outbound Primary LTR AUTO

11 302 MLOCR - International Outbound Primary LTR AUTO

11 303 MLOCR - ISS - International Inbound Primary LTR AUTO

11 304 MLOCR - International Inbound Primary LTR AUTO

11 305 International - Reserved
11 306 International - Reserved
11 307 International - Reserved
11 308 International - Reserved
11 309 International - Reserved
11 310C Composite MPBCS/DBCS/OSS - International 
11 311 MPBCS/OSS - International - Outbound Primary LTR AUTO

11 312 MPBCS - International - Outbound Primary LTR AUTO

11 313 DBCS - OSS - International - Outbound Primary LTR AUTO

11 314 DBCS - International - Outbound Primary LTR AUTO

11 315 MPBCS/OSS - International - Inbound Primary LTR AUTO

11 316 MPBCS - International - Inbound Primary LTR AUTO

11 317 DBCS/OSS - International Inbound Primary LTR AUTO

11 318 DBCS - International - Inbound Primary LTR AUTO

11 319 International - Reserved LTR AUTO

12 330C Composite AFSM100
12 331 AFSM100 - Outgoing Primary FLT AUTO

12 332 AFSM100 - Outgoing Secondary FLT AUTO

12 333 AFSM100 - Managed Mail FLT AUTO

12 334 AFSM100 - Incoming SCF Primary FLT AUTO

12 335 AFSM100 - Incoming Primary FLT AUTO

12 336 AFSM100 - Incoming Secondary FLT AUTO

12 337 AFSM100 - Box Mail FLT AUTO

12 338 AFSM100 - Incoming Non-Scheme FLT AUTO

12 339 AFSM100 - Reserved FLT AUTO

18 340  STANDBY - MAIL PROCESSING
18 341 QWL COORDINATOR-NONSUPERVISOR EMPLOYEES

10 342 QWL COORDINATOR-SUPERVISOR EMPLOYEES
17 343 OPENING UNIT-INTERNATIONAL OUTBOUND  
17 344 OPENING UNIT-INTERNATIONAL INBOUND  
17 345 POUCHING - INTERNATIONAL  
13 346 SPBS INTERNATIONAL OUTBOUND
13 347 SPBS INTERNATIONAL INBOUND   
17 348 MANUAL SACK SORT-INTERNATIONAL 
13 349 MECH SACK SORT-INTERNATIONAL 
17 350 OVERLABEL/DIRECT AO SACK - INTERNATIONAL
17 351 PLATFORM - INTERNATIONAL  
17 352 LOAD/UNLOAD AT PIERS - INTERNATIONAL
17 358 Robotics - Pedestal Type
17 359 Robotics - Gantry Type
15 380C Composite - VCS Keying
15 381 VCS Keying  - Outgoing Primary
15 382 VCS Keying  - Outgoing Secondary
15 383 VCS Keying  - Managed Mail
15 384 VCS Keying  - Incoming SCF
15 385 VCS Keying  - Incoming Primary
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SUPV        NON-SUPV OPER

15 386 VCS Keying  - Incoming Secondary
15 387 VCS Keying  - Box Section
15 388 VCS Keying  - Reserved
15 389 VCS Keying  - Reserved
12 420C Composite FSMOCR
12 421 FSMOCR - Outgoing Primary FLT MECH

12 422 FSMOCR - Outgoing Secondary FLT MECH

12 423 FSMOCR - Managed Mail FLT MECH

12 424 FSMOCR - Incoming SCF FLT MECH

12 425 FSMOCR - Incoming Primary FLT MECH

12 426 FSMOCR - Incoming Secondary FLT MECH

12 427 FSMOCR - Box Mail FLT MECH

12 428 FSMOCR - Reserved FLT MECH

13 434C Composite SPBS - BCR OUTGOING
13 434 SPBS - BCR - Outgoing Pref
13 435 SPBS - BCR - Outgoing Standard
13 436C Composite SPBS - BCR - INCOMING
13 436 SPBS - BCR - Incoming Pref
13 437 SPBS - BCR - Incoming Standard
13 438C Composite SPBS - BCR - PRIORITY
13 438 SPBS - BCR - Priority Outgoing MIX MECH

13 439 SPBS - BCR - Priority Incoming MIX MECH

12 440C Consolidated - FSM 1000
12 441 FSM1000-OUTGOING PRIMARY  FLT MECH

12 442 FSM1000-OUTGOING SECONDARY FLT MECH

12 443 FSM1000-MANAGED MAIL FLT MECH

12 444 FSM1000-SCF               FLT MECH

12 445 FSM1000-INCOMING PRIMARY  FLT MECH

12 446 FSM1000-INCOMING SECONDARY FLT MECH

12 447 FSM1000-BOX SECTION       FLT MECH

12 448 FSM1000-INCOMING NON-SCHEME FLT MECH

12 450C COMPOSITE INCLUDES OPERATIONS 450-451
12 450 FSM1000 - PRIOIRTY, OUTGOING MIX MECH

12 451 FSM1000 - PRIORITY, INCOMING MIX MECH

14 452 Global Priority Mail Outbound
14 453 Global Priority Mail Inbound
17 454 CODE/BILL/DISPATCH-INTERNATIONAL
12 460C Composite FSM 1000 BCR
12 461 FSM 1000 BCR - Outgoing Primary FLT MECH

12 462 FSM 1000 BCR - Outgoing Secondary FLT MECH

12 463 FSM 1000 BCR - Managed Mail FLT MECH

12 464 FSM 1000 BCR - Incoming SCF FLT MECH

12 465 FSM 1000 BCR - Incoming Primary FLT MECH

12 466 FSM 1000 BCR - Incoming Secondary FLT MECH

12 467 FSM 1000 BCR - Boxed Mail FLT MECH

12 468 FSM 1000 BCR  - Incoming NonScheme FLT MECH

12 469 FSM 1000 BCR - Reserved FLT MECH

18 545 FOREIGN MAILS           
18 546 FOREIGN MAILS           
18 547 SCHEME EXAMINERS        
18 548 DETAIL-MAIL ORDER/PUBLISHING HOUSE 
18 549 EMPTY EQUIPMENT PROCESSING  
18 554 OFFICE WORK & RECORDKEEPING-MAIL PROCESSING
18 555 OFFICE WORK & RECORDKEEPING-MAIL PROCESSING
18 560 MISC ACTIVITY-MAIL PROCESSING
18 561 MISC ACTIVITY-MAIL PROCESSING
18 562 MISC ACTIVITY-MAIL PROCESSING
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18 563 MISC ACTIVITY-MAIL PROCESSING
18 564 MISC ACTIVITY-MAIL PROCESSING
18 573 SHORT PAID & NIXIE - INTERNATIONAL
18 574 REPAIR & REWRAP-INTERNATIONAL
18 575 SURFACE AIRLIFT & EXPRESS MAIL - INTERNATIONAL
18 576 EMPTY EQUIPMENT-INTERNATIONAL
18 577 PREP & VERIFY DELIVERY BILLS - INTERNATIONAL
18 578 REGISTERED MAIL/DIPLOMATIC POUCHES - INTERNATIONAL
18 580 INSURED & RETURNED PARCELS 
18 584 MAILGRAM                
18 585 REGISTRY SECTION        
18 586 REGISTRY SECTION        
18 587 REGISTRY SECTION        
18 588 REGISTRY SECTION        
18 589 REGISTRY SECTION        
18 590 REGISTRY SECTION        
11 603 Mailer Validation Credits FHP, TPH LTR AUTO

11 604 Mailer Validation No Volume Credits
18 607 STEWARDS - CLERKS - MAIL PROCESSING
18 612 STEWARDS-MAIL HANDLER-MAIL PROCESSING

10 18 620 TRAVEL - MAIL PROCESSING
10 18 630 MEETING TIME - MAIL PROCESSING

18 669 EXPRESS MAIL DISTRIBUTION
18 677 ADMIN & CLERICAL - PROCESSING & DISTRIBUTION
18 681 ADMIN & CLERICAL - PROCESSING & DIST, INTERNATIONAL

10 698 SUPERVISOR, AUTOMATION-MP     
10 699 SUPERVISOR, MECHANIZATION-MP  
10 700 SUPERVISOR, MANUAL-MP         
10 701 SUPERVISOR, OTHER DIRECT-MP   
10 702 SUPERVISOR, INDIRECT-MP       

18 755 DELIVERY BCS SERVICING  
10 770 SUPERVISOR, RBCS SYSTEMS ADMINISTRATOR

15 771 RBCS CONTRACTING OFFICERS REPRESENTATIVE
15 774 RBCS AUDIT MODULE            
15 775 RBCS KEYING             
15 776 LETTER MAIL LABELING MACHINE
15 779 RBCS GROUP LEADER
18 793 EXPRESS MAIL DISTRIBUTION
18 798 MISCODED/UNCODED MAIL   
11 830C Consolidated - MLOCR
11 831 MLOCR - OUTGOING PRIMARY  LTR AUTO

11 832 MLOCR - OUTGOING SECONDARY   LTR AUTO

11 833 MLOCR - MANAGED MAIL     LTR AUTO

11 834 MLOCR - INCOMING SCF LTR AUTO

11 835 MLOCR - INCOMING PRIMARY  LTR AUTO

11 836 MLOCR - INCOMING SECONDARY   LTR AUTO

11 837 MLOCR - BOX SECTION       LTR AUTO

11 840C Composite - Chunky MOD to ISS
11 841 CHUNKY MOD-OUTGOING PRIMARY  LTR AUTO

11 842 CHUNKY MOD-OUTGOING SECONDARY LTR AUTO

11 843 CHUNKY MOD-MANAGED MAIL   LTR AUTO

11 844 CHUNKY MOD-INCOMING SCF LTR AUTO

11 845 CHUNKY MOD-INCOMING PRIMARY  LTR AUTO

11 846 CHUNKY MOD-INCOMING SECONDARY LTR AUTO

11 847 CHUNKY MOD-BOX SECTION    LTR AUTO

11 850C Consolidated - Single Line OCR
11 851 SLOCR-OUTGOING PRIMARY  LTR AUTO
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11 852 SLOCR-OUTGOING SECONDARY   LTR AUTO

11 853 SLOCR-MANAGED MAIL      LTR AUTO

11 854 SLOCR-INCOMING SCF LTR AUTO

11 855 SLOCR-INCOMING PRIMARY  LTR AUTO

11 856 SLOCR-INCOMING SECONDARY   LTR AUTO

11 857 SLOCR-BOX SECTION       LTR AUTO

11 860C Consolidated BCS ON OCR
11 861 BCS ON OCR-OUTGOING PRIMARY LTR AUTO

11 862 BCS ON OCR-OUTGOING SECONDARYY LTR AUTO

11 863 BCS ON OCR-MANAGED MAIL LTR AUTO

11 864 BCS ON OCR-INCOMING SCF LTR AUTO

11 865 BCS ON OCR-INCOMING PRIMARY LTR AUTO

11 866 BCS ON OCR-INCOMING SECONDARY LTR AUTO

11 867 BCS ON OCR-BOX SECTION LTR AUTO

11 868 BCS ON OCR-SECTOR/SEGMENT, 1ST PASS LTR AUTO

11 869 BCS ON OCR-SECTOR/SEGMENT, 2ND PASS LTR AUTO

11 870C Consolidated - Mail Processing BCS
11 871 MPBCS-OUTGOING PRIMARY  LTR AUTO

11 872 MPBCS-OUTGOING SECONDARY LTR AUTO

11 873 MPBCS-MANAGED MAIL      LTR AUTO

11 874 MPBCS-INCOMING SCF LTR AUTO

11 875 MPBCS-INCOMING PRIMARY  LTR AUTO

11 876 MPBCS-INCOMING SECONDARY LTR AUTO

11 877 MPBCS-BOX SECTION       LTR AUTO

11 878 MPBCS-SECTOR/SEGMENT, 1ST PASS LTR AUTO

11 879 MPBCS-SECTOR/SEGMENT, 2ND PASS LTR AUTO

11 880C Consolidated MLOCR-ISS
11 881 MLOCR-ISS-OUTGOING PRIMARY LTR AUTO

11 882 MLOCR-ISS-OUTGOING SECONDARY LTR AUTO

11 883 MLOCR-ISS-MANAGED MAIL  LTR AUTO

11 884 MLOCR-ISS-INCOMING SCF LTR AUTO

11 885 MLOCR-ISS-INCOMING PRIMARY LTR AUTO

11 886 MLOCR-ISS-INCOMING SECONDARY LTR AUTO

11 887 MLOCR-ISS-BOX SECTION   LTR AUTO

11 890C Consolidated - Delivery Bar Code Sorter
11 891 DBCS-OUTGOING PRIMARY   LTR AUTO

11 892 DBCS-OUTGOING SECONDARY LTR AUTO

11 893 DBCS-MANAGED MAIL       LTR AUTO

11 894 DBCS-INCOMING SCF       LTR AUTO

11 895 DBCS-INCOMING PRIMARY   LTR AUTO

11 896 DBCS-INCOMING SECONDARY LTR AUTO

11 897 DBCS-BOX SECTION        LTR AUTO

11 898 DBCS-SECTOR/SEGMENT, 1ST PASS LTR AUTO

11 899 DBCS-SECTOR/SEGMENT, 2ND PASS LTR AUTO

11 908 C CSBCS - Composite
11 908 CSBCS - Sector Segment LTR AUTO

11 909 CSBCS - Incoming Secondary LTR AUTO

11 910 CSBCS - Box Mail LTR AUTO

11 911 CSBCS - Delivery Point Sequence  DPS LTR AUTO

11 914 MPBCS - DELIVERY POINT SEQUENCE, 1ST PASS LTR AUTO

11 915 MPBCS - DELIVERY POINT SEQUENCE, 2ND PASS LTR AUTO

11 916 BCS-OSS - DELIVERY POINT SEQUENCE, 1ST PASS LTR AUTO

11 917 BCS-OSS - DELIVERY POINT SEQUENCE, 2ND PASS LTR AUTO

11 918 DBCS - DELIVERY POINT SEQUENCE, 1ST PASS LTR AUTO

11 919 DBCS - DELIVERY POINT SEQUENCE, 2ND PASS LTR AUTO

11 925 DBCS-OSS - DELIVERY POINT SEQUENCE, 1ST PASS LTR AUTO

11 926 DBCS-OSS - DELIVERY POINT SEQUENCE, 2ND PASS LTR AUTO
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10 927 MANAGER, DISTRIBUTION OPERATIONS
10 928 SUPERVISOR, DISTRIBUTION OPERATIONS

18 930 BUSINESS REPLY/POSTAGE DUE 
10 932 SUPERVISOR, INTERNATIONAL     

12 960C Consolidated - Flat Mail Bar Code Reader
12 961 FMBCR-OUTGOING PRIMARY  FLT MECH

12 962 FMBCR-OUTGOING SECONDARY FLT MECH

12 963 FMBCR-MANAGED MAIL      FLT MECH

12 964 FMBCR-INCOMING SCF FLT MECH

12 965 FMBCR-INCOMING PRIMARY  FLT MECH

12 966 FMBCR-INCOMING SECONDARY FLT MECH

12 967 FMBCR-BOX SECTION       FLT MECH

11 970C Consolidated - Bar Code Output Sub System
11 971 BCS-OSS-OUTGOING PRIMARY LTR AUTO

11 972 BCS-OSS-OUTGOING SECONDARY LTR AUTO

11 973 BCS-OSS-MANAGED MAIL    LTR AUTO

11 974 BCS-OSS-INCOMING SCF LTR AUTO

11 975 BCS-OSS-INCOMING PRIMARY LTR AUTO

11 976 BCS-OSS-INCOMING SECONDARY LTR AUTO

11 977 BCS-OSS-BOX SECTION LTR AUTO

11 978 BCS-OSS SECTOR/SEGMENT, 1ST PASS LTR AUTO

11 979 BCS-OSS SECTOR/SEGMENT, 2ND PASS LTR AUTO

FUNCTION 2 DELIVERY SERVICES

20 21 354 STANDBY - DELIVERY SERVICE 
21 613 STEWARDS - CARRIERS     
24 614 STEWARDS - SPECIAL DELIVERY MESSENGER      

20 21 622 TRAVEL - DELIVERY SERVICES
20 21 632 MEETING TIME - DELIVERY SERVICES
20 705 MANAGER/SUPERVISOR - DELIVERY SERVICES
20 707 MANAGER/SUPERVISOR - ROUTE EXAMINATION
20 708 MANAGER/SUPERVISOR - OTHER DELIVERY/CUST SERV  

29 709 ROUTERS                 
29 710 ROUTERS                 
29 711 ROUTERS                 

20 22 713 VIM ROUTE - STREET      
20 21 714 VIM ROUTE - OFFICE      
20 22 715 2-TRIP BUSINESS - STREET
20 21 716 2-TRIP BUSINESS - OFFICE
20 22 717 1-TRIP BUSINESS - STREET
20 21 718 1-TRIP BUSINESS - OFFICE
20 22 719 RESIDENTIAL FOOT-STREET 
20 21 720 RESIDENTIAL FOOT-OFFICE 
20 22 721 RESIDENTIAL MOTOR-STREET
20 21 722 RESIDENTIAL MOTOR-OFFICE
20 22 723 2TRIP MIXED FOOT-STREET 
20 21 724 2TRIP MIXED FOOT-OFFICE 
20 22 725 2TRIP MIXED MOTOR-STREET
20 21 726 2TRIP MIXED MOTOR-OFFICE
20 22 727 1TRIP MIXED FOOT-STREET 
20 21 728 1TRIP MIXED FOOT-OFFICE 
20 22 729 1TRIP MIXED MOTOR-STREET
20 21 730 1TRIP MIXED MOTOR-OFFICE
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20 27 731 COLLECTION STREET       
20 27 732 COLLECTIONS OFFICE      
20 23 733 PARCEL-POST-STREET      
20 23 734 PARCEL-POST-OFFICE      
20 23 735 RELAY-STREET            
20 23 736 RELAY-OFFICE            
20 23 737 COMBINATION-STREET      
20 23 738 COMBINATION-OFFICE      
20 23 739 CARRIER DRIVERS - STREET
20 23 740 CARRIER DRIVERS - OFFICE

26 743 CARRIER CUSTOMER SUPPORT ACTIVITIES
20 24 744 SPECIAL DELIVERY MESSENGER  

25 757 CITY EMPLOYEE ON RURAL ROUTES
28 768 CITY CARRIER - TERTIARY DISTRIBUTION

FUNCTION 3 MAINTENANCE

31 615  STEWARDS - VMF          
39 616  STEWARDS - MTE          
31 617  STEWARDS - MVS          

35 39 624  TRAVEL - PLANT & EQUIPMENT
35 39 634  MEETING TIME - PLANT & EQUIPMENT

33 647  VOMA SUPPORT 
35 676  ADMIN & CLERICAL - MAINTENANCE SUPPORT
30 31 679  ADMIN & CLERICAL - TRANSPORTATION & NETWORKS

39 680  ADMIN & CLERICAL - PLANT & EQUIPMENT
39 745  MAINTENANCE OPERATIONS SUPPORT
39 746  TELEPHONE SWITCHBOARD   
38 747  BUILDING SERVICES       
38 748  BUILDING SERVICES       
38 749  BUILDING SERVICES       
36 750  POSTAL OPERATING EQUIPMENT  
36 751  POSTAL OPERATING EQUIPMENT  
36 752  POSTAL OPERATING EQUIPMENT  
37 753  BUILDING SYSTEMS EQUIPMENT  
37 754  BUILDING SYSTEMS EQUIPMENT  

30 758  MANAGER, TRANSPORTATIONS & NETWORKS
30 759  SUPERVISOR, TRANSPORTATION OPERATIONS
30 760  MANAGER, VEHICLE MAINTENANCE

32 761  REPAIR-GENERAL MAINTENANCE  
32 762  SERVICING-GENERAL MAINTENANC
31 763  VEHICLE MAINTENANCE FACILITY 
31 764  MOTOR VEHICLE SERVICE
34 765  MOTOR VEHICLE OPERATORS 
34 766  TRACTOR TRAILER OPERATOR
34 772  MOTOR VEHICLE OPRERATOR - COLLECTIONS 
34 773  TRACTOR TRAILER OPERATOR - COLLECTIONS 

30 31 901  TRAVEL - VEHICLE SERVICE  
35 933  MANAGER, MAINTENANCE OPERATIONS
35 951  SUPERVISOR, MAINTENANCE OPERATIONS   
35 952  MANAGER/SUPERVISOR, MAINT. OPERATIONS SUPPORT
35 953  MANAGER, FIELD MAINTENANCE OPERATIONS

FUNCTION 4 CUSTOMER SERVICES

Version 1 Page 11



July 21, 1999 MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

41 048 ISS - Return to Sender LTR AUTO

41 049 OSS-Return to Sender LTR AUTO

43 240 MANUAL DISTRIBUITON STATION/BRANCH MIX MANL

41 252 CSBCS - Outgoing Primary LTR AUTO

41 253 CSBCS - Incoming Primary LTR AUTO

40 48 353 STANDBY-CUSTOMER SERVICES
45 355 WINDOW SERVICE-STATION/BRANCH
41 360C COMPOSITE - DBCS-OSS INCLUDES OPERATIONS 316-367
41 361 DBCS-OCR - OUTGOING PRIMARY LTR AUTO

41 362 DBCS-OCR - OUTGOING SECONDARY LTR AUTO

41 363 DBCS-OCR - RESERVED
41 364 DBCS-OCR - INCOMING SCF PRIMARY LTR AUTO

41 365 DBCS-OCR - INCOMING PRIMARY LTR AUTO

41 366 DBCS-OCR - INCOMING SECONDARY LTR AUTO

41 367 DBCS-OCR - BOX SECTION LTR AUTO

41 368 DBCS-OCR - RESERVED
41 369 DBCS-OCR - RESERVED
41 370C COMPOSITE INCLUDES OPERATIONS 371-379, 942, 943

41 371 DBCS-OSS - OUTGOING PRIMARY LTR AUTO

41 372 DBCS-OSS - OUTGOING SECONDARY LTR AUTO

41 373 DBCS-OSS - RESERVED LTR AUTO

41 374 DBCS-OSS - INCOMING SCF PRIMARY LTR AUTO

41 375 DBCS-OSS - INCOMING PRIMARY LTR AUTO

41 376 DBCS-OSS - INCOMING SECONDARY LTR AUTO

41 377 DBCS-OSS - BOX SECTION LTR AUTO

41 378 DBCS-OSS - SECTOR/SEGMENT, 1ST PASS LTR AUTO

41 379 DBCS-OSS - SECTOR/SEGMENT, 2ND PASS LTR AUTO

42 400C Composite FSMOCR
42 401 FSMOCR - Outgoing Primary FLT MECH

42 402 FSMOCR - Outgoing Secondary FLT MECH

42 403 FSMOCR - Managed Mail FLT MECH

42 404 FSMOCR - Incoming SCF FLT MECH

42 405 FSMOCR - Incoming Primary FLT MECH

42 406 FSMOCR - Incoming Secondary FLT MECH

42 407 FSMOCR - Box Mail FLT MECH

42 408 FSMOCR - Reserved FLT MECH

42 409 FSMOCR - Reserved FLT MECH

41 410C Composite - DBCS-ISS/OSS MODE
41 411 DBCS-ISS/OSS MODE - Outgoing Primary LTR AUTO

41 412 DBCS-ISS/OSS MODE - Outgoing Secondary LTR AUTO

41 413 DBCS-ISS/OSS MODE - Managed Mail LTR AUTO

41 414 DBCS-ISS/OSS MODE - Incoming SCF LTR AUTO

41 415 DBCS-ISS/OSS MODE - Incoming Primary LTR AUTO

41 416 DBCS-ISS/OSS MODE - Incoming Secondary LTR AUTO

41 417 DBCS-ISS/OSS MODE - Box Section LTR AUTO

41 418 DBCS-ISS/OSS MODE - Reserved LTR AUTO

41 419 DBCS-ISS/OSS MODE - Reserved LTR AUTO

49 539 ZIP+4 LOOKUP AT CMU/CFS 
48 542 INSURED - COD - CUSTOMS 
48 543 INSURED - COD - CUSTOMS 
48 544 CAGES SERVING CARRIERS/SPECIAL DELIVERY MESSENGERS
48 558 OFFICE WORK & RECORDKEEPING-CUSTOMER SERVICES
48 559 OFFICE WORK & RECORDKEEPING-DELIVERY SERVICE
45 568 WINDOW SERVICE-MAIN OFFICE
48 583 EXPRESS MAIL-CUSTOMER SERVICE
41 605 Mailer Validation Credits FHP, TPH LTR AUTO

41 606 Mailer Validation No Volume Credits

Version 1 Page 12



July 21, 1999 MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

48 608 STEWARDS - CLERKS - CUSTOMER SERVICES
40 48 621 TRAVEL - CUSTOMER SERVICES
40 48 631 MEETING TIME - CUSTOMER SERVICES

48 678 ADMIN & CLERICAL - AREA STATIONS  
40 706 MANAGER/SUPERVISOR - CUSTOMER SERVICES

48 741 MISC ACTIVITY-DELIVERY SERVICES
48 742 MISC ACTIVITY-CUSTOMER SERVICES 
44 769 STATION/BRANCH BOX SECTION      
49 791 Computerized Forwarding System - Delivery Unit Nixes
49 792 Computerized Forwarding System - Return to Sender
48 794 MISC MARKUP ACTIVITIES - STATION/BRANCH 
49 795 ADDRESS LABEL PREPERATION
49 796 MAIL MARKUP/FORWARDING  
49 797 COMPUTER MAIL FORWARDING
42 800C Composite - FSM- Station and Branch
42 801 FSM - OUTGOING PRIMARY  FLT MECH

42 802 FSM - OUTGOING SECONDARY FLT MECH

42 803 FSM - MANAGED MAIL FLT MECH

42 804 FSM - INCOMING SCF FLT MECH

42 805 FSM - INCOMING PRIMARY  FLT MECH

42 806 FSM - INCOMING SECONDARY FLT MECH

42 807 FSM - BOX SECTION       FLT MECH

42 810C Consolidated - LSM - Station and Branch
42 811 LSM - OUTGOING PRIMARY  LTR MECH

42 812 LSM - OUTGOING SECONDARY LTR MECH

42 813 LSM - MANAGED MAIL LTR MECH

42 814 LSM - INCOMING SCF   LTR MECH

42 815 LSM - INCOMING PRIMARY  LTR MECH

42 816 LSM - INCOMING SECONDARY LTR MECH

42 817 LSM - BOX SECTION       LTR MECH

42 818 LSM - BAR CODE READ - OUTGOING    LTR MECH

42 819 LSM - BAR CODE READ - INCOMING    LTR MECH

42 820C Consolidated - Auto Letters
41 821 AUTOMATED LETTERS - OUTGOING PRIMARY LTR AUTO

41 822 AUTOMATED LETTERS - OUTGOING SECONDARY LTR AUTO

41 823 AUTOMATED LETTERS - MANAGED MAIL LTR AUTO

41 824 AUTOMATED LETTERS - INCOMING SCF LTR AUTO

41 825 AUTOMATED LETTERS - INCOMING PRIMARY LTR AUTO

41 826 AUTOMATED LETTERS - INCOMING SECONDARY LTR AUTO

41 827 AUTOMATED LETTERS - BOX SECTION LTR AUTO

41 828 AUTOMATED LETTERS - SECTOR/SEGMENT, 1ST PASS LTR AUTO

41 829 AUTOMATED LETTERS - SECTOR/SEGMENT, 2ND PASS LTR AUTO

41 905 DELIVERY CS BCS DISTRIBUTION
41 906 CARRIER ROUTE SORTATION 
41 907 SERCIVING THE CSBCS BY SENIOR MAIL PROCESS
41 912 AUTOMATED LETTERS - DPS, 1ST PASS LTR AUTO

41 913 AUTOMATED LETTERS - DPS, 2ND PASS LTR AUTO

40 929 MANAGER, CUSTOMER SERVICES OPERATIONS
41 942 DBCS-OSS - DELIVERY POINT SEQUENCE, 1ST PASS LTR AUTO

41 943 DBCS-OSS - DELIVERY POINT SEQUENCE, 2ND PASS LTR AUTO

40 46 980 SSPC TECH STA/BR - MAINTENANCE
40 46 981 SSPC TECH STA/BR - MAINTENANCE TRAVEL
40 46 982 SSPC TECH STA/BR - SERVICE
40 46 983 SSPC TECH STA/BR - SERVICE TRAVEL
40 46 984 SSPC TECH MAIN OFC-MAINTENANCE
40 46 985 SSPC TECH MAIN OFC-MAINTENANCE TRAVEL
40 46 986 SSPC TECH MAIN OFC-SERVICE
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July 21, 1999 MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

40 46 987 SSPC TECH MAIN OFC-SERVICE TRAVEL

FUNCTION 5 FINANCE

50 56 540 MISC ACTIVIVIES - FINANCE 
50 56 556 OFFICE WORK & RECORDKEEPING-FINANCE
50 57 569 C/RA - NON FINANCE EMPLOYEE
50 57 579 ODIS - NON FINANCE EMPLOYEE
50 57 591 ODIS - FINANCE EMPLOYEE
50 57 592 C/RA - FINANCE EMPLOYEE
50 599 MANAGER, FINANCE

56 610 STEWARDS - CLERKS - FINANCE
50 56 623 TRAVEL - FINANCE

58 633 OTHER TIMEKEEPING
50 635 MEETING TIME - FINANCE - SUPERVISION    

56 636 MEETING TIME - FINANCE - NON SUPERVISION    
53 649 PSDS OPERATIONS         
54 650 BUDGET & FINANCIAL ANALYSIS   
56 651 ADMIN & CLERICAL - FINANCE
52 683 ADMIN & CLERICAL - ACCOUNTING SERVICES
54 684 ADMIN & CLERICAL - BUDGET & FINANCIAL ANALYSIS
55 685 POSTAL SYSTEMS COORDINATOR

50 703 SUPERVISOR, FINANCE
51 704 Revenue Assurance

50 923 STATISTICAL PROGRAMS COORDINATOR
50 936 SUPERVISOR , ACCOUNTING SERVICES 
50 937 GENERAL SUPERVISOR, PSDS OPERATIONS 

52 968 EXCHANGE OFFICE RECORD UNIT - INTERNATIONAL
57 969 STATISTICAL PROGRAMS-INTERNATIONAL  

FUNCTION 6 HUMAN RESOURCES

60 61 541  MISC HUMAN RESOURCE ACTIVITIES
62 557  OFFICE WORK & RECORDKEEPING-HUMAN RESOURCES 
65 566  TRAINING SUPPORT
62 572  PERSONNEL SECTION       

60 600  MANAGER, HUMAN RESOURCES
61 611  STEWARDS - CLERKS - HUMAN RESOURCES

60 641  MEETING TIME - HUMAN RESOURCES-SUPERVISION
61 642  MEETING TIME - HUMAN RESOURCES - NON-SUPERVISION

60 66 643  INJURY COMPENSATION
60 61 652  LABOR RELATIONS
60 63 653  SAFETY & HEALTH
60 64 654  EEO
60 61 686  ADMIN & CLERICAL - LABOR RELATIONS

64 687  ADMIN & CLERICAL - EEO
62 689  ADMIN & CLERICAL - PERSONNEL SERVICES
65 691  ADMIN & CLERICAL - TRAINING SUPPORT
63 692  ADMIN & CLERICAL - SAFETY/HEALTH

60 61 902  TRAVEL - HUMAN RESOURCES
69 958  REHABILITATION          
68 959  LIMITED DUTY            

FUNCTION 7 CUSTOMER SERVICES SUPPORT
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July 21, 1999 MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

70 79 001  PLATFORM ACCEPTANCE & WEIGHERS UNIT 
79 550  PRESORT VERIFICATION    

70 75 551  CLAIMS & INQUIRIES
70 75 552  CLAIMS & INQUIRIES
70 601  MANAGER, CUSTOMER SERVICES SUPPORT
70 655  SUPERVISOR, BUSINESS MAIL ENTRY
70 71 656  COMMERCIAL SALES & ACCOUNT MANAGEMENT      
70 72 657  POSTAL BUSINESS CENTERS
70 73 658  EXPEDITED MAIL SERVICE
70 74 659  RETAIL MARKETING
70 79 660  MAILING REQUIREMENTS & BUSINESS MAIL ENTRY
70 76 661  CONSUMER AFFAIRS        
70 77 662  ACCOUNTABLE PAPER       
70 78 663  ADMIN & CLERICAL - CUSTOMER SERVICES SUPPORT
70 72 693  ADMIN & CLERICAL - POSTAL BUSINESS CENTERS
70 73 694  ADMIN & CLERICAL - EXPEDITED MAIL SERVICE

74 696  ADMIN & CLERICAL - RETAIL MARKETING
79 697  ADMIN & CLERICAL - MAILING REQUIRE. & BUS. MAIL ENTRY

70 78 903  TRAVEL - CUSTOMER SERVICES SUPPORT
70 946  MANAGER, POSTAL BUSINESS CENTERS
70 948  MANAGER, COMMERCIAL ACCOUNTS
70 949  MANAGER, CONSUMER AFFAIRS & CLAIMS
70 950  MANAGER, BUSINESS MAIL ENTRY

FUNCTION 8 ADMINISTRATION

88 455  AREA/DISTRICT PROJECTS - SUPERVISION
88 456  AREA/DISTRICT PROJECTS - SUPERVISION
88 457  AREA/DISTRICT PROJECTS - SUPERVISION
88 458  AREA/DISTRICT PROJECTS - SUPERVISION
88 459  AREA/DISTRICT PROJECTS - SUPERVISION

89 470  AREA/DISTRICT PROJECTS - NON-SUPERVISION
88 471  HEADQUARTERS PROJECTS - SUPERVISION
88 472  HEADQUARTERS PROJECTS - SUPERVISION
88 473  HEADQUARTERS PROJECTS - SUPERVISION
88 474  HEADQUARTERS PROJECTS - SUPERVISION
88 475  HEADQUARTERS PROJECTS - SUPERVISION
88 476  HEADQUARTERS PROJECTS - SUPERVISION
88 477  HEADQUARTERS PROJECTS - SUPERVISION
88 478  HEADQUARTERS PROJECTS - SUPERVISION
88 479  HEADQUARTERS PROJECTS - SUPERVISION
88 480  HEADQUARTERS PROJECTS - SUPERVISION
88 481  HEADQUARTERS PROJECTS - SUPERVISION
88 482  HEADQUARTERS PROJECTS - SUPERVISION
88 483  HEADQUARTERS PROJECTS - SUPERVISION
88 484  HEADQUARTERS PROJECTS - SUPERVISION
88 485  HEADQUARTERS PROJECTS - SUPERVISION
88 486  HEADQUARTERS PROJECTS - SUPERVISION
88 487  HEADQUARTERS PROJECTS - SUPERVISION
88 488  HEADQUARTERS PROJECTS - SUPERVISION
88 489  HEADQUARTERS PROJECTS - SUPERVISION
88 490  HEADQUARTERS PROJECTS - SUPERVISION
88 491  HEADQUARTERS PROJECTS - SUPERVISION
88 492  HEADQUARTERS PROJECTS - SUPERVISION
88 493  HEADQUARTERS PROJECTS - SUPERVISION
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July 21, 1999 MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

88 494  HEADQUARTERS PROJECTS - SUPERVISION
88 495  HEADQUARTERS PROJECTS - SUPERVISION
88 496  HEADQUARTERS PROJECTS - SUPERVISION
88 497  HEADQUARTERS PROJECTS - SUPERVISION
88 498  HEADQUARTERS PROJECTS - SUPERVISION
88 499  HEADQUARTERS PROJECTS - SUPERVISION
88 500  HEADQUARTERS PROJECTS - SUPERVISION
88 501  HEADQUARTERS PROJECTS - SUPERVISION
88 502  HEADQUARTERS PROJECTS - SUPERVISION
88 503  HEADQUARTERS PROJECTS - SUPERVISION
88 504  HEADQUARTERS PROJECTS - SUPERVISION

89 505  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 506  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 507  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 508  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 509  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 510  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 511  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 512  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 513  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 514  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 515  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 516  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 517  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 518  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 519  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 520  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 521  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 522  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 523  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 524  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 525  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 526  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 527  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 528  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 529  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 530  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 531  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 532  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 533  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 534  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 535  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 536  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 537  HEADQUARTERS PROJECTS - NON-SUPERVISION
89 538  HEADQUARTERS PROJECTS - NON-SUPERVISION

81 82 570  ADMIN SERVICES - SUPPLY 
81 82 571  EXECUTIVE SECTION       
81 602  MANAGER, ADMINISTRATIVE SERVICES      

84 648  INFORMATION SYSTEMS
82 665  ADMIN & CLERICAL - ADMINISTRATION
83 666  PURCHASING
85 670  FACILITIES

80 671  POSTMASTER/INSTALLATION MANAGER
84 682  ADMIN & CLERICAL - INFORMATION SYSTEMS

81 82 904  TRAVEL - ADMINISTRATION
81 934  MANAGER, INFORMATION SYSTEMS   

Version 1 Page 16



July 21, 1999 MODS  OPERATION  NUMBERS
LDC LDC MODS      DESCRIPTION

SUPV        NON-SUPV OPER

FUNCTION 9 TRAINING

90 90 780  TRAINING - OPERATIONS SUPPORT 
91 91 781  TRAINING - MAIL PROCESSING
92 92 782  TRAINING - DELIVERY SERVICES
93 93 783  TRAINING - PLANT & EQUIPMENT MAINTENANCE
94 94 784  TRAINING - CUSTOMER SERVICES
95 95 785  TRAINING - FINANCE 
96 96 786  TRAINING - HUMAN RESOURCES 
97 97 787  TRAINING - CUSTOMER SERVICES SUPPORT
98 98 788  TRAINING - ADMINISTRATION 
93 93 789  TRAINING - VEHICLE SERVICES 

SPECIAL OPERATIONS

777 INCOMING LETTERS FLOWED TO ROUTE/BOX
778 INCOMING FLATS FLOWED TO ROUTE/BOX
888 FLOWED AS FINALIZED
988 LOANED AS OFFICER-IN-CHARGE
989 LOANED TO HEADQUARTERS
990 LOANED AS SUPERVISOR
991 LOANED AS CLERK
992 LOANED AS MAIL HANDLER
993 LOANED AS CARRIER
994 LOANED AS SPECIAL DELIVERY MESSENGER
995 LOANED AS VMF MECHANIC
996 LOANED AS MAINT BUILDING SERVICES
997 LOANED AS RURAL CARRIER
998 TIME & ATTENDANCE CORRECTION

50 53 999 INVALID OPERATIONS
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Source
_Type Description N_Rate Type Mail Handling Action
01 Machine Canceled 35.51 Machinable Letters FHP +
02 Metered Prep Pref 27.88 Machinable Letters FHP +
03 Metered Bypass Pref 28.25 Machinable Letters FHP +
04 Metered Prep Std 22.22 Machinable Letters FHP +
05 Metered Bypass Std 19.6 Machinable Letters FHP +
06 Opening Unit Mixed Pref 28.55 Machinable Letters FHP +
07 Opening Unit Mixed Std 18.11 Machinable Letters FHP +
08 Category C- OCR Readable 1 Machinable Letters INVALID +
09 Second Handling, Mixed, Std 18.11 Machinable Letters TPH +
10 Second Handling, Mixed, Pref 28.55 Machinable Letters TPH +
11 Hand Canceled 21.42 Non-Machinable Letters FHP +
12 Metered Prep, Pref 21.52 Non-Machinable Letters FHP +
13 Metered Bypass, Pref 15.07 Non-Machinable Letters FHP +
14 Metered Prep, Std 11.61 Non-Machinable Letters FHP +
15 Metered Bypass, Std 14.14 Non-Machinable Letters FHP +
16 Opening Unit Mixed Pref 21.02 Non-Machinable Letters FHP +
17 Opening Unit Mixed Std 13.57 Non-Machinable Letters FHP +
18 Barcode A Field 1 Machinable Letters INVALID +
19 Barcode B Field 1 Machinable Letters INVALID +
20 Barcode C Field 1 Machinable Letters INVALID +
21 Barcode B' Prime Field 1 Machinable Letters INVALID +
22 Barcode C' Prime Field 1 Machinable Letters INVALID +
23 Pre-Barcode B Field 1 Machinable Letters INVALID +
24 Pre-Barcode C Field 1 Machinable Letters INVALID +

25
Second Handling,
Metered Prep/Metered Bypass Std 13.66 Non-Machinable Letters TPH -

26 Pre Barcode B' Prime Field 1 Machinable Letters INVALID +
27 Machine Rejects 35.42 Machinable Letters TPH -
28 Auto/Mech Second Handling 1 Machinable Letters TPH +
29 Riffle Mail 30.43 Non-Machinable Letters TPH +
30 Pre Barcoded C'Prime Field 1 Machinable Letters INVALID +
31 Inventory Hand Canceled 21.42 Non-Machinable Letters FHP +
32 Inventory Metered Preparation, Pref 21.52 Non-Machinable Letters FHP +
33 Pre Barcoded Unique 5-Digit 1 Machinable Letters INVALID +
34 Inventory Opening Unit, Std 13.57 Non-Machinable Letters FHP +
35 Inventory Second Handling, Std 13.57 Non-Machinable Letters TPH +
36 Inventory Opening Unit, Mixed Pref 21.02 Non-Machinable Letters FHP +
37 Inventory Second Handling, Pref 21.02 Non-Machinable Letters TPH +
38 Category B - Script 1 Machinable Letters INVALID -
39 Rework 23.72 Machinable Letters FHP +
40 400 Bin 35.42 Machinable Letters TPH -
41 Letters, Destination 30.98 Foreign Letters FHP +
42 Letters, Origin 35.56 Foreign Letters FHP +
43 Total Unique 5- digit 1 Machinable Letters INVALID +
44 Withdraw - Foreign Origin 35.56 Foreign Letters TPH -
45 Inventory Foreign Origin 35.56 Foreign Letters FHP +
46 Inventory Foreign Origin 35.56 Foreign Letters TPH +
47 Local Cancelations 33.19 Machinable Letters FHP +
48 Console Reading 1 Machinable Letters INVALID +
49 Carrier Bypass 1 Letters INVALID +
50 Rework Bin and Key Errors 3.57 Flats FHP +
51 Machine Canceled 4.72 Flats FHP +
52 Meter Preparation 4.18 Flats FHP +
53 Meter Bypass 4.49 Flats FHP +
54 Opening Unit, Mixes Pref 3.57 Flats FHP +
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55 Opening Unit, Newspapers 2.78 Flats FHP +
56 Category A - FIM 1 Flats INVALID +
57 Inventory Mixed Pref 3.57 Flats FHP +
58 Inventory Mixed Pref 3.57 Flats TPH +
59 Inventory Newspapers 2.78 Flats FHP +
60 Inventory Newspapers 2.78 Flats FHP +
61 Inventory Flats, Origin 4.59 Flats FHP +
62 Inventory Foreign 4.59 Flats FHP +
63 Withdrawl, All Flats Second Handling 3.57 Flats TPH -
64 Second Handling, Mixed, Pref 3.57 Flats TPH +
65 Originating Std 4.83 Flats FHP +
66 Opening Unit, Mixed Std 4.36 Flats FHP +
67 Inventory, Opening Unit, Mixed Std 4.36 Flats FHP +
68 Console Reading (Pieces Fed) 1 Flats INVALID +
69 Carrier Bypass 1 Flats INVALID +
70 Outside Piece 1 Parcels FHP +
71 Sacks 8.79 Parcels FHP +
72 Hampers 39.7 Parcels FHP +
73 Hampers - Extended 65 Parcels FHP +
74 Inventory - Hampers 39.7 Parcels FHP +
75 Originating Presort, Pref 1 Letters INVALID +
76 Originating Presort, Std 1 Letters INVALID +
77 Originating Presort, Pref 1 Flats INVALID +
78 Originating Presort, Std 1 Flats INVALID +
79 Parcels for Delivery 1 Parcels FHP +
80 Machine Canceled 35.51 Letters FHP +
81 Metered Preparation, Pref 27.88 Letters FHP +
82 Metered Bypass, Pref 28.25 Letters FHP +
83 Metered BBM 22.22 Letters FHP +
84 Metered Bypass Std 19.6 Letters FHP +
85 Opening Unit, Pref 28.55 Letters FHP +
86 Opening Unit, Std 18.11 Letters FHP +
87 Metered Bypass Pref 15.07 Letters FHP +
88 Metered Bypass, Std 14.14 Letters FHP +
89 Opening Unit, Std 13.57 Letters FHP +
90 Machine Canceled 4.72 Flats FHP +
91 Metered Preparation 4.18 Flats FHP +
92 Metered Bypass 4.49 Flats FHP +
93 Originating, Std 4.83 Flats FHP +
94 AFCS-ISS Script Image Lift 1 Letters INVALID +
95 AFCS-ISS OCR Readable Image Lift 1 Letters INVALID +
96 INVALID 1 Letters INVALID +
97 INVALID 1 Letters INVALID +
98 INVALID 1 Letters INVALID +
99 Workload Unit 1 Workload Unit INVALID +
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MODS MAIL FLOW DENSITY MATRIX

FROM      Mail
MODS      Flow
Oper         Code                                                       TO MODS Operation Numbers

Updated November 17, 1998 Page 1

030 11 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

030 12 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

030 13 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

030 14 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

030 99 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

032 11 032, 033, 777, 888

032 12 032, 033, 777, 888

032 13 032, 033, 777, 888

032 14 032, 033, 777, 888

032 99 032, 033, 777, 888

033 11 032, 033, 777, 888

033 12 032, 033, 777, 888

033 13 032, 033, 777, 888

033 14 032, 033, 777, 888

033 99 032, 033, 777, 888

043 13 040, 043, 044, 150, 160, 168, 240, 777, 888

043 43 777, 888

044 13 044, 150, 160, 168, 240, 888

044 23 040, 888

045 14 044, 045, 150, 160, 168, 240, 888

060 13 050, 055, 062, 063,  070, 073, 074, 170, 175, 178, 240, 778, 888

060 14 050, 055, 062, 063, 070, 073, 074, 170, 175, 178, 240, 778, 888

062 13 050, 055, 062, 063, 070, 073, 074, 170, 175, 178, 240, 778, 888

062 14 050, 055, 062, 063, 070, 073, 074, 170, 175, 178, 240, 778, 888

063 13 050, 055, 062, 063, 070, 073, 074, 170, 175, 178, 240, 778, 888

063 14 050, 055, 062, 063, 070, 073, 074, 170, 175, 178, 240, 778, 888

070 99 074, 888

073 13 070, 074, 170, 175, 178, 240, 888

073 14 070, 074, 170, 175, 178, 240, 888

074 13 170, 175, 178, 240, 888

074 14 170, 175, 178, 240, 888

075 14 074, 075, 170, 175, 178, 240, 888

075 24 178, 888

081 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

082 33 160, 240, 888
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FROM      Mail
MODS      Flow
Oper         Code                                                       TO MODS Operation Numbers

Updated November 17, 1998 Page 2

083 33 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

084 33 044, 150, 160, 168, 169, 240, 777, 888

085 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

086 33 160, 888

087 33 169, 777, 888

090 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

091 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

092 33 160, 240, 888

093 33 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

094 33 044, 150, 160, 168, 169, 240, 777, 888

095 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

096 33 160, 888

097 33 169, 777, 888

141 33 050, 055, 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

142 33 175, 178, 179, 240, 778, 888

143 33 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

144 33 074, 075, 170, 175, 178, 179, 240, 778, 888

145 33 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

146 33 175, 178, 179, 240, 778, 888

147 33 179, 240, 778, 888

148 33 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

150 13 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

150 14 030, 032, 033, 040, 044, 045, 150, 160, 168, 169, 240, 777, 888

150 23 150, 160, 168, 169, 240, 777, 888

150 99 030, 032, 033, 040, 043, 044, 045, 150, 160, 168, 169, 240, 777, 888

160 43 160, 168, 169, 888

168 43 169, 888

170 43 060, 062, 063, 070, 073, 074, 075, 175, 178, 179, 240, 778, 888

170 44 060, 062, 063, 070, 073, 074, 075, 175, 178, 179, 240, 778, 888

175 43 175, 178, 179, 888

178 43 179, 888

191 33 050, 055, 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

192 33 175, 178, 179, 240, 778, 888

193 33 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

194 33 074, 075, 170, 175, 178, 179, 240, 778, 888
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195 33 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

196 33 175, 178, 179, 240, 778, 888

197 33 179, 240, 778, 888

261 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

262 33 050, 055, 150, 160, 168, 169, 240, 777, 888

263 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

264 33 044, 150, 160, 168, 169, 240, 777, 888

265 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

266 33 160, 168, 169, 777, 888

267 33 168, 169, 888

271 33 030, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

272 33 050, 055, 150, 160, 168, 169, 240, 777, 888

273 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

274 33, 044, 150, 160, 168, 169, 240, 777, 888

275 33 030, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

276 33 160, 168, 169, 777, 888

277 33 168, 169, 888

278 33 160, 168, 169, 777, 888

279 33 160, 168, 169, 777, 888

281 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

282 33 050, 055, 150, 160, 168, 169, 240, 777, 888

283 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

284 33 044, 150, 160, 168, 169, 240, 777, 888

285 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

286 33 160, 168, 169, 777, 888

287 33 168, 169, 888

301 33 032, 888

302 33 032, 888

303 33 030, 040, 043, 150, 888

304 33 030, 040, 043, 150, 888

311 33 032, 888

312 33 032, 888

313 33 032, 888

314 33 032, 888

315 33 030, 040, 150, 888
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316 33 030, 040, 150, 888

317 33 030, 040, 150, 888

318 33 030, 040, 150, 888

421 33 050, 055, 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

422 33 175, 178, 179, 240, 778, 888

423 33 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

424 33 074, 075, 170, 175, 178, 179, 240, 778, 888

425 33 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

426 33 175, 178, 179, 240, 778, 888

427 33 179, 240, 778, 888

441 33 050, 055, 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

442 33 175, 178, 179, 240, 778, 888

443 33 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

444 33 074, 075, 170, 175, 178, 179, 240, 778, 888

445 33 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

446 33 175, 178, 179, 240, 778, 888

447 33 179, 240, 778, 888

448 33 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

461 33 050, 055, 060, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

462 33 175, 178, 179, 240, 778, 888

463 33 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

464 33 074, 075, 170, 175, 178, 179, 240, 778, 888

465 33 060, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

466 33 175, 178, 179, 240, 778, 888

467 33 179, 240, 778, 888

468 33 060, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

831 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

832 33 160, 240, 777, 888

833 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

834 33 044, 150, 160, 168, 169, 240, 777, 888

835 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

836 33 160, 888

837 33 169, 888

841 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

842 33 160, 240, 777, 888



MODS MAIL FLOW DENSITY MATRIX

FROM      Mail
MODS      Flow
Oper         Code                                                       TO MODS Operation Numbers

Updated November 17, 1998 Page 5

843 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

844 33 044, 150, 160, 168, 169, 240, 777, 888

845 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

846 33 160, 888

847 33 169, 888

851 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

852 33 160, 240, 777, 888

853 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

854 33 044, 150, 160, 168, 169, 240, 777, 888

855 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

856 33 160, 888

857 33 169, 888

861 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

862 33 160, 240, 777, 888

863 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

864 33 044, 150, 160, 168, 169, 240, 777, 888

865 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

866 33 160, 888

867 33 169, 888

869 33 160, 168, 169, 777, 888

871 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

872 33 160, 240, 777, 888

873 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

874 33 044, 150, 160, 168, 169, 240, 777, 888

875 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

876 33 160, 888

877 33 169, 888

879 33 160, 168, 169, 777, 888

881 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

882 33 050, 055, 150, 160, 168, 169, 240, 777, 888

883 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

884 33 044, 150, 160, 168, 169, 240, 777, 888

885 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

886 33 160, 168, 169, 777, 888

887 33 168, 169, 888
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891 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

892 33 050, 055, 150, 160, 168, 169, 240, 777, 888

893 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

894 33 044, 150, 160, 168, 169, 240, 777, 888

895 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

896 33 160, 168, 169, 777, 888

897 33 168, 169, 888

898 33 160, 168, 169, 777, 888

899 33 160, 168, 169, 777, 888

908 33 160, 168, 169, 777, 888

909 33 160, 168, 169, 777, 888

910 33 160, 168, 169, 777, 888

911 33 160, 168, 169, 777, 888

914 33 160, 168, 169, 777, 888

915 33 160, 168, 169, 777, 888

916 33 160, 168, 169, 777, 888

917 33 160, 168, 169, 777, 888

918 33 160, 168, 169, 777, 888

919 33 160, 168, 169, 777, 888

925 33 160, 168, 169, 777, 888

926 33 160, 168, 169, 777, 888

961 33 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

962 33 175, 178, 179, 240, 778, 888

963 33 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

964 33 074, 075, 170, 175, 178, 179, 240, 778, 888

965 33 060, 062, 063, 070, 073, 074, 075, 170, 175, 178, 179, 240, 778, 888

966 33 175, 178, 179, 240, 778, 888

967 33 179, 240, 778, 888

971 33 030, 032, 033, 040, 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

972 33 050, 055, 150, 160, 168, 169, 240, 777, 888

973 33 043, 044, 050, 055, 150, 160, 168, 169, 240, 777, 888

974 33 044, 150, 160, 168, 169, 240, 777, 888

975 33 030, 032, 033, 040, 043, 044, 150, 160, 168, 169, 240, 777, 888

976 33 160, 168, 169, 777, 888

977 33 168, 169, 888
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978 33 160, 168, 169, 777, 888

979 33 160, 168, 169, 777, 888
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